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介绍 1
软件概述
SCIEX OS 软件将仪器控制、数据采集、数据处理和报告功能融合在一个软件包里。

打开软件

1. 从 Start 菜单中选择软件：

• Windows 7：Start > All Programs > SCIEX > SCIEX OS > SCIEX OS

• Windows 10：Start > SCIEX OS > SCIEX OS

注释: 如果 LibraryViewServiceHost 服务未运行，则会显示 User Account Control 对话
框。单击 Yes 启动该服务。

如果软件进行了 Integrated 模式配置，则会打开 Home 页面。

如果软件进行了 Mixed 模式配置，则会打开 Logon 对话框。继续进行以下步骤。

2. 如果正在使用 Central Administrator Console (CAC) 软件，并且 SCIEX OS 已配置为集中
管理，则选择要登录的工作组。

3. 如果 Logon 对话框打开，则键入有权使用该软件的用户的用户名和密码，然后单击 OK。
此时 Home 页面便会打开。

关于主页

主页包含工作区图标，按功能、状态面板、功能区和启动对话框分组。工作区访问权限由用户
的指定角色以及许可决定。

介绍
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图 1-1 主页

项目 描述

1 深蓝色图标左侧的浅蓝色竖线表示工作区已打开，工作正在进行，用户可
访问功能。图标显示了已打开工作区的状态。

2 深蓝色图标表示工作区已关闭。

3 灰色图标表示工作区未启用。

4 工作区打开时，图标右上角显示关闭图标 (×)。

5 访问启动对话框。启动对话框包含所有工作区的列表。单击图标右侧的

 打开启动对话框。

6 功能区请参阅以下章节：关于功能区和启动对话框。要导航至其他工作
区，请在列表中单击一个工作区。当前打开的工作区将保持活动，功能区

中显示工作区图标。单击  关闭活动的工作区。单击  返回到主
页。

7 功能：采集、处理和管理。访问权限取决于用户的指定角色和许可。

8 系统状态。单击标题栏显示或隐藏状态面板。

9 状态面板。请参阅以下章节：关于状态面板。

介绍
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表 1-1 功能

标签 描述

Acquisition （采集）运用 Acquisition 分组中的功能创建方法、批次，提
交样本用于采集。用户还可以通过 MS Tune 来调谐质谱仪。

Processing （处理）运用 Processing 分组中的功能来定量或定性处理数
据。

Management （管理）运用管理分组中的功能来配置设备、设定软件访问、
浏览事件日志。

表 1-2 图标

标签 描述

Batch （批次）使用 Batch 工作区创建批次并将其提交至队列。请
参阅以下章节：Batch 工作区。

Queue （队列）使用 Queue 工作区监控采集和处理状态，并管理队
列中的样本。请参阅以下章节：Queue 工作区。

MS Method （MS 方法）使用 MS Method 工作区创建并编辑 MS 方法。
请参阅以下章节：MS Method 工作区。

LC Method 或 AE Method （LC 方法或 AE 方法）使用 LC Method 工作区创建并编辑
LC 方法。请参阅以下章节：LC Method 工作区。

如果 Echo® MS 模块处于活动状态，则会显示 AE Method
（AE 方法）图标。使用它创建和编辑声波激发 (AE) 方法。
请参阅以下章节：AE Method 工作区。

MS Tune （MS 调谐）使用 MS Tune 工作区优化质谱仪。请参阅以下
章节：MS Tune 工作区。

Explorer (Explorer) 使用 Explorer 工作区检查采集的数据。请参阅以下
章节：Explorer 工作区。

Analytics （分析）使用 Analytics 工作区处理并检查采集的数据。请参
阅以下章节：Analytics 工作区。

Configuration （配置）使用 Configuration 工作区配置软件、添加和激活设
备、分配用户角色，创建和分配审核图。请参阅文档：《帮助
系统》。

Library （谱库）使用 Library 工作区管理化合物谱库。

Event Log （事件日志）使用 Event Log 工作区查看系统事件，包括错误
和警告。请参阅文档：《实验室主管指南》。

Audit Trail （审核记录）使用 Audit Trail 工作区查看软件事件的记录，例
如配置更改和数据处理。请参阅文档：《实验室主管指南》。

介绍
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关于功能区和启动对话框

图 1-2 功能区

项目 描述

1 允许用户打开另一个工作区，方法是从列表中选择它。此工作区将成为活
动工作区。之前的活动工作区将保持打开。请参阅图：图 1-3。

2 显示活动工作区的名称。

3 打开主页。

4 显示打开的工作区。活动工作区显示为白色。要将打开的工作区变为活动
工作区，请单击工作区图标。

5 显示当前登录的用户。

6 显示系统状态。请参阅以下章节：关于状态面板。

7 打开帮助系统。单击 ?。

介绍
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图 1-3 启动对话框

项目 描述

1 显示工作区列表。单击 。

2 显示活动工作区的名称。

3 显示工作区的状态。深蓝色背景表示工作区已关闭。左侧浅蓝色垂直栏表
示工作区打开。浅蓝色背景表示工作区激活。

4
关闭打开的工作区。单击 。

5
关闭活动的工作区。单击 。

关于状态面板

要打开此面板，请单击状态面板标题栏。请参阅图：图 1-2。

状态标题栏的图标、文本和颜色发生变化时，表明系统状态发生变化。将状态面板用于：

介绍

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
12/214

软件用户指南
RUO-IDV-05-9804-ZH-F



• 添加或选择一个项目。

• 查看队列中的现存样本以及批次采集完成的预计剩余时间。

• 查看队列中的现存样本数量以及队列完成的预计剩余时间。

• 查看系统状态或 Configuration 工作区内的 Devices 列表中已启动的各个设备的状态。

• 访问直接设备控制以启动或停止设备。

• 查看设备详情。

• 将质谱仪或 LC 系统置于 Standby 状态。

• 平衡系统。

图 1-4 SCIEX OS 状态面板

表 1-3 状态面板部分

标签 描述

Projects
（项目）显示当前项目。单击 Create Project ( ) 以创建项
目。请参阅以下章节：添加一个项目。

介绍
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表 1-3 状态面板部分 (续)

标签 描述

Queue （队列）显示队列中的样本状态。提供的信息包括：

• Samples waiting（等待的样本）

• Sample time remaining（剩余的样本时间）

• Acquisition time remaining（剩余的采集时间）

请参阅以下章节：管理队列。

Devices （设备）列出活动配置中的设备。在此列表中，可以通过以下方
式管理设备。

• 单击设备名称打开 Device Details 对话框并查看详情。

• 查看图标状态或将光标移动到状态图标上方以显示设备状态。

• 单击 Direct device control( ) 打开 Device Control 对话
框。

Direct Control （直接控制）允许用户手动控制设备。单击 Standby 将系统置于
Standby 状态。单击 Equilibrate 打开 Equilibrate 对话框。请参阅
以下章节：平衡系统。

表 1-4 状态面板功能

目的 方法

显示状态面板 单击 小化状态面板顶端的状态面板标题栏。请参阅图：图 1-2。

隐藏状态面板 在状态面板标题栏显示时单击它。

更改活动项目 从状态面板的 Projects 列表中选择一个项目。

提示! 单击 Create Project ( ) 以创建项目。键入项目名称，然
后单击 OK。

介绍
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表 1-4 状态面板功能 (续)

目的 方法

控制设备状态 1. 在状态面板上单击设备标题右侧的 Direct device

control( )。

此时 Device Control 对话框打开。

2. 按需要开始、停止或更新设备。

3. 单击 OK。

通过该步骤获得设备状态的详细反馈。例如：温度、压力和电
压。要检测设备状态，单击设备名称 右端的图标。

Data Acquisition 面板

使用 Data Acquisition 面板开始和监控实时数据采集。用户还可以在实时采集数据时编辑采集
方法参数，并在 Explorer 工作区中保存或打开数据。

提示! 单击 Data Acquisition 面板顶端，然后上下拖动以调整内容尺寸。

图 1-5 Data Acquisition 面板

项目 描述

1 显示 TIC 和质谱或 XIC。如果检测器激活，还会显示 DAD 或 UV 数据。

2 MS 方法。悬停以显示正在运行的 MS 方法的名称。

3 LC 方法。悬停以显示正在运行的 LC 方法的名称。

4 单击 Start 开始手动采集。单击 Start > Start with LC 以打开 Start with
LC 对话框。

5 单击停止手动采集。

6 单击保存数据。

介绍
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项目 描述

7 单击以实时浏览数据。

锁定屏幕

若要在工作站无人值守时防止对软件进行未授权访问，请锁定软件。当软件被锁定时，正在进
行的任何采集或处理都将继续。

当自动登出时间到期时，用户将登出。采集继续。

注释: 如果正在处理或未保存 Results Table，则不会登出。

1. 按下 Ctrl+Q。

图 1-6 Lock Screen 对话框

2. 单击 OK。
SCIEX OS is Locked 对话框随即打开。

解锁软件

如果软件被锁定，则当前登录的用户可以解锁软件。

注释: 其他用户不能解锁软件，但拥有 Force User Logoff 权限的用户可以使当前用户登出。

在 SCIEX OS is Locked 对话框中，键入当前用户的密码，然后单击 Unlock。

电子实验室笔记本支持
SCIEX 不支持任何特定的电子实验室笔记本 (ELN) 解决方案，但 SCIEX 会提供产品、工具和
服务，以方便与 ELN 系统集成的数据导入和导出：

• 批次创建：SCIEX OS 可以导入 csv 和 txt 格式的批次文件。请参阅 Batch 工作区。

• 结果上传：SCIEX OS 可以将数据导出至 txt 文件，以在 LIMS 系统中使用。请参阅
Analytics 工作区。

文档标志和惯例
本指南采用了以下标志和惯例。

介绍
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危险! 危险表示会导致重伤或死亡的行为。

警告! 警告表示如不遵守注意事项可能会导致人身伤害的行为。

小心: 表示如不遵守注意事项可能会导致系统受损或数据破坏或丢失的操作。

注释: 注释一词突出强调了程序或说明中的重要信息。

提示! 提示在文中针对特定需求提供有助于应用技术和程序的有用信息，以及提供捷径，但对
于程序的完成而言并非必不可少。

介绍
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操作说明 — 设备配置 2
使用 Configuration 工作区来：

• 启用和停用设备

• 添加和删除设备

• 编辑设备设置

• 测试设备

添加设备

注释: 为避免出现任何激活问题，务必在添加任何其他设备前添加质谱仪。

1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 如果任何设备已激活，则单击 Deactivate。

4. 单击 Add。
Device 对话框随即打开。

5. 在 Type 列表中选择所需类型。

6. 在 Model 列表中选择所需型号。

7. 单击 Settings 编辑设置或恢复默认值。

8. 若要配置质谱仪以使用 High Mass 或 Low Mass 功能，在 Settings 对话框的 Instrument
Model 部分中，选择以下选项之一：

• Low Mass：若要在有限的质量范围、高灵敏度工作模式下运行，请选择此选项。线性
离子阱 (LIT) 扫描的 大质量范围是 50 Da 至 1000 Da，四极杆扫描的 大质量范围是
5 Da 至 1250 Da。

• High Mass：若要在扩展的质量范围工作模式下运行，请选择此选项。LIT 扫描的 大
质量范围是 50 Da 至 2000 Da，四极杆扫描的 大质量范围是 5 Da 至 2000 Da。

9. 单击 Test Device 核查设备是否配置正确且可用。

10. 单击 Save。

11. 根据需要重复步骤 4 至步骤 10。

12. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。

13. 要编辑或删除设备，请参阅帮助系统。
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删除设备

注释: 若删除的设备是整体系统的一部分，则该系统中的全部设备均将被删除。用户无法删除
整体系统中的单个设备。

1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 单击 Deactivate。

4. 选择一个设备。

5. 单击 Delete。

6. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。

编辑设备设置
1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 如果设备已激活，则单击 Deactivate。

4. 选择要编辑的设备。

5. 单击 Edit。
Device 对话框随即打开。

6. （可选）编辑 Device Display Names 区域中的设备属性。有关属性的信息，请参阅文
档：《帮助系统》。

7. （可选）单击 Settings 以查看和更改其他设备信息。使用 Settings 对话框执行以下任
务：

• 单击 Restore Defaults 以恢复设备的默认设置。

• 单击 Test Device 核查设备是否配置正确且可用。如果测试成功，则 Settings 对话框
关闭。

8. 单击 Test Device 核查设备是否配置正确且可用。
如果测试成功，则显示绿色消息。否则，消息将会指示配置无效且需要更新。

9. 单击 Save。

10. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。
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操作说明—软件配置 3
有关配置用户和角色的信息，请参阅文档：《实验室主管指南》。

关于项目和根目录
根目录是包含一个或多个项目的文件夹。软件将在该文件夹中查找项目数据。预定义的根目录
为 C:\SCIEX OS Data。
为了确保项目信息安全地存储，请使用 SCIEX OS 创建项目。请参阅以下章节：添加一个项
目。

项目数据可组织安排到子文件夹中。使用 SCIEX OS 软件创建子文件夹。请参阅以下章节：
添加子文件夹。

注释: 对于通过 Central Administrator Console (CAC) 软件管理的工作组，CAC 软件的配置控
制是否能够通过 SCIEX OS 管理项目。如果在 CAC 软件中选择了 Use central settings for
projects 选项，则 Projects 页面为只读状态。

添加根目录

根目录是存储一个或多个项目的文件夹。

注释: 软件 多保存十个根目录。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Current root directory 字段旁边的 Create Root ( )。

4. 将完整路径输入根目录文件夹中。
文件夹已创建。

提示! 不输入路径，而是单击 Browse，然后选择将创建根目录的文件夹。在路径末尾输
入“\”和根目录文件夹名称。

提示! 或者，在 File Explorer 中创建一个文件夹，浏览和选择该文件夹。

注释: 对于具有处理许可的 SCIEX OS 装置，根目录可以是 Analyst 软件
Analyst Data\Projects 文件夹。

5. 单击 OK。
新的根目录成为当前项目的根目录。
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删除根目录

软件将维护过去使用的十个根目录的列表。用户可以从此列表中删除根目录。

注释: Current root directory 无法删除。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Current root directory 字段旁的 。
Clear Root Directory 对话框随即打开。

4. 选择将从根目录列表中删除的文件夹，然后单击 OK。

指定一个安全网络帐户

如果项目储存在网络资源上，则可指定一个 SNA，以确保工作站的所有用户都有网络资源的
必要访问权限。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Credentials for Secure Network Account。

4. 输入网络资源上规定的安全网络帐户的用户名、密码和域。

5. 单击 OK。

添加一个项目

项目中储存有采集方法、数据、批次、处理方法、处理结果等。我们建议用户为每个项目使用
单独的项目文件夹。

提示! 还可以通过单击 Status 面板上的 Create Project( ) 来创建项目。

请勿在 SCIEX OS 软件外部创建项目或者复制粘贴文件。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 单击 Current Project 字段旁的 Create Project ( )。
New Project 对话框随即打开。

4. 键入项目名称。

5. 单击 OK。
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添加子文件夹

在项目之内，数据可进一步组织安排到子文件夹中。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 单击 Add Data Sub-Folders to any Project。
Add Data Sub-Folders 对话框随即打开。

4. 在 SCIEX OS Project 字段中，选择要添加子文件夹的项目。

5. 单击 Project Data Sub-Folders 部分中的框上方的 Add a new data sub-folder

( )。
Data Sub-Folder Name 对话框随即打开。

6. 键入子文件夹的名称。

7. 单击 Save。

8. 关闭 Add Data Sub-Folders 对话框。

选择队列选项
软件将按照顺序处理列表中已提交的样本，使用所选的采集方法运行每个样本。所有样本采集
完成后，队列停止，系统进入 Ready 状态。在 Instrument Idle Time 字段中设定的时间过去
后，系统进入 Standby 状态。在 Standby 状态下，LC 泵和柱温箱关闭，有些质谱仪的电源也
会关闭。自动进样器的温控器始终开启，以防止样本降解。

只有分配有管理队列权限的用户才能在 后一次采集完成后并且仪器进入 Standby 状态前修改
队列运行的时长。

1. 打开 Configuration 工作区。

2. 单击 Queue。

3. 按需要选择队列选项。关于选项描述，请参阅文档：《帮助系统》。

4. 单击 Save。

选择实验室信息管理系统 (LIMS) 设置
使用这一功能连接至 LIMS 服务器。用户可以从 LIMS 导入批次信息，或将结果导出至
LIMS。

注释: 连接到 Watson LIMS 不需要此程序。

1. 打开 Configuration 工作区。

2. 单击 LIMS Communication。

3. 要与 LIMS 通信，在 LIMS Server 字段中键入 LIMS 服务器的 URL，然后选择 Enable
import from the specified LIMS server。

操作说明—软件配置

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
22/214

软件用户指南
RUO-IDV-05-9804-ZH-F



注释: 客户 IT 部门或中间件提供商负责配置 LIMS 服务器。联系他们了解 URL 或服务器
的位置。

4. 单击 Save。

启用全屏模式
选择该功能将 SCIEX OS 作为主要应用程序。用户无法关闭软件或访问其他软件程序。

1. 打开 Configuration 工作区。

2. 单击 General。

3. 在 General 下，选择 Enabled 复选框以启用 Full Screen Mode。

4. 单击 Save。

选择区域设置
本特性应用于 Control Panel 中选中的区域和语言设置。只能用小数点“.”或逗号“,”作为小数分
隔符。不支持数字分组。

1. 打开 Configuration 工作区。

2. 单击 General。

3. 在 Regional Settings 下，单击 Apply。
重启计算机后 Windows 操作系统中配置的区域设置将应用于软件。

4. 单击 Save。

5. 重启计算机。

管理化合物谱库

导入 LibraryView 软件包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 LibraryView Package (*.lbp)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。
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8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。

导入化合物数据库

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框执行下列操作之一：

• 单击 DiscoveryQuant Compound Database (*.mdb)。

• 单击 Analyst Compound Database (*.mdb)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。
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导入 Cliquid 软件包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Cliquid Package (*.clq)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

10. 如果需要，可在 Instrument Name 对话框的 Instrument Name 字段内键入质谱仪的名
称。

11. 单击 OK。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

12. 必要时需解决任何冲突问题。

13. 单击 Finish。

导入 Excel 文件

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Excel file (*.xls)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Excel worksheet to importLibrary Importer 对话框中选择合适的 。
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8. 如果该工作表包含列标题，则选择 Selected Excel Worksheet has headers 旁的复选
框。

9. 如果需要，可在 Instrument Name 对话框的 Instrument Name 字段内键入质谱仪的名
称。

10. 为每列信息选择合适的标题。

提示! Compound:CompoundId 和 Compound:Name 是必选项。对不需要的信息选择
---[not used]---。

11. 单击 Next。

12. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

13. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

14. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

15. 必要时需解决任何冲突问题。

16. 单击 Finish。

导入谱库数据库快照

小心: 潜在的数据丢失。执行此程序之前，请备份当前 LibraryView 软件数据库。该信息包内
的信息可覆盖 LibraryView 软件数据库内的所有现有数据。取消选项在导入开始后不可用。

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Overwrite Database with Library Snapshot (*.lbp)。

5. 在 Warning 对话框中单击 Yes。

6. 导航至 Open 对话框中的相应文件。

7. 选择所需文件，然后单击 Open。

8. 单击 Finish。
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从第三方导入谱库信息包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Third Party Library Package (*.tplp)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。

安装有许可证授权的 LibraryView 软件包

注释: LibraryView 软件必须安装。

注释: 获取 LibraryView 软件许可证时，需要接入互联网。如果计算机不能接入互联网，则需
要复制所生成的计算机 ID。用一台能够接入互联网的计算机访问 SCIEX 网站的许可证授权页
面，然后按照操作说明获取许可证。

可以从 DVD 或从 SCIEX 网站下载的 zip 应用程序文件安装许可库。应用程序文件可包括化合
物名称、化合物转换信息和化合物谱库。

1. 以具有管理员权限的 Windows 用户身份登录计算机。

2. 执行以下任一操作：

• 如果谱库是从 DVD 安装的，需将 DVD 光盘放入 DVD 驱动器，然后继续步骤 5。

• 如果谱库通过下载文件安装，则继续步骤 3。
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3. 从 SCIEX 网站下载所需的 zip 文件。

提示! 为了避免可能出现的安装问题，请将文件保存至计算机桌面以外的某个位置。

4. 下载完成后，右键单击所下载的文件，然后单击 Extract All。

5. 找到提取的文件或 DVD，然后双击 Library.exe。

提示! 如果 User Account Control 对话框打开，请单击 Yes。

提示! 如果 LibraryView Setup (Not Responding) 消息对话框打开，请关闭该消息对话
框，右键单击 Library.exe 文件，然后选择 Run as administrator 选项以再次开始安
装。

6. 在 LibraryViewPackages Feature Unavailable 对话框中单击 Software Activation。
LibraryViewPackages Activation 对话框随即打开。

7. 在相应字段中键入与所示内容完全相同的许可证密钥。
如果许可证密钥不可用，请使用 sciex.com/request-support 上信息联系我们。

8. 单击 Generate Computer ID。
将为工作站创建唯一标识符。

9. 单击 Copy ID to Clipboard。

10. 按照操作说明获取许可证。

提交必需信息后，许可证文件会发送至所提供的每个电子邮件地址。

11. 关闭浏览器窗口。

12. 在收到包含许可证文件的电子邮件后，将许可证文件复制到工作站桌面上。

13. 在 Install License FileLibraryViewPackages Activation 对话框中，单击 。

14. 在 Select the new license file to be installed 对话框中，浏览并选择许可证文件。

15. 单击 Open。
Select the new license file to be installed 和 LibraryViewPackage Activation 对话框均关
闭。

16. 执行以下任一操作：

• 在 Library Importer 对话框中单击 Compound 列上方的 All，以导入所有化合物。

• 在 Library Importer 对话框中的相应行内单击，以导入单个化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

17. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

18. 必要时需解决任何冲突问题。
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19. 单击 Finish。

化合物冲突

设置含有化合物组的谱库或设置各种化合物时，软件会在数据库中搜索名称或化学式相同的化
合物，作为信息包中的化合物。如果找到了化合物，软件就会对信息包中的对应化合物进行标
记，然后等待用户输入后再继续运行。

用户可以选择：

• 合并化合物信息。来自信息包中化合物的新质谱、离子对和保留时间均被添加到保存在数
据库中的化合物信息中。

• 覆盖化合物信息。来自信息包中的化合物信息将替代保存在数据库中的化合物信息。

• 保留化合物信息。数据库中的化合物信息保留下来，而来自信息包中的化合物信息将被丢
弃。

冲突信息可帮助用户作出正确选择。

查看化合物冲突

1. 在 在 Library Importer 对话框中单击该化合物旁边的 Resolve，以查看冲突详情。

2. 执行以下任一操作：

• 单击 Keep Original，以保留现有化合物信息，并舍弃新信息。

• 单击 Use New，以用新信息替代现有化合物信息。

3. 为每种化合物重复步骤 1 和步骤 2 。

4. 当所有冲突解决完毕后，单击 Finish。

合并化合物

1. 在 Library Importer 对话框中执行以下任一操作：

• 单击 Merge，将导入信息包中单个化合物的新质谱、离子对和保留时间与保存在数据
库中的对应化合物信息合并。

• 单击 Merge All 将导入信息包中所有化合物的新质谱、离子对和保留时间与保存在数
据库中的所有对应化合物信息合并。

2. 当所有冲突解决完毕后，单击 Finish。

覆盖化合物

1. 在 Library Importer 对话框执行下列操作之一：

• 单击 Overwrite All 将保存在数据库中的所有化合物信息用导入信息包中的对应化合物
信息覆盖。

• 单击相应化合物旁边的 Resolve，然后单击 Use New，可使数据库中存储的化合物信
息被导入信息包中的对应化合物信息覆盖。

2. 当所有冲突解决完毕后，单击 Finish。
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保留原始化合物

1. 在 Library Importer 对话框执行下列操作之一：

• 单击 Keep All Original 保留数据库中存储的所有化合物信息，并舍弃来自导入信息包
中的化合物信息。

• 单击相应化合物旁边的 Keep Original，以保留存储在数据库中的单个化合物信息，并
丢弃源自导入信息包的化合物信息。

2. 当所有冲突解决完毕后，单击 Finish。

添加化合物

注释: 也可以使用 Edit Library 选项将化合物添加到谱库中。

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Add 图标。

注释: 化合物名称是必填项。其他所有信息是选填项。

4. 在 Details 选项卡的字段中，键入合适的信息。

5. 单击 Save。

给化合物添加质谱

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 双击相应的化合物。

4. 单击 MS Spectra 选项卡。

5. 单击 Edit Mode 图标。

6. 单击 Add Spectra 图标。

7. 单击 Open *.wiff fileAdd Mass Spectrum from *.wiff file to Compound 对话框中的 。

8. 在 Open 对话框中浏览并选择合适的 wiff 或 wiff2 文件。

9. 单击 Open。

10. 请执行以下任一操作，以将化合物添加至谱库：

• 对于 IDA 数据，扩展样本，然后在左侧的导航窗格中选择合适的化合物。

• 对于 EMS、MRM 和循环数据，请选择合适的样本。

11. 请执行以下任一操作，以给该化合物添加质谱：

• 对于 IDA 数据，在 Acquired Spectrum 窗格中单击 Add Spectrum。
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• 对于 EMS、MRM 和循环数据，双击 TIC，然后单击 Acquired Spectrum 窗格中的
Add Spectrum。

12. 对每个要添加的质谱重复步骤 7 至步骤 11。

13. 单击 Save。

14. 单击 MS Spectra 选项卡上的 Save。
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操作说明 — 用户工作流程 4
分析师

任务 请参阅

查看主屏和状态面板，检查系统状
态。

关于主页 和 关于状态面板。

通过 Microsoft Excel 电子表格、
LIMS 或手动创建并提交批次。
Analysts 创建和提交批次前，
Method Developers 必须锁定液相
色谱方法和质谱方法。

Batch 工作区。

查看和管理队列中的样本。 Queue 工作区。

在 Results Table 中处理和检查数
据。

Analytics 工作区。

浏览数据。 Explorer 工作区。

方法开发人员

任务 请参阅

配置系统。 • 操作说明 — 设备配置。

• 定义项目的默认处理参数。

• 自定义 Result Table。

调谐质谱仪。 MS Tune 工作区。

配置液相色谱 (LC) 设备。 LC 设备的文档。

创建液相色谱方法。 创建一种 LC 方法。

Echo® MS 系统：创建声波激发
(AE) 方法。

创建一种 AE 方法。

创建质谱仪 (MS) 方法。 MS Method 工作区。

开发处理方法。 创建处理方法。

管理员

任务 请参阅

设置 Windows 文件许可权限。 实验室主管指南
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任务 请参阅

配置 LIMS。 选择实验室信息管理系统 (LIMS) 设置。

给软件添加用户并指定角色。 实验室主管指南

存档日志。 存档日志。

审核人

任务 请参阅

审查处理后的结果。 Analytics 工作区。

浏览数据。 Explorer 工作区。

审查日志。 查看日志。
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操作说明 - 采集方法 5
使用以下工作区来执行采集任务：

• MS Method 工作区：创建并管理 MS 方法

• （在 Echo® MS 模块激活时不适用）LC Method 工作区：创建并管理 LC 方法

• （如果 Echo® MS 模块已激活）AE Method 工作区：创建并管理 AE 方法

• Batch 工作区：创建批次并将它们提交至队列

• Queue 工作区：管理队列中的样本

注释: 如欲避免性能问题或数据损坏，在样本采集期间，请勿执行任何计算机维护步骤，如整
理碎片或清理磁盘、病毒扫描或 Windows Updates。

MS Method 工作区
使用此工作区可创建和管理质谱仪 (MS) 方法。

在 MS Method 工作区中可以打开多个方法。使用 Views 菜单，用户可以将方法窗口的排列方
式更改为选项卡式、垂直平铺、水平平铺或浮动视图。在浮动视图中，可以调整窗口大小、
大化或 小化窗口、将窗口移出 SCIEX OS 窗口并移到其他显示器上。

方法窗口的标题包含方法和项目名称。在平铺和浮动视图中，活动方法的标题栏为蓝色，其他
方法的标题栏为灰色。在选项卡式视图中，活动方法的选项卡为白色，其他方法的选项卡为蓝
色。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

创建一种 MS 方法

通过此程序创建以下类型的 MS 方法：MRM（包括 Scheduled MRM (sMRM) 和 Scout
Triggered MRM (stMRM) 算法方法）、Q1、Q1MI、Q3、Q3MI、中性丢失扫描、母离子扫
描、子离子扫描、ER、EMS、EPI、MS3 和 IDA。

注释: 线性离子阱 (LIT) 扫描模式（ER、EMS、EPI、MS3）仅在安装了 QTRAP 许可证的
SCIEX 7500 系统上受支持。

注释: IDA 方法仅在 SCIEX 7500 系统上受支持。

注释: Echo® MS 系统：建议将 MRM 方法用于声波激发应用。不支持 sMRM 和 stMRM 算
法。

新方法使用质谱仪的默认设置。请参阅 使用默认设置。

提示! 有关使用 Guided MRM 选项创建 MS 方法的信息，请参阅以下章节：创建使用引导式
MRM 的 MRM 方法。
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注释: 请确保在状态面板选中当前项目名称。

1. 打开 MS Method 工作区。

2. 单击 New 按钮上的向下箭头，然后从列表中选择一种扫描类型。可用的扫描类型取决于
质谱仪。请参阅以下章节：扫描技术。

图 5-1 MS 方法列表（已安装带有 QTRAP 许可证的 SCIEX 7500 系统）

3. 根据需要在字段中键入值。关于参数描述，请参阅文档：《帮助系统》。

小心: 潜在的系统损坏。（Echo® MS 系统）将 Ion source gas 1 参数设置为至少 90 psi
以避免淹没孔板。

4. （可选）将质量导入 MS 列表。

• 单击 Import compounds from a file。在 Open 对话框中，浏览并选择要导入的 csv
或 txt 文件，然后单击 Open。

注释: 对于 MRM 方法，单击 Import 以选择 Import compounds from a file 选项。

• MRM 方法：单击 Import > Update retention time from a processing method。在
Open 对话框中，浏览并选择包含要导入的保留时间的处理方法，然后单击 Open。
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• MRM 方法：Import > Import compounds from a library。选择以从具有离子对表信
息或 MS 谱图的谱库中导入。请参阅文档：《帮助系统》。

5. （可选）单击 Advanced > Show advanced parameters 以显示并编辑分辨率参数
Settling time、Pause time、Step size 和 Q0 dissociation。

注释: 只有 SCIEX 7500 系统可显示 Q0 dissociation。

6. （可选）单击 Options > Ramp 以逐渐升高方法中的参数值。

7. （可选）单击 Options > Apply ionization scheduling 执行预订离子化功能。

8. （可选）运行方法。请参阅以下章节：手动运行一种 MS 方法。

9. 在 Data Acquisition 面板中查看实时数据。

提示! 单击 Data Acquisition 面板顶端，然后上下拖动以调整内容尺寸。请参阅以下章
节：Data Acquisition 面板。

10. （可选）要在 Explorer 工作区中查看数据，请单击 Data Acquisition 面板中的 Open data

exploration to view real time data ( )。请参阅文档：《帮助系统》。
实时采集以样本标题中的词 Acquiring、Finished 或 Aborted 表示在 Explore 窗格中。

图 5-2 实时采集——Acquiring

11. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

12. 在 File Name 字段中键入一个名称。

13. 单击 Save。

注释: 优化 MS 方法需要手动、迭代地调整参数，然后采集数据， 后观察调整对信号的
影响。
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导入化合物提示

• 从文件导入化合物提示：

• 源 csv 或 txt 文件必须采用以下格式：

• 源文件不应包含列标题。

• 导入时，源文件中的列数和顺序必须匹配 MS 方法中 Mass Table 的列数和顺序。

• 仅源文件中的有效值会导入到 Mass Table 的相应单元格中。如遇到无效值，受影响的单
元格将出现一个验证图标，以显示无效值的位置，或者保留该单元格的默认值。

• 导入时不可打开源 csv 或 txt 文件。

• 导入 Scheduled MRM (sMRM) 和 Scout Triggered MRM (stMRM) 中的驻留时间，RT
模式算法方法的处理方式有所不同，具体取决于该离子对的 Edit dwell time 复选框是否
选中。

如选中 Edit dwell time，且用户在该源文件中指定的驻留时间值介于用户在 MS 方法中
指定的 小和 大驻留时间之间，则导入该值。如果该值超出此范围，则导入的值会被
小或 大驻留时间替代，以 接近导入值的为准。

如清除 Edit dwell time，则源文件中的驻留时间值被基于已有和导入的方法参数（包括
方法持续时间、目标周期时间、并发性、保留时间和保留时间容差）计算得出的驻留时
间所替换。

注释: 对于组模式中的 stMRM 算法方法，驻留时间由用户手动编辑。因此，如果它们介
于 小值和 大值之间，则会从源文件中将其导入。

• 从离子对表导入化合物提示：

• 安装的库包含离子对表中 少一种化合物的 MRM 离子对和化合物相关参数。下图显示
LibraryView 软件中的离子对表。

注释: 谱库离子对表中的离子对和化合物相关参数可来自安装的谱库，也可由用户手动创
建和维护。
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图 5-3 LibraryView 软件中的离子对表

创建一种 IDA 方法

注释: IDA 方法仅在 SCIEX 7500 系统上受支持。

1. 打开 MS Method 工作区。

2. 单击 New > IDA

3. 在 Method duration 字段中键入方法时长。

4. 设置源和气体参数。关于 IDA 方法中所用参数的描述，请参阅文档：《帮助系统》。

5. 在 Survey 字段中，选择以下其中一种实验类型：

• MRM

• Neutral Loss

• Precursor Ion

• Q3

• EMS

6. 在 IDA Criteria 字段中选择工作流。

工作流列表会因所选择的全谱扫描而异。

操作说明 - 采集方法

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
38/214

软件用户指南
RUO-IDV-05-9804-ZH-F



注释: 如用户更改全谱扫描，将继承通用 IDA 条件和输入的值。

7. 设置 IDA 条件。

8. 在 Dependent 字段中，选择以下其中一种实验类型：

• EPI

• Product Ion

• Add Second IDA Criteria (MS3)：选择以添加二级 IDA 实验，MS3 条件性扫描和二
级标准。EPI 扫描将更改为全谱扫描。

9. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

10. 在 File Name 字段中键入一个名称。

11. 单击 Save。

创建使用引导式 MRM 的 MRM 方法

使用 Guided MRM 优化或创建新的 MRM 采集方法时，请使用注射器输注、三通输注或者声
学输注（如果使用 Echo® MS 系统）。

注释: Echo® MS 系统：由于峰较窄，我们建议尽可能减少离子对的数量。建议的离子对数量
为四个到 多六个。

使用 Guided MRM 优化或创建新的 MRM 采集方法时，请使用注射器输注或者三通输注。

如果需要增加对起止电压的控制，可使用 Guided 选项。

1. 打开 MS Method 工作区。

2. 单击 New > Guided Optimization > MRM Infusion。
Preparation 页面随即打开。

3. 选择该模式：

• Guided：用于增加对起止电压的控制。

• Automatic：允许软件自动选择起止电压值。

4. 选择 Polarity。

5. 要使用已知离子对，请执行此操作：

a. 单击 Use known transitions。
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b. 在每种化合物的表格中键入 Q1 mass (Da)、Compound ID 和 Q3 Mass (Da)。

6. 要使用未知离子对，请执行此操作：

a. 单击 Find transitions automatically。

b. 在每种化合物的表格中指定 Compound Name、Charge、Precursor Ion 和
Number of Fragments to Use。

7. 单击 Continue。
Set Initial Conditions 页面随即打开。

8. 如有需要，调整初始离子源参数和 Q1 参数。

9. 如果未自动进行处理，请单击 Start。

10. 当喷雾稳定时，单击 Next。
系统会自动优化 Declustering Potential、Collision Energy 和 Collision Cell Exit
Potential 参数，并且如果选择了 Unknown transitions，则识别子离子。

11. （自动模式）等待至所有子离子被识别，所有参数被优化以及 Report 页面显示。然后，
转到步骤 16。

12. 在 Optimize Declustering Potential 页面上，请执行以下操作：

a. 在 Start、Stop 和 Step 字段中键入数值。

b. 单击 Start。

注释: 如有需要，调整优化参数，然后单击 Ramp 以进行再次优化。

c. 完成优化后，请单击 Next。

13. 在 Determine the Product Ions 页面上，请执行以下操作：

a. 如果需要，调整 CE 优化的 Start、Stop 和 Step 字段。

b. 如果需要，在 Start Mass (Da)和 Stop Mass (Da) 字段中键入数值。

注释: 如有需要，调整优化参数，然后单击 Ramp 以进行再次优化。

c. 完成优化后，请单击 Next。

14. 在 Optimize Collision Energy 页面上，请执行以下操作：

a. 在 Start、Stop 和 Step 字段中键入数值。

b. 单击 Start。

注释: 如有需要，调整优化参数，然后单击 Ramp 以进行再次优化。

c. 完成优化后，请单击 Next。

15. 在 Optimize Collision Cell Exit Potential 页面上，请执行以下操作：

a. 在 Start、Stop 和 Step 字段中键入数值。

b. 单击 Ramp。
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注释: 如有需要，调整优化参数，然后单击 Ramp 以进行再次优化。

c. 完成优化后，请单击 Next。

Report 页面显示出来。

16. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

注释: 软件还会在同一个文件夹中保存相应的 wiff 数据文件和优化报告。

17. 单击 Continue 打开 MS Method 工作区的优化方法。

18. 在 Method Duration 字段中键入所需的方法持续时间。

19. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

20. 在 File Name 字段中键入一个名称。

21. 单击 Save。

创建使用 FIA 的 MRM 方法

1. 打开 MS Method 工作区。

2. 单击 New > Guided Optimization > MRM FIA。
打开 Set Initial Acquisition Values 页面。

3. 选择 LC Method 或单击  以查看当前项目中选择的 LC 方法。

4. 指定注射体积。

5. 在 Method Duration 字段中键入所需的方法持续时间。

6. 选择 Rack Type、Rack Position、Plate Type 和 Plate Position。

7. 选择 Polarity。

8. 在表中为每个化合物键入 Compound ID、Q1 mass (Da)、Q3 Mass (Da)、CE (V)、
CXP (V)、Dwell time (ms) 和 Vial Position。关于参数描述，请参阅文档：《帮助系
统》。

注释: 该表可以包含 多 10 种化合物。
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9. 单击 Next。
随即将显示 Set Initial LC-MS Conditions 页面。

10. 在 Initial conditions with 字段中选择 Compound ID。然后调整源和气体参数以及 MRM
参数。关于参数描述，请参阅文档：《帮助系统》。

11. 如果未自动进行处理，请单击 Start。

12. 单击 Next。
随即将显示 Optimize Parameters 页面。

13. 在 Determine step size using 字段中选择步长大小。请参阅文档：《帮助系统》。

14. 指定是否使用强度或 Optimize using 字段中的信噪比优化。

15. 在 Initial Parameter Values 表中，选择要优化的参数。

16. 对于每个待优化参数，在 Start、Stop、Step 或 Discrete steps 字段中定义步骤。

17. 在 Replicate injection for each step 字段中为每个参数步骤选择待复制的次数。

18. 单击 Start。

19. 完成优化后，请单击 Next。
随即将显示 Review Report 页面。请参阅文档：《帮助系统》。

20. 单击 Open in MS Method Editor 打开 MS Method 工作区的优化方法。

21. 在 Method Duration 字段中键入所需的方法持续时间。

22. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

23. 在 File Name 字段中键入一个名称。

24. 单击 Save。

创建使用输注的 MS3 方法

注释: 线性离子阱 (LIT) 扫描模式（ER、EMS、EPI、MS3）仅在安装了 QTRAP 许可证的
SCIEX 7500 系统上受支持。

1. 打开 MS Method 工作区。

2. 单击 New > Guided Optimization > MS3 Infusion。
随即将显示 Preparation 页面。

3. 设置 Basic、Enhanced Resolution、Enhanced Product Ion、Multiple Reaction
Monitoring 和 MS3 参数。请参阅文档：《帮助系统》。
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4. 单击 Next。
随即将显示 Initial Conditions & Optimization 页面。

5. 设置源和气体参数。关于参数描述，请参阅文档：《帮助系统》。

6. 单击 Start。
系统自动测定 Q1 离子和子离子，并优化碰撞能量和 AF2 能量。

注释: 系统一次测定一个 Q1 离子。

7. 等待至所有子离子被识别，所有参数被优化以及 Report 页面显示。

8. 单击 Open in MS Method Editor 打开 MS Method 工作区的优化方法。

9. 在 Method Duration 字段中键入所需的方法持续时间。

10. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

11. 在 File Name 字段中键入一个名称。

12. 单击 Save。

创建 sMRM 算法方法

必要程序

• 创建包含 MRM 实验的 MS 方法。请参阅下面的程序：

• 创建一种 MS 方法

• 创建使用引导式 MRM 的 MRM 方法

注释: Echo® MS 系统：不支持 Scheduled MRM (sMRM) 算法。

1. 按以下步骤打开包含 MRM 实验的 MS 方法：

a. 单击 Open。

b. 选择 MS 方法。

c. 单击 Open。

2. 在 MRM Mode 字段中，选择 Scheduled MRM。
Scheduled MRM (sMRM) 算法字段随即显示。

3. 将 Target Cycle Time 设置为适合峰宽的值。
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4. 根据 LC 方法条件将每个化合物的 Retention time (min) 设置为预计保留时间。

5. 根据峰形将 Retention time tolerance (+/-sec) 设置为适当的值。

6. （可选）要应用 sMRM 算法触发，选择 Apply sMRM triggering 并更新 Mass Table 部
分。请参阅文档：《帮助系统》。

7. （可选）按以下方法更新高级参数：

a. 单击 Advanced > Show advanced parameters。

b. 根据需要调整 Minimum Dwell Time、Maximum Dwell Time、Settling time 和
Pause time。

c. （可选）在 MS 列表中调整 Q1 resolution 或 Q3 resolution，或者二者一同调整。

图 5-4 高级参数

8. 单击 sMRM Summary 查看 sMRM 方法的图形表示。单击 Close 关闭它。
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图 5-5 (s)MRM Plots 对话框

注释: 可以同时打开多个 (s)MRM Plots 对话框，在 MS Method 工作区中打开的每个 MS
方法各一个。

9. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

10. 在 File Name 字段中键入一个名称。

11. 单击 Save。

12. 使用适当的 LC 方法运行 MS 方法，然后调整参数以优化性能。请参阅以下章节：手动运
行一种 MS 方法。
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创建 stMRM 算法方法

必要程序

• 创建包含 MRM 实验的 MS 方法。请参阅下面的程序：

• 创建一种 MS 方法

• 创建使用引导式 MRM 的 MRM 方法

注释: Echo® MS 系统：不支持 Scout Triggered MRM (stMRM) 算法。

1. 按以下步骤打开包含 MRM 实验的 MS 方法：

a. 单击 Open。

b. 选择 MS 方法。

c. 单击 Open。

2. 在 MRM Mode 字段中，选择 Scout triggered MRM RT 或 Scout triggered MRM
Group
Scout Triggered MRM (stMRM) 算法字段随即显示。

3. 将 Target Cycle Time 设置为适合峰宽的值。

4. 在 Mass Table 中，为每个标记离子对选中 Trigger 复选框并指定 Trigger threshold。

5. Scout triggered MRM RT 模式：指定指示洗脱顺序的保留时间，然后设置 RT
overlap。请参阅以下章节：保留时间模式。

6. Scout triggered MRM Group 模式：将每个离子对分配给一个超级组。标记离子对及其
所有相关离子对必须在同一个超级组中。请参阅以下章节：组模式。

7. （可选）按以下方法更新高级参数：

a. 单击 Advanced > Show advanced parameters。

b. 根据需要调整 Minimum Dwell Time、Maximum Dwell Time、Settling time 和
Pause time。

c. （可选）在 MS 列表中调整 Q1 resolution 或 Q3 resolution，或者二者一同调整。

8. 单击 sMRM Summary 查看 sMRM 方法的图形表示。单击 Close 关闭它。
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图 5-6 (s)MRM Plots 对话框

注释: 可以同时打开多个 (s)MRM Plots 对话框，在 MS Method 工作区中打开的每个 MS
方法各一个。

9. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

10. 在 File Name 字段中键入一个名称。

11. 单击 Save。

12. 使用适当的 LC 方法运行 MS 方法，然后调整参数以优化性能。请参阅以下章节：手动运
行一种 MS 方法。
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通过多个实验创建方法

必要程序

• 创建一种 MS 方法。请参阅下面的程序：

• 创建一种 MS 方法

• 创建使用引导式 MRM 的 MRM 方法

1. 按以下步骤来打开实验将添加到的 MS 方法：

a. 单击 Open。

b. 选择 MS 方法。

c. 单击 Open。

2. 在 Method Overview 窗格中，单击 Add Experiment，然后单击要添加的实验扫描类型。

图 5-7 Add Experiment 菜单

3. 设置实验参数。关于参数描述，请参阅文档：《帮助系统》。

4. 为要添加的每个实验重复步骤 2 和步骤 3。
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5. （可选）单击 Options > Apply experiment scheduling 为每个实验配置 Start run time
和 Stop run time。

注释: 实验安排对 Scheduled MRM (sMRM) 和 Scout Triggered MRM (stMRM) 算法实验
不可用。因此，存在下列限制：

• 如果对多个 MRM 实验应用实验安排，则它们无法转换为 sMRM 或 stMRM 实验。并
且 sMRM 或 stMRM 实验也无法添加到启用了实验安排功能的 MRM 方法。

• 实验安排无法应用于包含 sMRM 或 stMRM 实验的 MS 方法。

6. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

7. 在 File Name 字段中键入一个名称。

8. 单击 Save。

对于 MRM 扫描类型以外的扫描类型，优化 MS 方法需要手动、迭代地调整参数，然后采
集数据， 后观察调整对信号的影响。

打开 MS 方法

使用此程序打开通过 SCIEX OS 创建的 MS 方法。要打开使用 Analyst 软件创建的方法，请参
阅以下章节：转换 Analyst 软件方法。

SCIEX OS 可以打开为活动质谱仪之外的其他质谱仪创建的 MS 方法。例如，它可以转换为
SCIEX Triple Quad 5500+ 系统创建的方法，以便用于 SCIEX Triple Quad 4500 系统。为
此，请确保 MS 方法位于当前项目中。打开 MS 方法时，软件将参数调整为与活动设备兼容。

注释: 软件不能转换为 X500 QTOF 或 ZenoTOF 系统创建的方法以使其用于 SCIEX Triple
Quad 或 QTRAP 系统。

1. 打开 MS Method 工作区。

2. 单击 Open。
Open MS Method 对话框随即打开。它包含当前项目中的 MS 方法列表。

3. （可选）如果要打开的方法不在当前项目中，则选择包含要打开的方法的项目。

4. 选择要打开的 MS 方法，然后单击 Open。

提示! 要选择多个方法，请使用 Shift 或 Ctrl 键。

操作说明 - 采集方法

软件用户指南
RUO-IDV-05-9804-ZH-F

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统

49/214



如果 MS 方法中的设备与活动设备不匹配，则 Convert MS Method 对话框打开。单击 OK
以便为活动设备转换 MS 方法。转换完成后，单击 OK。使用之前认真检查 MS 方法。

注释: 如果正在从不同的质谱仪转换 MS 方法，则该 MS 方法的名称为 Untitled。

转换 Analyst 软件方法

Analyst 软件中创建的 MS 方法可以转换以便用于 SCIEX OS。如果 Analyst 软件方法中的设
备与 SCIEX OS 中的活动设备不匹配，则方法参数调整为与活动设备兼容。

注释: SCIEX OS 无法打开为 QTRAP 系统创建的方法。

注释: 请确保在状态面板选中当前项目名称。

1. 打开 MS Method 工作区。

2. 单击 Open > Convert file。

3. 浏览至要转换的方法并选中，然后单击 Open。
该软件可转换方法，报告由于设备和方法文件格式差异导致的任何问题。方法在 MS
Method 工作区打开。

4. 检查 MS 方法并 纠正任何问题。

5. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

6. 在 File Name 字段中键入一个名称。

7. 单击 Save。

对于 MRM 以外的扫描类型，优化 MS 方法需要手动、迭代地调整参数，然后采集数据，
后观察调整对信号的影响。

手动运行一种 MS 方法

必要程序

• 在 MS Method 工作区中，创建 MS 方法或打开现有方法。请参阅以下章节：MS Method
工作区或 打开 MS 方法。

使用此程序在 MS Method 工作区中运行激活的方法。
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1. 单击 Data Acquisition 面板中的 Start 按钮上的向下箭头，然后单击以下各项之一：

• Start：此选项在不使用 LC 的情况下运行 MS 方法。

• Start with LC

注释: 此选项对 Echo® MS 系统不可用。

请参阅以下章节：Data Acquisition 面板。

警告! 火灾危险。将溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件可
以提供高达 5 mL/min 的流速，但直接送进流率超过 3 mL/min 的溶剂可能会造成
溶剂在离子源中积聚。可以用三通将溶剂流分开，以确保提供给离子源的 大流速
不超过 3 mL/min。

如果用户单击 Start with LC，则系统会打开 Start with LC 对话框。有关此对话框上的字
段的信息，请参阅文档：《帮助系统》。

注释: 必须激活 LC 系统，并且必须创建和保存 LC 方法。

图 5-8 Start with LC 对话框

2. （可选）要在 Explorer 工作区中查看数据，请单击 Data Acquisition 面板中的 Open data

exploration to view real-time data ( )。
实时采集以样本标题中的词 Acquiring、Finished 或 Aborted 表示在 Explore 窗格中。
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图 5-9 实时采集——Acquiring

3. （可选）根据需要优化 MS 参数。关于参数描述，请参阅文档：《帮助系统》。

4. 单击 Data Acquisition 面板中的 Stop。

5. （可选）要保存数据，请遵照以下步骤：

a. 单击 Save 保存数据。
Save Data 对话框随即打开。

b. （可选）选择保存数据的项目和子文件夹（如适用）。

c. 在 File Name 字段中键入一个名称。

d. 单击 Save。

6. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

7. 在 File Name 字段中键入一个名称。

8. 单击 Save。

使用默认设置

使用此程序设置默认方法参数。源和气体参数的默认值应用到所有实验类型。化合物相关参数
的默认值针对各实验类型定义。为每种极性设置默认参数。

更改不会应用于现有方法。在更改之后创建的任何方法都将使用新值。

1. 打开 MS Method 工作区。

2. 单击 Advanced > Default settings。
随即将显示 Source and Gas Settings 页面。

3. 选择 Polarity。

4. 设置源和气体参数。关于参数描述，请参阅文档：《帮助系统》。
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注释: 对于负极性，仅可调整 Spray voltage。其他源和气体参数值取自正极性。

5. 单击 Save。

6. 单击 Compound Dependent Settings。
随即将显示 Compound Dependent Settings 页面。

7. 选择 Experiment type。

8. 选择 Polarity。

9. 为选定的实验类型设置参数。关于参数描述，请参阅文档：《帮助系统》。

10. 单击 Save。

LC Method 工作区
使用此工作区可创建和管理 LC 方法。

在 LC Method 工作区中可以打开多个方法。使用 Views 菜单，用户可以将方法窗口的排列方
式更改为选项卡式、垂直平铺、水平平铺或浮动视图。在浮动视图中，可以调整窗口大小、
大化或 小化窗口、将窗口移出 SCIEX OS 窗口并移到其他显示器上。

方法窗口的标题包含方法和项目名称。在平铺和浮动视图中，活动方法的标题栏为蓝色，其他
方法的标题栏为灰色。在选项卡式视图中，活动方法的选项卡为白色，其他方法的选项卡为蓝
色。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

创建一种 LC 方法

请参阅随液相色谱设备提供的文档。

1. 打开 LC Method 工作区。

2. 单击 New。

3. 单击左侧面板中的一个设备，然后按需要编辑字段。

4. 通过单击以下命令之一保存并有选择地锁定 LC 方法：

• Save：用于保存 LC 方法。

• Save > Lock Method：用于保存和锁定 LC 方法。

Save As LC Method 对话框随即打开。

5. 在 File Name 字段中键入 LC 方法名称，然后单击 Save。

AE Method 工作区
使用此工作区可创建和管理 AE 方法。当 Echo® MS 系统激活时，主页上的 LC Method 图标
将变为 AE Method。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。
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创建一种 AE 方法

注释: 请确保在状态面板选中当前项目名称。

1. 打开 AE Method 工作区。

2. 单击 New。

3. 按需要编辑字段。关于参数描述，请参阅文档：《帮助系统》。

4. 通过单击以下命令之一保存并有选择地锁定 AE 方法：

• Save：用于保存 AE 方法。

• Save > Lock Method：用于保存和锁定 AE 方法。

Save As AE Method 对话框随即打开。

5. 在 File Name 字段中键入 AE 方法名称，然后单击 Save。

Batch 工作区
Batch 工作区包含要采集和（可选）处理的一组样本的相关信息。批次可以告知软件样本的采
集和处理顺序。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 对于选定的自动进样器、样本支架类型、样本支架位置、样本板类型、样本板位置和进
样瓶位置都彼此相关，并且只有特定值有效。

注释: 与 Echo® MS 系统结合使用时，此工作区将定义样本在孔板中的排列方式。系统将优化
通量的采集顺序。

表 5-1 Batch 工作区列

列名称 定义 字段值要求

Sample and method information（样本和方法信息） ( )

Sample Name （样本名称）样本的名称。 小于 252 个字符。

Sample ID （样本 ID）样本的自定义编号或
其他标识符。

小于 252 个字符。Sample ID 字
段不能包含以下任何无效字符：
\ / : ; * ? " < > |=

Barcode ID （条形码 ID）样本的唯一 ID。 小于 250 个字符。

MS Method （MS 方法）方法的名称。 该 MS 方法必须存在于当前项目
中。该字段不区分大小写。

LC Method （LC 方法）（适用于除 Echo®

MS 系统之外的所有系统）液相色
谱方法的名称。

该 LC 方法必须存在于当前项目
中。该字段不区分大小写。
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表 5-1 Batch 工作区列 (续)

列名称 定义 字段值要求

AE Method （AE 方法）（Echo® MS 系统）
声波激发方法的名称。

当 Echo® MS 系统在 Devices 页
面处于激活状态时显示。

AE 方法必须存在于当前项目中。
该字段不区分大小写。

Rack Type （样本支架类型）自动进样器的
支架类型。

必须是适合 LC 方法所指定自动
进样器的任一有效选项。

Rack Position （样本支架位置）样本架在托盘
上的位置。

数值。

Plate Type （孔板类型）自动进样器中的孔
板类型。

注释: 如果 Rack Type 对进样瓶
进行了描述，则此列不可用。

必须是适合 LC 方法所指定自动
进样器的任一有效选项。

Plate Position （孔板位置）样本板在样本架上
的位置。

必须匹配任一预定义的自动进样
器孔板位置。

Vial Position （进样瓶位置）（LC 方法）进样
瓶在支架或孔板中的位置。

数值。 大值不得大于样本架内
的进样瓶数。

Well Position （孔位置）（AE 方法）孔在孔板
中的位置。

当 Echo® MS 在 Devices 页面处
于激活状态时显示。

数值。 大值不得大于样本架内
的孔数。

Injection Volume
(µL)

（注射体积 (µL)）待注射的样本
量。

注释:

仅在 LC 方法中，注射体积取自
于 LC 方法。用户可在 Batch 工
作区或在导入的批次文件中覆盖
此注射体积。当提交批次时，会
比对 LC 设备支持的范围验证注
射体积。

要恢复至 LC 方法指定的注射体
积，请删除该字段的内容，然后
在 LC Method 字段中重新选择
LC 方法。

数值。
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表 5-1 Batch 工作区列 (续)

列名称 定义 字段值要求

Sample Type （样本类型）样本的类型。 确保样本类型与预定义的一类样
本类型相匹配。任何不匹配的类
型都会被自动替换为 Unknown。

Dilution Factor （稀释系数）各个样本的稀释系
数。

对于 SCIEX 开发的方法，该值必
须为 1.000000。

必须为大于零的值，且包含六个
小数位。默认值是 1.000000。该
字段不得留空。

Data File （数据文件）保存所采集数据的
文件名称。包含将存储文件的子
文件夹的完整路径。

必须少于 252 个字符。字符总数
包括数据子文件夹路径内的字符
数。数据文件不能包含任何这些
无效字符：\ / : ; * ? " < > |=

提示! 单击箭头以从列表中选择子
文件夹，或键入新的子文件夹的
名称。确保在子文件夹和文件名
之间包含反斜杠 (\)。如果子文件
夹不存在，将会在批次运行时创
建子文件夹。

注释: （Echo® MS 系统）不得在
多个批次中使用相同的数据文件
名称。

Processing Method （处理方法）方法的名称。如果
将使用现有的 Results File，则
将此字段留为空白。选中现有的
Results File 时，值 *Embedded
Method* 将自动显示在此字段
中。

注释: 处理方法必须符合为样本指
定的 MS 方法。

从项目的处理方法列表中选择一
种处理方法。
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表 5-1 Batch 工作区列 (续)

列名称 定义 字段值要求

Results File （结果文件）保存所处理结果的
文件名称。如果指定了有效的
Results File，将会在采集完成后
自动处理样本数据。如果文件名
无效，将无法完成批次提交过
程。

注释: 如果选择现有的 Results
File，则将所选 Results File 的内
嵌方法用于处理，Processing
Method 单元格中的文本将被替
换为 *Embedded Method*。

文件名不能包含以下任何无效字
符：\ / ; : * ? " < > |=

文件路径（包括文件名和子文件
夹）必须少于 252 个字符。

提示! 单击箭头以从列表中选择现
有 Results File。要创建一个文
件，请键入文件名称。文件将在
处理提交批次中的第一个样本时
创建。

注释: （Echo® MS 系统）不得在
多个批次中使用相同的结果文件
名称。

Marker Well （标记孔）用于将时序文件与第
一个孔对齐的孔。Marker Well
必须至少包含 MS Method 列中
指定的 MS 方法所定义的成分之
一。

当 Echo® MS 在 Devices 页面处
于激活状态时显示。

为标记孔选择 True。当提交批次
时，所有其他孔将被自动设为
False。

Comment （评注）文本 必须少于 50 个字符。Comment
字段不能包含以下任何无效字
符：\ / : ; * ? " < > |=

Custom columns （自定义列）（可选）用户定义
的列，采用文本、整数或实数格
式。

要求取决于格式。

Component Concentrations（成分浓度）（ ）
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表 5-1 Batch 工作区列 (续)

列名称 定义 字段值要求

Component （成分名称）MS 方法、处理方法
或 Results Table 中定义的成分名
称。

该批次可以包含 多 4,000 个成
分行。

成分名称取自 MS 方法（用于
MRM 扫描）、处理方法或
Results Table。该名称在方法创
建期间已验证。

也可以手动添加成分到该表。请
参阅以下章节：添加成分浓度。

注释: 如果导入文件中含有与批次
网格中任一列都不匹配的数据
列，那么该列可作为 Compound
或 Component Name 列处理。添
加浓度列并在其中填充该数据列
中的值。

Component
concentration

用于标准物和质量对照品样本类
型的分析物或内标浓度。该表每
个样本有一列。样本名称用作列
名。

数值大于或等于 0。

管理批次

注释: 请确保在状态面板选中当前项目名称。

在 Batch 工作区中，使用以下功能管理批次。

表 5-2 Batch 工作区的功能

目的 方法

显示或隐藏列 单击 View。请参阅以下章节：显示或隐藏列。

剪切行 单击 Manage Samples > Cut。

复制行 单击 Manage Samples > Copy。

粘贴行 单击 Manage Samples > Paste。

插入一行 单击 Manage Samples > Insert sample。

删除一行 单击 Manage Samples > Delete sample。

选择列 单击 View。请参阅以下章节：显示或隐藏列。

添加子文件夹到项目中 单击 Manage Samples > Add data sub-folders。 请参阅文
档：《帮助系统》。

打印批次 单击 Print。

保存批次到当前项目 单击 Save > Save 或 Save > Save As。
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表 5-2 Batch 工作区的功能 (续)

目的 方法

将批次导出为 txt 或 csv 文件 单击 Save > Export。

显示或隐藏列

1. 打开 Batch 工作区。

2. 单击 View。

3. 根据需要，在 View 对话框中选择或取消选择该列复选框。关于列描述，请参阅表格：表
5-1。

图 5-10 View 对话框

4. 单击 OK。
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添加自定义列

使用此程序向批次添加列以存储干重等关于样本的额外信息，以使其能够用于化学式和计算列
中的处理。

1. 打开 Batch 工作区。

2. 右键单击批次网格，然后单击 Add Custom Column。
Add Custom Column 对话框打开。

3. 在 Column name 字段中，键入列的名称。

名称必须唯一。它不能与任何预定义列的名称相同。

4. 在 Column type 字段中，选择这些类型之一：

• Integer：此列包含整数。小数将舍入到 接近的整数。

• Real：此列包含实数， 多六位小数。

• Text：此列包含文本， 多 128 个字符。

5. 单击 Add。
新列添加到 Batch 工作区右侧。

更改自定义列的名称

注释: Column type 无法更改。

1. 打开 Batch 工作区。

2. 右键单击要更改的列，然后单击 Edit Custom Column。
Edit Custom Column 对话框随即打开。

3. 在 Name 字段中，为该列键入新名称。

名称必须唯一。它不能与任何预定义列的名称相同。

4. 单击 Apply。

删除自定义列

1. 打开 Batch 工作区。

2. 右键单击批次网格，然后单击 Delete Custom Column。
Delete Custom Column 对话框随即打开。

3. 选中要删除的列名称旁边的复选框。

4. 单击 Delete。
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从文件中导入一个批次

必要程序

• 创建一个批次文件。关于要包含在文件中的字段的描述，请参阅表格：表 5-1。

注释: 在导入的 Microsoft Excel 文件中，第一列必须是预定义列，接着是自定义列。预定
义列的列标题必须与 SCIEX OS 中的列名称匹配。如果预定义列的列标题不正确，则将不
会导入信息。仅支持将句点作为 csv 或 xsl 文件中的小数分隔符。

注释: 在导入批次文件前将其关闭。批次文件如果已在 Microsoft Excel 中打开将无法导
入。

• （对于从 Watson LIMS 导入可选）要自动插入 LC Method 字段，确保 LC 方法的名称与
MS 方法的名称相同。

注释: Watson LIMS 没有 LC 方法字段。如果 LC 方法的名称与 MS 方法的名称不同，则
必须手动插入 LC 方法列。

提交样本前，请检查批次目录。

提示! 要使用剪切、复制、粘贴、添加行和删除行等功能，请单击 Manage Samples。

1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

3. 单击 Open > Import from file。
Batch Import 对话框打开。

4. 单击 Browse。

5. 导航至所需文件。

6. 单击 Open。

7. （可选）根据需要选择或取消选择 Append to current batch 复选框。

注释: 若用户未选择 Append to current batch 选项，则表格中的任何现有数据都将被覆
盖。

8. 单击 Import。

9. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

10. 提交批次前确保达到柱温箱温度。

11. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。
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12. 提交批次。请参阅以下章节：提交批次。

从 LIMS 中导入一个批次

必要程序

• 在 Configuration 工作区中配置 LIMS。请参阅文档：《帮助系统》。

注释: 要从 Watson LIMS 导入批次，请参阅以下章节：从文件中导入一个批次。

1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

3. 单击 Open > Import from LIMS。
Import a Batch File 对话框打开。

4. 键入文件位置或文件名称。

5. 在 Batch Identifier 字段键入批次标识符。

6. （可选）根据需要选择或取消选择 Append to current batch 复选框。

注释: 若用户未选择 Append to current batch 选项，则表格中的任何现有数据都将被覆
盖。

7. 单击 Import。

8. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

9. 提交批次前确保达到柱温箱温度。

10. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。

11. 提交批次。请参阅以下章节：提交批次。

手动创建批次

提交样本前，请检查批次目录。

注释: 如果质谱仪采用触点闭合与外部设备通信，那么请遵循该等指南：

• 请确保批次中定义的样本序列与外部设备上定义的序列相匹配。

• 请确保方法持续时间少于或等于外部设备上所定义的进样之间的时间间隔。

提示! 要使用剪切、复制、粘贴、添加行和删除行等功能，请单击 Manage Samples。
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1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

提示! 如要使用现有批次，可单击 Open > Open.

3. 单击 New。

4. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

5. 在表格中键入批次信息。

关于表格中的列的描述，请参阅表格：表 5-1。

提示! Batch 工作区提供以下功能，以更轻松地创建批次：

• Sample Type 等单元格的内容可以从单元格列表中选择。单击单元格右侧显示列表。

• 添加到批次中的第二行及随后的行将自动填充前一行的值。

• 用户可以通过选中单元格、单击单元格的右下角，然后拖动到单元格内容将复制到的
后一行来复制单个单元格。

• 用户可以通过选中单元格、单击 右侧单元格的下角，然后拖动到单元格内容将复制到
的 后一行来复制同一行中的一组单元格。

• 用户可以通过在两行中键入连续值、选中这两个单元格、单击底部单元格的右下角，并
拖动到该系列中的 后一行来复制一系列值。

• 用户可以使用 Copy (Ctrl+C) 和 Paste (Ctrl+V) 命令复制一个单元格或一组单元格的内
容，然后将它们粘贴到新位置。

注释: LC 列在 LC 方法被选中前不可用。

提示! 要配置批次以在采集样本后自动处理样本，请使用以下方法之一：

• 要使用内嵌的处理方法，请选择现有的 Results File。样本将使用相应 Results 文件的
内嵌方法进行处理。

• 若要使用新的处理方法，请清除 Results File 字段。清除 Results File 字段时，
Processing Method 字段将可用。选择一种 Processing Method，然后键入新的
Results File 名称。样本将使用选中的处理方法进行处理。

在非目标筛选工作流中进行处理时，无法选择比较样本进行自动处理。对于使用
AutoPeak 算法的处理方法，软件始终使用创建方法所用的样本来构建积分模型。

6. （可选）定义成分浓度。请参阅以下章节：添加成分浓度

7. （可选）按以下步骤对批次应用决策规则：

a. 选择 Decision Rules 复选框。

b. 单击 Decision Rules，然后对要应用到批次的每个决策规则选择 Apply。要添加决
策规则，请参阅以下章节：添加决策规则。

操作说明 - 采集方法

软件用户指南
RUO-IDV-05-9804-ZH-F

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统

63/214



c. 单击 Save。

注释: 如已选择 Decision Rules 选项，且至少一个决策规则是对于该批次是活动的，则
在 Queue 工作区批次名称旁显示 Decision Rules: Active。如活动项目位于该网络且网
络不可用，则显示文本 Decision Rules: Disabled。

8. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。

9. 提交批次前确保达到柱温箱温度。

10. 确保使用批次中所用的 MS 和 LC 方法平衡系统。

11. 提交批次。请参阅以下章节：提交批次。

使用样本板布局功能创建批次（LC 系统）

样本板布局功能可为用来填充 Batch 工作区内表格的样本架和样本板结构提供图形显示。

1. 打开 Batch 工作区。

2. 选择 MS Method。

3. 选择 LC Method。
LC 系统必须处于活动状态。

4. 键入将保存采集数据的 Data File 的名称。

5. 选择将用于在采集后处理数据的 Processing Method。

6. 键入将保存处理数据的 Results File 的名称。

7. 单击 Plate Layout。
Plate Layout 窗口随即打开，并且在默认情况下显示孔板示意图。

8. 设置孔板的属性。
该窗口更新，以图示所选定的孔板类型。

9. 在该示意图中，单击一个样本位置。
所选样本位置在该示意图中完全高亮显示。Batch 工作区更新，从没有完全定义样本位置
的第一行开始，也就是说，不包含 Rack Type、Plate Type（若使用样本板）和 Vial
Position 值。该表格会相应显示样本位置。

10. 根据需要在示意图中继续单击样本位置，以填充 Batch 工作区内的表格。

如果在 Batch 工作区内的表格中键入样本位置，则示意图会相应更新。

提示! 要删除与指定支架类型相关的所有数据，请单击 Clear All。如果选定的支架类型识
别出一个孔板，则 Clear All 下的菜单会包含 Clear Front 和 Clear Back。

11. 要指定重复的选定样本位置，请单击示意图中的样本位置。
样本板布局的示意图用彩色轮廓显示重复样本位置，Batch 工作区内的表格显示相应的数
据。
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图 5-11 样本板布局——重复的样本位置（位置 1）

注释: 未选中的位置以灰色显示，曾选中的位置以带灰色边框的蓝色显示。

12. 要查看示意图中的样本索引，请将鼠标悬停在高亮显示的样本位置上方。
一条工具提示会显示相应的样本索引。

13. 当所有位置分配并审核完毕，请单击 Plate Layout 窗口内的 Close，然后单击 Batch 工作
区内的 Save。

使用样本板布局功能创建批次（Echo® MS 系统）

样本板布局功能可为用来填充 Batch 工作区内表格的样本孔板提供示意图。

1. 打开 Batch 工作区。

2. 完成批次表格的第一行：

a. 选择 MS Method。

b. 选择 AE Method。

c. 键入将保存采集数据的 Data File 的名称。

d. 选择将用于在采集后处理数据的 Processing Method。

e. 键入将保存处理数据的 Results File 的名称。

3. 单击 Plate Layout。
Plate Layout 窗口随即打开，并且在默认情况下显示孔板示意图。随后，窗口显示 后一
次使用的孔板类型或为当前高亮显示的样本指定的孔板类型。

4. 选择 Plate Type。
该窗口更新，以图示所选定的孔板类型。

5. 对于 Sequence 字段，单击表示样本在孔板上的排列顺序的图标。选项包括以下各项：

• Z-Seq（Z 序列）：样本在第一行中从左到右排列，然后在第二行中从左到右排列，以
此类推。

• N-Seq（N 序列）：样本在第一列中从上到下排列，然后在第二列中从上到下排列，以
此类推。

• R-Ser-Seq（行蛇形序列）：样本在第一行中从左到右排列，然后在第二行中从右到左
排列，在第三行中从左到右排列，以此类推。
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• C-Ser-Seq（列蛇形序列）：样本在第一列中从上到下排列，然后在第二列中从下到上
排列，在第三列中从上到下排列，以此类推。

6. 在示意图中，单击要添加到批次中的样本位置，选择序列，然后单击 Add Selected。

提示! 要添加全部样本，请单击 Select All。要清除全部选择，请单击 Remove All。

提示! 拖动光标划过多个孔，以选择它们。

选定的样本将添加到 Batch 工作区中的表格。

7. 单击 Close。

8. 完成批次表格的剩余字段。

9. （可选）保存批次。

10. 提交批次。请参阅以下章节：提交批次。

管理成分浓度
添加成分浓度

批次中包含 MS 方法、处理方法或 Results Table 中定义的成分浓度。使用此程序添加其他成
分浓度。

注释: 对于 QualityControl 和 Standard 类型的样本，通过此程序添加的成分浓度可进行编辑。
当含有成分的处理方法经过样本定义后，成分浓度列会被添加到批次中。通过处理方法添加的
成分浓度仅对包含该成分的处理方法样本是可编辑的。

1. 在 Batch 工作区中，单击 Component Concentrations ( )。

2. 单击 Manage Components > Add Component。

3. 键入 Component 的名称。

4. 单击 OK。
新成分浓度即会添加到当前批次中。

删除成分浓度

通过该步骤将某个成分浓度从批次中删除。

1. 在 Batch 工作区中，单击 Component Concentrations ( )。

2. 单击 Manage Components > Remove Component。
此时会显示成分列表。其中将包含使用 Add Component Concentration 命令添加的所
有成分，以及某种 MRM 方法或者处理方法添加到该批次的时间。

3. 从列表中选择浓度。

4. 单击 OK。
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管理决策规则
添加决策规则

使用此程序添加决策规则。

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Add Rule。
Decision Rules Configuration 对话框打开。

3. 为决策规则键入名称。

4. 定义决策规则的属性，包括标记规则，何时评估决策规则，以及响应。请参阅文档：《帮
助系统》。

5. 单击 Save 保存该决策规则。

6. 单击 Save 关闭对话框。

注释: 如果用户不点击 Decision Rules 对话框上的 Save，新的决策规则将不会被保存。

更改决策规则

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击要更改的决策规则的 Decision Rule Name。
Decision Rules Configuration 对话框打开。

3. 更改决策规则的 Decision rule name 和设置，包括标记规则，何时评估决策规则，以及
响应。请参阅文档：《帮助系统》。

4. 单击 Save 保存该决策规则。

5. 单击 Save 关闭对话框。

注释: 如果用户不点击 Decision Rules 对话框上的 Save，新的决策规则将不会被保存。

删除决策规则

使用此程序删除决策规则。

1. 在 Batch 工作区中，单击 Decision Rules.。
Decision Rules 对话框打开。

2. 单击 Flagging Rule Used。

3. 单击 Delete Rule 删除该决策规则。

4. 单击 Save。

创建副本规则

使用此程序创建副本规则。
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1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击要复制的决策规则。

3. 单击 Duplicate Rule。

4. 单击 Save。

导入决策规则

使用此程序导入决策规则。

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Import List。

3. 导航至要导入的文本文件并选中，然后单击 Open。

4. 单击 Save。

导出决策规则

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Export List。

3. 导航至您希望保存文本文件的位置，键入文件名，然后单击 Save。

4. 单击 Cancel。

平衡系统

在早上运行新方法之前或提交批次之前平衡系统。平衡是为质谱仪和 LC 系统或 Echo® MS 系
统处理后续样本或批次做预热和准备。

1. 单击状态面板上的 Equilibrate。
Equilibrate 对话框随即打开。

2. 从 MS Method 列表中选择一种 MS 方法。

3. 执行以下任一操作：

• 从 LC Method 列表中选择一种 LC 方法。

• 从 AE Method 列表中选择一种 AE 方法。

4. 在 Time (min) 字段中键入平衡时间（单位为分钟）。

（Echo® MS 系统）建议 低平衡时间为 10 分钟。

5. 单击 OK。
当平衡完成时，状态面板中的系统状态为 Ready。

提示! 打开 Queue 工作区监控平衡进度。Queue 工作区表示平衡完成所需时间。要在完
成前停止平衡，请单击 Queue 工作区中的 Stop。
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提交批次

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 单击 Submit。
Submit Samples 对话框随即打开。

2. 单击 OK 继续。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

从 Batch 工作区提交单个样本到队列

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 选择样本的行标识号。

2. 单击 Submit。
Submit Samples 对话框随即打开。

3. 单击 OK 继续。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

从 Batch 工作区提交多个样本到队列

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 执行以下任一操作：

• 单击每个样本的样本行标识号的同时按下 Ctrl。

• 向上或向下拖动标识号列表。
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注释: 样本将按照选定顺序提交，而不按照在批次中的显示顺序提交。

2. 单击 Submit。
Submit Samples 对话框随即打开。

3. 单击 OK 继续。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

Queue 工作区
Queue 工作区显示：

• 队列状态

• 批次状态

• 样本采集和处理状态

在此工作区中，用户可以管理队列中的批次和样本。

默认状态下样本不会显示在队列中。样本信息折叠在批次名称下方。显示批次状态、批次名
称、批次中的样本数量和采集当前批次的剩余时间。

注释: 使用 Echo® MS 系统时，Queue 工作区仅显示批次信息。样本信息不可用。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 数据同时采集到 SCIEX OS wiff2 文件以及与 Analyst 软件兼容的 wiff 文件。

注释: 样本采集过程中，请勿手动更改集成分流阀位置。

图 5-12 Queue 工作区
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表 5-3 Queue 工作区列

标签 描述

Batch Name 提交到该队列的批次名称、批次中的样本数，以及决策规则处理状
态。
队列中每批次为一行。默认情况下，批次为折叠，但可以展开显示该
批次中的所有样本。对于每个样本，在如下列显示信息。

注释: 对于含决策规则处理的批次，软件延迟采集下一个样本，以保证
当前样本的处理完成。如未在允许时间内完成处理，则禁用决策规
则。延时时间是采集时间的 1.5 倍。

Acquisition Status （采集状态）数据采集的状态。有关状态图标的信息，请参阅以下章
节：队列图标。

Est. Start Time （估计开始时间）此样本采集开始的时间。

Acquisition Time （采集时间）采集此样本所需时间。

Sample Name （样本名称）批次中指定的样本名称。

Sample ID （样本 ID）批次中指定的样本标识符。

Barcode （条形码）批次中指定的样本瓶条形码编号。

Rack Code （支架代码）批次中指定的 LC 支架标识符。

Rack Position （支架位置）批次中指定的 LC 支架的安装位置。

Plate Code （孔板代码）批次中指定的 LC 孔板的标识符。

Plate Position （孔板位置）批次中指定的 LC 孔板的安装位置。

Vial Position （进样瓶位置）样本在 LC 孔板或支架中的位置。

MS Method （MS 方法）批次中指定的 MS 方法。

LC Method （LC 方法）批次中指定的 LC 方法。

Injection Volume （注射体积）注射的样本量。

Data File （数据文件）数据将采集到的数据文件的名称。

Scanned Barcode （扫描的条形码）进样瓶的标识符。

User （用户）提交批次的用户的名称。

Project （项目）将在其中保存数据文件的项目。

Data File Status （数据文件状态）数据文件的状态。

Auto Processing
Status

（自动处理状态）数据处理的状态。有关状态图标的信息，请参阅以
下章节：队列图标。

Processing Method （处理方法）将用于处理采集数据的处理方法。如果使用现有的
Results 文件，则此列包含文本 *Embedded Method*。

Results File （结果文件）处理的数据将写入到的文件。
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表 5-3 Queue 工作区列 (续)

标签 描述

Decision Rule
Status

（决策规则状态）样本的标记状态和该决策规则采取的措施。

Decision Rule
Summary

（决策规则摘要）触发的决策规则的名称。

管理队列

样本自 Batch 工作区提交之后开始采集。确认提交批次前系统已经经过平衡。请参阅以下章
节：平衡系统。

注释: 如果在样本采集过程中出现异常终止，请再次运行该样本。如果异常终止是由停电引
起，则自动进样器托盘的温度不再保持恒定，因而给样本品质带来问题。

使用下表中的特性来管理队列中的样本和批次。

表 5-4 Queue 工作区特性

目的 方法

显示或隐藏列。 单击 Manage > Display Columns。请参阅以下章节：显示
或隐藏列。

查看批次中的所有样本。
单击 。

折叠批次中的所有样本。 单击 。

开始采集。 单击 Start。运行任何样本前要对系统进行平衡。

查看已提交样本的状态。 双击批次标题。

重新采集所选样本。 1. 单击样本。

2. 单击 Manage > Reacquire samples。

删除所选样本。 1. 单击样本。

2. 单击 Manage > Delete samples。

删除所选样本标题下的全部样
本。

1. 单击样本。

2. 单击 Manage > Delete samples below row
selection。

清除队列中的全部已采集批次
或样本。

单击 Manage > Clear queue。

从所选的行中删除焦点。 单击 Manage > Clear all selections。
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表 5-4 Queue 工作区特性 (续)

目的 方法

将选定批次或样本移动到队列
的顶部。

1. 单击批次标题。

2. 单击 Manage > Move row to top。

注释: 只能移除未采集到的单个批次或样本。

将选定样本在队列中向上移
动。

1. 单击样本。

2. 单击 Manage > Move row up。

注释: 只能移除未采集到的单个样本。

将选定样本在队列中向下移
动。

1. 单击样本。

2. 单击 Manage > Move row down。

注释: 只能移除未采集到的单个样本。

折叠全部样本和批次。 单击 Manage > Collapse all rows。

显示全部样本和批次。 单击 Manage > Expand all rows。

查看正在采集的样本的数据。 执行以下任一操作：
• 双击正在采集的样本。

注释: 双击 Processing Status 列左侧的其中一个列。

• 单击 Data Acquisition 面板中的 Open data exploration

to view real time data ( )。

查看已采集到的样本中的数
据。 双击 Acquisition Status 列中绿色的复选标记 ( )。

查看已创建的 Results 文件。
双击 Processing Status 列中绿色的复选标记 ( )。

查看正在扫描的条形码瓶。 1. 单击 Manage > Display Columns。

2. 选择 Select Columns 对话框中的 Barcode 或 Scanned
Barcode 复选框或此两者。请参阅以下章节：显示或隐
藏列。

3. 单击 OK。
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表 5-4 Queue 工作区特性 (续)

目的 方法

停止队列。 1. 单击 Stop。

2. 选择 Stop now 或 Stop after the current tasks are
completed。

3. 单击 OK。

停止所有剩余排队样本的处
理。

1. 单击 Cancel remaining processing。

2. 单击 Yes。

打印队列。 单击工作区菜单中的 Print。

显示或隐藏列

1. 在 Queue 工作区中，单击 Manage > Display Columns.

2. 根据需要在 Display Columns 对话框中，选择或取消选择该列复选框。关于列描述，请参
阅表格：表 5-3。
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图 5-13 Display Columns 对话框

3. 单击 OK。

队列图标

表 5-5 队列图标

图标 名称 描述

展开箭头 显示批次中的样本。

折叠箭头 隐藏批次中的样本。
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表 5-6 采集状态图标

图标 1 名称 描述

Completed （不适用于 Echo® MS 系统）样本或整个批次采集成功。
双击此图标以在 Explorer 工作区中打开样本。

（Echo® MS 系统）批次采集成功。双击此图标以在
Explorer 工作区中打开批次。

Warning （不适用于 Echo® MS 系统）样本采集成功，但用户停止
或扩展了采集。

（Echo® MS 系统）批次采集成功，但用户停止或扩展了
采集。

Failed （不适用于 Echo® MS 系统）样本或批次内的任何样本未
成功采集。

（Echo® MS 系统）批次或批次内的任何样本未成功采
集。

Failed （不适用于 Echo® MS 系统）校准样本不符合验收标准。
双击该图标以查看状态报告。

（Echo® MS 系统）校准批次不符合验收标准。双击该图
标以查看状态报告。

In Progress 正在采集样本或批次。

Waiting 样本或批次暂未采集成功，或者未处在采集过程中。

Barcode Warning 条形码读取错误或者条形码扫描与样本不匹配。

表 5-7 处理状态图标

图标 2 名称 描述

Completed （不适用于 Echo® MS 系统）样本处理成功。双击此图标
以在 Analytics 工作区中打开 Results 文件。

（Echo® MS 系统）批次处理成功。双击此图标以在
Analytics 工作区中打开 Results 文件。

Warning 处理被用户停止。

1 如果使用判定规则，则采集状态可能会受到判定规则影响。例如，判定规则可能会中止样本或停止队列。判
定规则会考虑批次中的所有样本、是否有样本正被处理到不同 Results 文件中，然后考虑关联的 Results 文
件。即使是在队列中不再可见的样本也会考虑在内。

2 如果 Processing Status 列为空，则没有为样本选择任何处理方法或 Results 文件。
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表 5-7 处理状态图标 (续)

图标 名称 描述

Failed （不适用于 Echo® MS 系统）样本未处理成功。

（Echo® MS 系统）批次未处理成功。

In Progress （不适用于 Echo® MS 系统）样本正在处理。

（Echo® MS 系统）批次正在处理。

Waiting （不适用于 Echo® MS 系统）样本尚未处理。

（Echo® MS 系统）批次尚未处理。

表 5-8 判定规则状态图标

图标 3 4 名称 描述

Flagging rule
passed

样本符合在判定规则中配置的标记规则的通过条件。

Flagging rule
marginal

样本符合在判定规则中配置的标记规则的临界条件。

Flagging rule failed 样本符合在判定规则中配置的标记规则的失败条件。

Queue stopped 根据判定规则停止队列。当停止队列并采集下一个批次
时，也会显示此图标。

Sample injected 样本根据判定规则重新进样，或者样本从判定规则中配置
的进样瓶进样。

表 5-9 数据文件状态图标

图标 名称 描述

Transfer Complete （不适用于 Echo® MS 系统）样本已成功传输至网络项
目。

（Echo® MS 系统）批次已成功传输至网络项目。

Transfer in Process （不适用于 Echo® MS 系统）样本正在传输至网络项目。

（Echo® MS 系统）批次正在传输至网络项目。

3 当用户将光标悬停在判定规则名称、标记规则名称和采取的操作上时，将会显示标记状态图标及其工具提
示。

4 如果用户选择在采集所有标准品后评估规则，则追溯性地更新标记样本的状态。
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表 5-9 数据文件状态图标 (续)

图标 名称 描述

Transfer Failed （不适用于 Echo® MS 系统）样本传输失败。SCIEX OS
将尝试再次传输样本。

（Echo® MS 系统）批次传输失败。SCIEX OS 将尝试再
次传输该批次。

MS Tune 工作区
保存仪器数据时软件会创建一个 dat 文件。可使用该文件来恢复之前的参数状态。dat 备份文
件以文件创建时间而不是备份时间命名。

注释: （SCIEX 4500、5500、5500+、6500 和 6500+ 系统）仪器优化应只使用 ESI 探针执
行。

注释: （SCIEX 7500 系统）仪器优化应采用 Analytical 探针和相应的 E Lens 技术执行。强度
规格仅应用于此配置。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

优化检测器

当系统灵敏度较低时，请使用本程序验证检测器电压是否已优化。在本程序进行过程中，软件
可调节检测器电压，以提供 佳灵敏度。当完成优化时，用户可保存优化值或舍弃改动。

注释: 确保在 High Mass 和 Low Mass 模式执行此程序。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中，执行以下操作之一：

• 选择 Positive Detector Optimization 或 Negative Detector Optimization。

• 选择 Detector Optimization。

Introduction 页面随即显示。它描述了优化过程的目的、前提条件及指示。

3. 确保正确配置注射泵。请参阅文档：《系统用户指南》。然后单击 Next。

4. 确保喷雾稳定，之后单击 Next。

5. 请按照屏幕上的指示操作。 请参阅文档：《帮助系统》。
优化报告随即显示。

6. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。
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注释: 软件还会在同一个文件夹中保存相应的 wiff 数据文件和优化报告。

7. 单击 Next。

8. 单击 Save Settings。
系统将显示以下消息：“Tuning settings were saved”。

调谐 MS 扫描

注释: 确保在 High Mass 和 Low Mass 模式执行此程序。

1. 打开 MS Tune 工作区。

2. 单击 Tuning Procedures > MS Scan Tuning。
随即将显示 MS Scan Tuning Settings 窗口。

3. 选择是否 Verify MS scans 或 Tune and calibrate MS scans。请参阅文档：《帮助系
统》。

如果选择了 Verify MS scans，则选择 Show tuning status 以显示通过或未通过状态。

4. 选择要使用的调谐程序。请参阅文档：《帮助系统》。

5. 为选定的调谐程序配置程序设置。

6. 单击 Next。
Introduction 页面随即显示。其中描述了调谐程序的目的、前提条件及指示。请参阅文
档：《帮助系统》。

7. 单击 Next。
随即将显示 Achieve Stable Spray 页面。

图 5-14 示例：稳定喷雾（正极性，低质量模式）

图 5-15 示例：稳定喷雾（负极性，高质量模式）

8. 等待喷雾稳定，之后单击 Next。
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9. 优化离子源气体 1。请参阅文档：《帮助系统》。
该软件指导用户优化选定的扫描模式和扫描速度。

10. 请按照屏幕上的指示操作。
随即将显示优化 Report 页面。下图显示 High Mass 模式中执行的程序示例图。该图仅用
于说明。如在 Low Mass 模式下执行程序，图中将不会显示峰 1522（正）和 1566
（负）。Q1 和 Q3 扫描类型的所关注峰和形状类似。

图 5-16 示例：正极 Q1 扫描（High Mass 模式）
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图 5-17 示例：负极 Q1 扫描（High Mass 模式）

图 5-18 示例：正极 LIT 扫描（High Mass 模式）

操作说明 - 采集方法

软件用户指南
RUO-IDV-05-9804-ZH-F

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统

81/214



图 5-19 示例：负极 LIT 扫描（High Mass 模式）

11. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

注释: 软件还会在同一个文件夹中保存相应的 wiff 数据文件和优化报告。

12. 单击 Next。

13. 单击 Save Settings。
系统将显示以下消息：“Tuning settings were saved”。

恢复仪器数据

每当用户在每次调谐程序结束时保存调谐设置时，软件均会先生成一份仪器数据文件 (dat) 拷
贝，然后更新当前 dat 文件。之前保存的设置可使用 Restore Instrument Data 功能恢复。

每次执行调谐程序时，会生成报告和数据文件以跟踪优化结果。默认情况下，wiff2 数据文件
和报告可在如下位置找到：D:\SCIEX OS Data\Optimization。

1. 打开 MS Tune 工作区。

2. 从 Restore Instrument Data 菜单中，选择一个拥有较早时间戳的待还原 dat 文件。
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图 5-20 Instrument Tuning and Optimization 对话框

3. （可选）按照以下步骤查看要还原的 dat 文件的报告：

a. 单击 View Report。

b. 如果为选定的仪器数据文件生成报告，则导航至报告文件并双击它进行打开。

4. 单击 Yes。
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操作说明 — 处理 6
Explorer 工作区
对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

打开样本

在 Explorer 工作区中执行数据检查任务之前，打开要检查的样本。

1. 打开 Explorer 工作区。

2. 要打开单个样本，请遵照以下步骤：

a. 单击 File > Open Sample。
Select Sample 对话框即会打开。

b. 浏览，然后选择要打开的样本。

c. 单击 OK。

3. 要打开多个样本，请遵照以下步骤：

a. 单击 File > Open Multiple Samples。

b. 在 Select Samples 对话框中，从 Available 列表中选择样本，然后单击箭头以移动
文件至 Selected 列表。

提示! 要选择一个样本，请展开文件，单击该样本，然后单击箭头。

c. 单击 OK。

验证是否存在某种分析物

必要程序

• 打开样本。

1. 提取离子。请参阅以下章节：提取离子。

2. （可选）显示 Data and Peaks Table。请参阅以下章节：显示 Data and Peaks Table。

3. 检查化合物的峰面积、强度、质量和电荷状态。

对于 SCIEX Triple Quad 系统，电荷状态仅适用于全扫描数据类型。
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提取离子

必要程序

• 打开样本。

用来计算一个或多个叠加的提取离子色谱图 (XIC)，此图表示在给定质量范围内作为保留时间
函数的强度的总和。

1. 单击 Show > Extract Ion Chromatogram (XIC)。

图 6-1 Show 菜单：Extracted Ion Chromatogram (XIC)

2. 如果 Specify XIC Ranges 对话框打开，则执行以下步骤：

a. 键入 Center、Width 和 Compound 值或导入值。

注释: XIC 默认标题包括给定行的单元格内所示的化合物名称。

提示! 当使用 Center/Width 模式时，可为该 Center 值指定化学式，而非质量。当使
用中性成分，例如 H2O 时，会在正离子模式下自动加上质子，或在负离子模式下减
去质子。例如，m/z 比（H3O+ 的 m/z 比）将用于正离子模式。通过在该成分的末尾
附加“+n”或“-n”，可明确指定电荷状态（其中，n 表示电荷状态；如果 n 被略去，则视
作 1）。例如，如果指定 H2ONa+，+，则 m/z 比（H2ONa++ 的 m/z 比）按原样使
用。

b. （可选）使用右键菜单中的功能自定义离子提取的选项。有关更多信息，请参阅文
档：《帮助系统》。

c. 单击 OK。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打
开。
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图 6-2 Process All Overlays? 对话框

3. 如果 Select MRMs 对话框打开，则选择 MRM 以包含在 XIC 中，然后单击 OK。

4. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 XIC。

• 选中 Active Only，以仅从当前活动样本生成 XIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

打开 Total Ion Chromatogram
必要程序

• 打开样本。

总离子色谱图 (TIC) 通过将一系列质量扫描中所有离子的强度贡献值进行求和而创建。使用
TIC 可在单一窗格内查看整个数据集。TIC 通过将一次扫描中所有离子的强度之和作为色谱窗
格中所示时间的函数绘制而得。

1. 单击 Show > Total Ion Chromatogram (TIC)。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

2. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 TIC。

• 选中 Active Only，以仅从当前活动样本生成 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。
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3. 右键单击 TIC，然后使用右键菜单中的功能。

图 6-3 总离子色谱图的右键菜单

项目 描述

1 当存在一条以上的叠加轨迹时，该功能可用。可从图中删除当前活动的轨
迹。要删除一条当前不活动的轨迹，可将其激活，然后再选择该功能。

2 当存在一条以上的叠加轨迹时，该功能可用。可删除当前活动轨迹以外的
所有轨迹。如果要保留的轨迹当前不活动，则应将其激活，然后再选择该
功能。

3 给图形添加文本。

如果需要，可单击 Font 以调节字体属性，然后再单击 OK。将说明文字
添加在 (x, y) 位置，用户可在此位置右键单击，以打开菜单。

添加说明文字后，用户可将其拖至新位置。如果用户拖动其进入 X 或 Y
轴，则会取消拖动操作。

字符序列“\d”和“\u”按照特殊方式进行处理。在前一种情况下，紧随字符绘
制为下标，而后一种情况则将其绘制为上标。在两种情况下，特殊字符均
不可见。这对化学式而言尤其有用。例如，'H\d3O\u+’ 显示为 H3O+.

4 编辑选定的说明文字。用户也可通过双击说明文字来打开该对话框。

5 删除选定的说明文字。或者，将说明文字拖到图形外，以将其删除。

6 在图形包含至少一处说明文字时可用。一次性删除所有说明文字。

7 在图形中粘贴一幅图像。

8 可从图形中删除选定图像。
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打开 Base Peak Chromatogram
必要程序

• 打开样本。

可通过将每个质谱图 大峰的强度作为时间的函数生成一张图。

1. 单击 Show > Base Peak Chromatogram (BPC)。

图 6-4 BPC Options 对话框

2. 填充 BPC Options 对话框中的字段。有关字段的信息，请参阅文档：《帮助系统》。

注释: 如果单一选定区域持续 1.0 分钟以上的色谱图在生成基峰色谱图时处在活动状态，
则该时间范围会作为选定区域的默认时间范围。否则，会使用 近的时间范围。有限时间
范围让用户免于手动键入具体范围。

如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。
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图 6-5 Process All Overlays? 对话框

3. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 BPC。

• 选中 Active Only，以仅从当前活动样本生成 BPC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

显示 Data and Peaks Table
必要程序

• 打开样本。

Data and Peaks Table 包含两个不同的表格。Data 表显示由一个数据集构成的原始 (X, Y)
值，Peaks 表显示有关峰本身的信息。此表在图形激活时生成。

注释: 图中仅显示高于当前阈值的峰，使用图中 Y 轴上的蓝色箭头进行设置。请参阅以下章
节：在图形中使用数据。

该功能用来为当前的活动数据显示包含两个表格的窗格：一个表格涉及原始 (X, Y) 值，另一个
表格与峰列表有关。

1. 单击 Show > Data and Peaks Table。
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图 6-6 Show 菜单：Data and Peaks Table

2. 使用下表中的功能。

表 6-1 Data and Peaks Table 功能

目的 方法

根据该字段对表格进行排
序。

单击列标题。

复制当前选定的单元格。 右键单击该表格，然后单击 Copy。如果 Data 选项卡已激
活，则选定的 X 和 Y 值会被复制。如果 Peaks 选项卡已激
活，则选定的峰信息会被复制。

仅复制选定行。 首先，通过在行选择器列内拖动以选择行，使用 Shift 或
Ctrl 键可选择多行。然后，右键单击该表格，并单击
Copy。

选择多列。 按住 Ctrl 键，然后单击列标题。如果用户仅单击列标题，则
会对此列排序。

复制整表。 单击 Edit > Select All，然后单击 Edit > Copy。

导出数据为文本。 右键单击该窗格，然后单击 Export Data as Text。

可将整个数据列表保存至指定文件。X 和 Y 值用一个制表符
隔开，每对 (X, Y) 后都有一个硬回车。
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表 6-1 Data and Peaks Table 功能 (续)

目的 方法

导出峰列表数据为文本。 右键单击该窗格，然后单击 Export Peak List as Text。

可将整个峰列表保存至指定文件。这不包括低于当前阈值
（在相关图形的 Y 轴设定）的峰。峰度量指标用制表符隔
开，每个峰后面都有一个硬回车。

3. 检查化合物的峰面积、强度、质量和电荷状态。

注释: 电荷状态仅对全扫描数据类型可用。

显示 Sample Information
必要程序

• 打开样本。

Sample Information 窗格对用来采集活动数据的实验进行了文字描述。这些信息包括样本特定
信息，包括样本名称和有关数据采集的信息，如实验的数量和类型。

如果涉及同一数据文件的不同样本的两个或多个 Sample Information 窗格均可见，则单击树状
视图内有关任一窗格的某个项目会使所有其他窗格滚动至相应区域。这时假定所有窗格均存在
同名区域。如果用户想比较两个相似、但不完全相同的样本信息窗格，则该功能非常有用。

单击 Show > Sample Information。

显示 Graph Selection Information
必要程序

• 打开样本。

Graph Selection Information 对话框显示有关色谱图或质谱图内选定区域的信息，可在其中一
个这类窗格激活时生成。

1. 单击 Window > Graph Selection Window。
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图 6-7 Graph Selection Info 对话框

2. 在色谱图或质谱图中进行一项或多项选择。

图 6-8 Graph Selection Info 对话框

3. 适用时，从列表中选择一个选项：Default Info、XY Info、Standard Deviations、
Signal/Noise 或 Manual Reconstruct。
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图 6-9 选择信息选项

关于对话框中的字段的描述，请参阅文档：《帮助系统》。

4. （可选）手动计算信噪比。

a. 选择色谱图或在质量重建工作流中选择重建图形。

b. 用 Shift 键进行多选，一同选择噪声区域和目标峰。

c. 选择 Default Info > Signal/Noise。

5. （可选）单击 Options ( )，设置 Graph Info 选项，然后单击 OK。关于选项描述，请参
阅文档：《帮助系统》。

例如，要使用 3 Sigma 作为噪声因数，将 Noise multipler for S/N 设置为 3。

6. （可选）单击 Fill Peaks( )。
在活动图中，可在深浅交替填充峰与不以交替方式填充峰这两种模式之间进行切换。如果
用户想查看与 Peak Width at Base 相对应的峰范围，则该功能非常有用。

7. （可选）单击 Show Point Symbols( )。
活动窗格中的所有谱图可在用点符号表示数据点与不以点符号表示数据点这两种模式之间
进行切换。如果用户正在仔细检查一个峰并且想了解有多少个数据点构成该峰（而不是仅
使用主窗口所示的文本信息），则该功能非常有用。

在图形中编辑设置

必要程序

• 打开样本。

单击 Edit，然后使用 Edit 菜单中的功能。
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图 6-10 Edit 菜单：Options

项目 描述

1 复制当前数据至剪切板。当质谱图或色谱图激活时，会复制该活动图的一
张图片。

2 当质谱图激活时，将当前图形作为照片复制到剪切板。

3 将整个活动窗口的图像复制至剪切板。其中不包括该窗口的标题栏及其各
种窗格的工具栏。

4 将剪贴板中的数据粘贴到当前视图中。

5 当一个表格激活时，可选择表内的所有行。当一个文本窗格激活时，可选
择全部文本。

6 允许用户设置有关图形外观、峰标记和寻找、自动处理以及计算 XIC 范
围的选项。请参阅以下章节：设置选项。

7 恢复默认的 Explorer 选项。请参阅以下章节：重置选项。

在图形中使用数据

必要程序

• 打开样本。

1. 要设置标记峰的阈值以及诸如 Data and Peaks 表中的后续功能，可拖动图中 Y 轴所示的
蓝色箭头。
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图 6-11 Y 轴上的蓝色箭头

2. 使用 Graph 菜单中的功能。
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图 6-12 Graph 菜单：Options

项目 描述

1 选择要在后续操作中处理的图形部分。例如，选择色谱图中的一个区域，
然后双击以获得平均质谱图。使用 Set Selection 功能，以键入特定的 X
范围，从而可能比使用光标时更准确地设置选定部分。

a. 单击 Graph > Set Selection。

Set Selection 对话框随即打开。

b. 键入 Center 和 Width 值。

c. 单击 OK。

提示! 要在图中手动设置选定部分，请在绘图区拖动光标以进行选择。如
果按住 Shift 键，则任何当前选定部分会得以保留。
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项目 描述

2 出于绘图目的，可按照指定倍数，在一定范围扩大 Y 值。

a. 打开一个样本或多个样本。

b. 在图中选择一个部分。

c. 单击 Graph > Expand Selected Y-Values by。

Expand Selection 对话框随即打开。

d. 键入扩大系数。

e. 单击 OK。

3 清除所有扩大范围。
• 在范围已扩大的图形中，单击 Graph > Clear Expansion Ranges。

4 可从图中删除当前活动的轨迹。当存在一条以上的叠加轨迹时，该功能可
用。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove Active

Trace。

5 可删除当前活动轨迹以外的所有轨迹。当存在一条以上的叠加轨迹时，该
功能可用。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove All Traces

Except Active。

6 从图中删除所有数据点均低于当前所设阈值的叠加轨迹。

如果用户将图形放大并导致当前只有一部分 X 范围可见，则会打开一个
对话框。用户可选择是使用整个范围还是仅使用当前可用部分来删除低于
阈值的轨迹。

• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove Traces
Below Threshold。

7 当活动图包含一条以上叠加轨迹时，可使用较为浅淡的线条，绘制除当前
活动轨迹以外的所有轨迹。使用该功能可将注意力集中于活动轨迹。这
样，不活动轨迹引起注意力分散的可能性就会减小。要恢复至原始样式，
请再次选择该功能。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Fade Inactive

Trace。

8 当活动图形中包含一条以上叠加轨迹，请反转第二条轨迹。这可使其容易
目视比较两条相似轨迹。再次选择 Invert Second Overlay，可恢复至原
始视图。

9 将单一轨迹图形替换为对所有单独轨迹求和所得的图形。
• 在包含一条以上叠加轨迹的活动图中，单击 Graph > Sum Graph

Traces。

操作说明 — 处理

软件用户指南
RUO-IDV-05-9804-ZH-F

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统

97/214



项目 描述

10 为每个单独叠加轨迹创建一个图形。例如，如果用户从包含三个叠加轨迹
的图中开始，然后选择该功能，那么 终结果包含四个窗格：原图包含所
有叠加轨迹，其余三个图形各包含一个不同的数据集。
a. 在包含一条以上叠加轨迹的活动图中，单击 Graph > Split Traces

into Separate Panes。

Number of Columns 对话框随即打开。

b. 选择输出中的列数。

必需行数根据行数和叠加轨迹数确定。

c. 选择该复选框，可在新窗口中打开窗格。如果该复选框未选中，则会
在同一窗口内打开窗格。

11 可打开 Set Titles 对话框。使用该选项可手动更改轨迹的标题。

12 可打开 Color 对话框。使用该选项可为当前活动图的轨迹设置颜色。

13 可打开 Set Trace Colors Using Titles 对话框。当叠加有多条图形轨迹
时，软件可为叠加轨迹使用默认颜色。使用该选项可为标题包含指定文本
的轨迹设置特定颜色。

14 为当前活动图的数据创建副本，然后将其添加至该图中。使用该功能可查
看特定数据处理操作的效果。例如，如果用户使用该功能复制数据，然后
再对两条轨迹其中之一进行平滑，那么所得图形包含操作之前和之后的的
叠加轨迹。

• 在活动图中，单击 Graph > Duplicate Active Data。

15 为当前活动的图形创建副本。使用该功能可查看特定数据处理操作的效
果。例如，如果用户使用该功能复制数据，然后再对两条轨迹其中之一进
行平滑处理，那么操作之前和之后的轨迹显示在两张不同的图形中。链接
X 轴可使在缩放一个图形时，另一个图形也会自动缩放。

• 在活动图中，单击 Graph > Duplicate Graph。

16 可打开 Offset Traces 对话框。使用该选项可根据一系列叠加图形轨迹创
建一幅三维层叠图。

17 从 TIC 中删除生成的偏移。

使用双窗格操作工具

必要程序

• 打开 Explorer 工作区。

使用沿着窗格右边缘的图标，在两个窗格（源窗格和目标窗格）上执行操作。请参阅以下章
节：表 6-2。在所有情况下，单击源窗格内的图标，然后将其拖至目标窗格。
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表 6-2 双窗格工具

图标 名称 描述

Move Pane 改变窗格的相对位置。显示在每个窗格的右上角。单击
一个窗格中的图标，然后将其拖动至第二个窗格的顶
部、底部、左侧或右侧部分。根据光标释放位置的不
同，第一个窗格相对于第二个窗格的位置改变。当用户
拖动窗格时，第二个窗格的一侧红色高亮，指示第一个
窗格将要放置的位置。

注释: 用户也可以将窗格从一个窗口拖动至另一窗口。

Add Data 逐点对两个数据集进行求和。 初单击的源窗格中的数
据会被添加至目标窗格（拖放图标在该窗格中释放）。
修改后窗格的标题更新，以表明其已修改。

注释: 只有类型相同的两个数据集，才可以相加。例如，
用户不能将质谱图添加至色谱图中。

提示! 如果目标图含有一个以上的叠加轨迹，那么在默认
情况下，源数据只添加至活动目标数据中。按住 Ctrl
键，可将源数据添加到目标窗格内的所有数据集。

Subtract Data 从质谱中减除背景。与 Add Data 图标相似，区别在于
该图标会将源数据从目标数据中减除。

提示! 如果目标图含有一个以上的叠加轨迹，那么在默认
情况下，源数据只从活动目标数据中减除。按住 Ctrl
键，可将源数据添加到目标窗格内的所有数据集。

提示! 通常，不保留源数据内的强度大于目标数据内强度
的任何数据点。也就是说，负 Y 值会被舍弃。按住 Shift
键，可保留强度为负值的数据点。

Overlay Data 将源图内的活动数据叠加在目标图上。操作完成后，目
标图包含一个新系列和一份目标数据。

提示! 如果源图包含一条以上的叠加轨迹，那么在默认情
况下，只有活动数据的一个副本会移动至目标图中。按
住 Ctrl 键，可将源图内所有数据集的一个副本叠加在目
标图上。

移动窗格或窗口

必要程序

• 打开样本。
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单击 Window，然后使用 Window 菜单中的功能。

图 6-13 Window 菜单：Options

项目 描述

1 可打开一个窗口，其中显示活动图内选定区域的信息。例如，选定区域的
X 范围、选定点的强度范围等等。如果该窗口已经显示，则选择该菜单项
会将其关闭。请参阅以下章节：显示 Graph Selection Information。

2 可将窗口的信息布局从行格式更改为列格式。

3 可从窗口中删除当前活动窗格，并将其放在新窗口内。

4 排列任何已打开且尚未 小化的窗口，从而使其都并排位于一行内。

5 排列任何已打开且尚未 小化的窗口，从而使其都上下排列于一列内。

执行高斯平滑

必要程序

• 打开样本。

应用高斯平滑算法。这是一个具有指定宽度的过滤器，其加权因数符合高斯或正态函数。

1. 单击 Process > Gaussian Smooth。

图 6-14 Gaussian Smooth 对话框

2. 在 Smoothing width 字段中键入一个数值。
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这实际上是高斯函数在其 大高度一半时的宽度。总宽度较大是因为此项计算将高斯曲线
的两翼包括在内。如果高斯函数的半宽小于 1 个点，则允许使用分数值。

3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

阈值数据

必要程序

• 打开样本。

删除强度低于当前阈值设置的任何数据点。拖动图形 Y 轴所示的蓝色箭头，以设置阈值。

1. 单击 Process > Threshold Data。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

图 6-15 Process All Overlays? 对话框

2. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 TIC。

• 选中 Active Only，以仅从当前活动样本生成 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。
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使用图形选定的子集数据

必要程序

• 打开样本。

该功能仅在某图形只有一个选定区域激活时才可用。请删除选定区域以外的数据点。使用该功
能可将数据处理聚焦于完整数据的一个子集。

1. 在图中选择一个区域。

2. 单击 Process > Subset Data (using graph selection)。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

图 6-16 Process All Overlays? 对话框

3. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 XIC 或 TIC。

• 选中 Active Only，以仅从当前活动样本生成 XIC 或 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

基线减除色谱图

必要程序

• 打开样本。

从一张色谱图中去除变化相对缓慢的背景。

对于色谱图中的每个数据点，窗口在对应 X 值处居中，找到窗口内相对左右强度 小的点。这
两点之间用一条直线连接，Y 值在窗口中心计算得出。这是该点数据要去除的基线。

操作说明 — 处理

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
102/214

软件用户指南
RUO-IDV-05-9804-ZH-F



1. 单击 Process > Baseline Subtract Chromatogram。

图 6-17 Baseline Subtract 对话框

2. 在 Subtraction half window 字段中键入一个数值（用分钟表示）。

3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

偏移色谱图

必要程序

• 打开样本。

用来偏移色谱图的时间值。

1. 单击 Process > Offset Chromatogram。

图 6-18 Offset 对话框

2. 在 Total offset 字段中键入一个数值（用分钟表示）。
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3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 选择 Use incremental offset (to fan out overlays) 以在时间方向上将叠加分开。

5. 单击 OK。

为质谱创建质心

必要程序

• 打开样本。

为质谱创建质心，也就是说用质量和强度点取代轮廓谱图，这仅适用于检测到的峰。

1. 单击 Process > Centroid Spectrum。

图 6-19 Centroid 对话框

2. 选择要用于质心过程的度量：

• Intensity：对于每个峰，质心 Y 值就是构成该峰的 大数据点的强度。

• Height ：该度量与强度度量相似，区别在于若存在基线偏移，需从强度值中减除基线
强度。

• Area：对于每个峰，质心 Y 图就是该峰的总面积。这是一个准确的整数，因为报告值
同时取决于强度轮廓和峰宽。

• Intensity sum above 50%：对于每个峰，Y 值就是构成该峰的高于峰顶强度 50% 的
强度部分之和。该值非常有用，因为它不像 Intensity 和 Height 度量那样仅取决于单个
数据点的强度，并且它也不受可能是噪声或可能受到干扰的峰边缘的影响。
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3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

导出数据为文本

必要程序

• 打开样本。

将当前活动的质谱图或色谱图保存至一个制表符分隔文本文件。

1. 单击 File > Export > Data as Text。
如果质谱数据已导出，则 Add Zero Intensity Points for Export 对话框随即打开。

图 6-20 Add Zero Intensity Points for Export 对话框

2. 如果 Add Zero Intensity Points for Export 对话框打开，则执行以下任一操作：

• 单击 No, leave data as-is 从导出的文件中排除强度为零的点。

• 单击 Yes, add points with zero intensity 将强度为零的点包含到导出的文件中。

然后单击 OK。

3. 键入导出文件的文件名。

4. 单击 Save。

导出峰列表为文本

必要程序

• 打开样本。
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用户可将当前活动的质谱图或色谱图的峰列表保存至一个制表符分隔的文本文件。该文件包含
诸如质心 X 值（质量或时间）、峰面积、高度等信息。

1. 单击 File > Export > Peak List as Text。

2. 键入导出文件的文件名。

3. 单击 Save。

打印数据

必要程序

• 打开样本。

1. 单击 File > Print，然后选择所需选项。
Print 对话框随即打开。

2. 选择打印机，然后单击 Print。

重置选项

必要程序

• 打开 Explorer 工作区。

用户可将 Explorer 工作区内的所有选项重置为默认值。这包括在前一节介绍的选项以及处理
选项。重置选项仅影响当前登录的 Windows 用户，而同一计算机的其他用户不受影响。

1. 单击 Edit > Reset Options。
此时会出现一个确认对话框。

2. 单击 OK。

设置选项

必要程序

• 打开 Explorer 工作区。

必要时可使用每个选项卡中的功能。

1. 单击 Edit > Options。
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图 6-21 Options 对话框：Graph Appearance 选项卡

2. 适用时，设置每个选项卡上的选项。关于选项描述，请参阅文档：《帮助系统》。

3. 单击 OK。

Analytics 工作区
对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 从 Analytics 工作区输出数据的受控方式为：导出 Results Table、将数据传输至 LIMS
以及报告。输出数据的其他来源，比如从结果表复制和粘贴，是不受控的方式。不得将这些非
受控方法用于受管制的用途。

Analytics 工作区不支持数字分组。不要对文本框（例如积分参数）中的数字或 Results Table
等网格中的数字分组。

处理方法包括积分选定峰的定量的标准。

审核人应当按照峰积分标准以及实验室标准操作规程 (SOP) 中的数据接受度来审查数据。

SCIEX OS 可以在 SCIEX OS 或 Analyst 软件采集数据时处理数据。任何采集的样本都可以添
加到 Results Table 中。要添加正在采集的样本，请先等待采集完成，然后将它们添加到
Results Table 中。
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定义项目的默认处理参数

该选项设置创建处理方法时所使用的默认找峰参数。如果成分较多，可根据色谱设置默认值，
这样就无需对每一种成分进行逐个调整。不过，没有哪一组参数对于所有成分都是理想的，因
此，对于某些成分而言，可能需要对某些参数逐一进行调整。

1. 在 Analytics 工作区中，单击 Projects > Project default settings。

注释: 请确保在状态面板选中当前项目名称。

此时 Project Default Settings 对话框打开。

2. 在 Quantitative Processing 页面上，执行这些步骤：

a. 从 Signal to Noise Algorithm 列表中选择信噪比算法。

b. 从 Integration Algorithm 列表中选择积分算法，然后设置默认参数进行定量处理。

关于参数描述，请参阅文档：《帮助系统》。

3. 在 Qualitative Processing 页面上，从 Library Search Algorithm 列表中选择库搜索算
法，然后设置定性处理的默认参数。

有关算法的信息，请参阅文档：《帮助系统》。

4. 在 Mass Reconstruction Processing 页面上，从 Integration Algorithm 列表中选择积分
算法，然后设置质量重建的默认积分参数。
关于参数描述，请参阅文档：《帮助系统》。

注释: 仅 MQ4 和求和算法可用。

5. 单击 Save。

6. 单击 Close。

使用工作区布局

使用工作区布局功能在 Analytics 工作区中保存自定义工作区布局。自定义布局与结果文件一
起保存，在打开文件时自动应用。这样可在用户分析结果时为其节省时间。保存的工作区布局
可应用于其他结果文件。它还可设置为项目的默认工作区布局，每当打开该项目中的结果文件
时就会应用。工作区布局可保存在任何位置，包括本地网络上。

用户可以在不同的已保存布局之间更改，以对其结果文件执行不同类型的数据分析。

注释: 所有工作区布局都使用 qlayout 文件扩展名保存。

注释: 任何可直接更改或修改数据的设置都不会保留在工作区布局中。

下表列出了与工作区布局保存在一起的 UI 元素。
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表 6-3 与工作区布局保存在一起的 UI 元素

窗格 保存的 UI 元素

Results Table • Qualify for Rules Filters 复选框。

• 合格的行筛选器。

• 表格排序选择。

• 突出显示的行和列。

• Table display settings。

• 列筛选器。

注释: 当工作区布局应用于不同 Results Table 时，如有可能，会应用
列筛选器设置。如果筛选的列在 Results Table 中不存在，或者如果筛
选选项不适用，则不会应用该设置。

Views 菜单 • Show hidden pane 设置。

• 是否选择了 Tabbed view 选项。

Samples 或
Components
and Groups

• Samples 或 Components and Groups 列表是否打开。

• 是否选择特定样本或成分以显示在 Results Table 中。

• 在 Samples 列表中，Options > Synchronize Sample Selection 的
设置。

• 在 Components and Groups 列表中，All Internal Standards、All
Analytes、All Components 和 Groups (where applicable) 选项的
选择。

• 在 Components and Groups 列表中，Options > Show IS 的设置。

Peak Review • Peak Review 窗格是否打开及其是否已停靠。

• 当前 View。

• 任何选定的 Options，包括 Peak review display settings 选项和 XIC
Graph Title 选项。

Calibration
Curve

• Calibration Curve 窗格是否打开。

• Options 菜单中的 Show excluded standards、Show quality
controls、Show legend、Use percent Y-axis 和 Log-log plot 设
置。
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表 6-3 与工作区布局保存在一起的 UI 元素 (续)

窗格 保存的 UI 元素

Metric Plot • Metric Plot 窗格是否打开。

• Link 菜单设置。

• Regression 对话框设置。

• Options 菜单中的 Display "N/A" as 0.0、Show sample names、
Show legend、Use percent Y-axis、Start Y-axis at 0 和 Connect
with lines 设置。

Statistics Pane • Statistics 窗格是否打开。

• 当前的 Sample grouping 选择。

• 当前的 Metric 选择。

保存当前工作区布局

1. 打开 Analytics 工作区。

2. 打开一个 Results Table。

3. 根据需要自定义工作区布局。

4. 单击 Views > Save current layout。
此时会打开 Save Workspace Layout As 对话框。

5. 键入工作区布局名称，然后单击 Save。

对当前项目应用其他工作区布局

对当前结果文件应用不同的工作区布局可让用户快速地对相同数据执行不同类型的结果分析。

1. 打开 Analytics 工作区。

2. 打开结果文件。

3. 单击 Views > Apply different layout to current results。
Apply a Workspace Layout 对话框打开。

4. 单击 Browse，选择布局，然后单击 Open。
Apply a Workspace Layout 对话框显示所选工作区布局的预览。

5. 单击 OK。

提示! 单击 Views > Recent layouts 并选择布局，以应用 近使用的工作区布局。

将当前工作区布局设置为项目默认值

设置项目默认工作区布局可在多个会话或用户之间保留布局。它还使在该项目内创建的任何新
结果文件打开时都使用项目默认工作区布局。

1. 打开 Analytics 工作区。
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2. 打开结果文件。

3. 自定义工作区布局以适应项目。

4. 单击 Views > Set current layout as project default。
Default Workspace Layout for the Project 对话框打开。

5. 在 Default layout name 字段中键入布局名称，然后单击 OK。

6. 单击 Results > Save。

设置项目 Secure Export Settings
只有被分配管理员角色的用户才能执行该任务。

选中该项后，文本文件中的数据在导出过程中会被加密。设置一个用于加密的密码。

1. 在 Analytics 工作区中，单击 Projects > Project secure export settings。

图 6-22 Secure Export Settings 对话框

2. 选择 Encrypt Results Table when exporting for this project 复选框。

3. 在 Password 字段键入密码。

4. 在 Confirm Password 字段再次键入密码。

5. 单击 OK。

启用项目修改峰警告

该选项默认为未选。如果选中该项，当用户在 Results Table 中对某个色谱图进行改动并保存
改动时，就会出现一条警告，提示用户已作改动。用户可以选择继续保存，或者返回 Results
Table。

在 Analytics 工作区中，单击 Projects > Enable project modified peak warning。

创建处理方法

处理方法包含数据处理的定量和定性设置。无针对性工作流程用于未知成分。
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提示! 要编辑现有的处理方法，请单击 Process Method > Open。

1. 打开 Analytics 工作区。

2. 单击 Process Method > New。

提示! 要编辑当前 Results Table 中的处理方法，单击 Process Method > Edit
embedded method，然后继续执行步骤 3。

3. 在 Workflow 页面上，选择至少一个工作流程以及参考样本。关于此页面上的字段的描
述，请参阅文档：《帮助系统》。

提示! 要使用质量重建工作流，仅选择 Quantitation。

4. 选择 Components 页面，然后执行以下步骤：

a. 若适用，单击 Options > Mass Reconstruction，然后单击确认对话框中的 Yes，选
择质量重建工作流。

b. 完成成分表。关于此表格上的字段的描述，请参阅文档：《帮助系统》。

注释: 仅当积分算法设置为 MQ4 或 Summation 时，质量重建工作流可用。

提示! 如果该组在 Components 表中进行定义，那么用户可选择对组内离子求和，即使相
应离子对的母离子扫描和实验指数不同时也不例外。求和离子未显示在表中，但却显示在
Integration 页面上，并且也作为 group name > Sum 显示在 Results Table 中。该功能有
助于定量分析蛋白质和肽。

提示! 如果成分的保留时间未知，则将质量或化学式的 Retention Time Mode 设置为
Find n peaks，其中 n 为 1、2、5、10 或全部。软件可识别指定数量的面积 大的特征
峰，指定合适的保留时间，然后执行针对性的峰处理工作流。处理完成后，Results Table
的内嵌方法可保存为目标方法。

提示! 如要从文本文件中导入成分和积分参数，可从 Import 菜单中选择适当的指令使用。
如果成分信息不包含浓度单位，则软件使用在 Project Default Settings 对话框中定义的
Concentration units。

注释: 无法从使用 AutoPeak 积分算法的处理方法导入积分参数。

注释: 积分参数可从 Analyst 软件定量方法导入。Analyst 软件参数映射到相应的
SCIEX OS 参数，无法映射的任何参数都使用项目默认值设置。

注释: 积分参数可从不使用 SignalFinder 算法的 MultiQuant 软件定量方法导入。对于
MQ4 方法，S/N Integration Threshold 从 MultiQuant 软件中的默认值 0 变为项目默认
值。MultiQuant 软件的参数映射到 SCIEX OS 的相应参数。

5. 选择 Integration 页面，然后执行这些步骤：

a. 为每种成分选择积分参数。关于此页面上的字段的描述，请参阅文档：《帮助系
统》。
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提示! 要定义自动离群值删除的规则，请单击 Options > Remove Outliers
Automatically。请参阅文档：《帮助系统》。

b. （可选）要查看噪声区域，单击 Options > Show Noise Regions。请参阅以下章
节：使用噪声区域。

注释: 仅当信噪比算法设置为 Standard Deviation 或 Peak to Peak 时显示 Show
Noise Regions。

6. （如果适用）选择 Library Search 页面，然后定义谱库搜索参数。关于此页面上的字段的
描述，请参阅帮助系统。

7. 选择 Calculated Columns 页，然后定义自定义计算列中使用的自定义化学式。关于此页
面上的字段的描述，请参阅帮助系统。

注释: 有关计算列的更多信息，请参阅以下章节：计算列。

8. 选择 Flagging Rules 页，然后选择在 Results Table 中用于标记结果的规则。关于此页面
上的字段的描述，请参阅文档：《帮助系统》。

或者，创建自定义标记规则，或为预定义规则自定义下列值：

• 以下各项的接受度标准：

• 接受度标准和质量对照

• 未知样本的计算浓度范围

• 峰积分

• 质量准确度、保留时间置信度、同位素匹配、谱库分数和化学式查找器分数的红绿灯设
置

• 离子率接受度的红绿灯设置

离子率为峰响应率，即定性离子和定量离子的峰面积或高度。

提示! 如要从文本文件导入标记规则，可单击 Import。

9. 选择 Formula Finder 页面，然后选择化学式查找器设置。关于此页面上的字段的描述，
请参阅文档：《帮助系统》。

10. （如果选择了无针对性工作流程）选择 Non-targeted Peaks 页面，然后定义无针对性搜
索参数。关于此页面上的字段的描述，请参阅文档：《帮助系统》。

11. 单击 Save。

提示! 如果创建了无针对性方法，则当前项目的默认参数用于峰积分，那些参数保存在处
理方法文件中。如果处理方法包含目标分析物，那么目标成分的自定义积分参数将不会影
响无针对性峰积分。如果用户稍后更改了项目默认参数，那么更改后参数将不会影响现有
的无针对性方法，它仍会包含方法创建时的参数。只有新创建的无针对性方法才使用更改
后参数。
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处理数据

1. 打开 Analytics 工作区。

2. 单击 Results > New。

3. 在 Process New Results 对话框中，使用箭头 (  和 ) 选择要处理的样本。

4. 按以下方式之一选择处理方法：

• 单击 Browse，然后选择处理方法并单击 Open。

• 单击 New，然后创建新的处理方法。请参阅以下章节：创建处理方法。

5. （可选）单击 Edit 以编辑处理方法。请参阅以下章节：创建处理方法。

6. 为无针对性工作流程选择对比样本。

7. 单击 Process。

注释: 在无针对性分析中，执行按加合物自动分组。如果保留时间相同的化合物之间存在
的质量差与一种常见加合物相关，则分组算法会为这些化合物分配加合物改性剂。此功能
有助于防止调查具有不同电荷加合物的重复化合物。

如果数据包含的自定义批次列与预定义 Results Table 列或现有化学式同名，将会显示一
条警告消息。单击 OK 继续。这些列名称的开头会添加一个下划线 (_)。

8. 要显示或隐藏样本类型，单击 Sample Type 列上的筛选器图标 ( )，然后选择或清除所
需的复选框。

9. 要设置接受度筛选器，单击任何接受度列上的筛选器图标 ( )，选择 Filter by Flag，然
后选择 Pass 或 Fail。

注释: Acceptance 列包括 Accuracy、Accuracy Acceptance、Asymmetry Factor、
Calculated Concentration、Concentration Acceptance、Integration Acceptance、
Quality Retention Time Delta (min)、Retention Time Error (%) 和 Total Width。

10. 要选择定性置信度筛选器，单击 Confidence 红绿灯，然后选择或清除相应的复选框。

注释: 使用 AutoPeak 算法生成 Results Table 后，如果用户更改了 XIC 宽度和预计 RT，
那么除非用户使用新的 XIC 宽度和预计 RT 值更新该模型，否则数据将使用以前的算法模
型进行重新处理。

11. 要根据 Results Table 列的各个值进行筛选，请单击列标题上的筛选器图标 ( )，然后选
择要显示在 Results Table 中的值的复选框。

提示! 要应用其他自定义筛选器，请选择 Text Filters。

提示! 要在对 Results Table 进行更改（例如，面积计数更改）后重新应用筛选器，单击

Reapply Filter( )。

12. 按以下方式之一选择保存 Results 文件：
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• 单击 Results > Save。

• 要防止对 Results Table 进行更改，请单击 Results > Lock results file and save。

添加样本

前提条件

• 在 Analytics 工作区中，打开 Results Table。

本选项可向当前活动的 Results Table 内添加其他样本。

1. 单击 More > Add samples。

2. 在 Select Samples 对话框中选择所需样本。

• Available 窗格中会显示子文件夹、wiff2 文件以及当前项目的 Data 文件夹项下的可用
样本。

• 展开各个文件夹查看任何子文件夹或 wiff2 文件。如果 wiff2 文件已展开，就会显示可
用样本。

• 使用箭头添加 ( ) 或删除 ( ) 样本。

• 按照以下方式选择样本：

• 双击单个样本。

• 选择一个样本或数据文件，然后单击 。

• 将样本或数据文件从左侧窗格拖动到右侧窗格中。

按 Shift 或 Ctrl 可选择多个文件或样本，然后一起移动。

3. 单击 OK。
将新样本并入并添加到现有表内时，会出现一个进度条。

自定义 Result Table

前提条件

• 在 Analytics 工作区中，打开 Results Table。

选择 Results Table 中要显示的数字格式和列。可以将列设置应用到项目中的所有 Results
Table。

注释: 用户自定义结果表的列设置时，不得隐藏一些重要列，例如 Sample Name、Sample
ID、Barcode 等。

提示! 如果列名称被截去，可将光标移动到字段上方，在工具提示中显示列名称。
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1. 单击 More > Table display settings。
此时 Results Table Display Settings 对话框打开。关于 Results Table 中的列的描述，请
参阅以下章节：Results Table 列。

图 6-23 Results Table Display Settings 对话框

项目 描述

1 单击 Export 按钮，选择一个之前保存的列设置文件。对话框字段是用选
定文件中的信息来更新的。

2 单击将当前对话框设置保存到文件中。使用 Import 按钮导入并使用这些
设置。该选项允许用户在不同的列布局之间切换。

3 以字母顺序显示列名称。

注释: 该列表中还包括用于创建 Results Table 的处理方法中定义的计算
列。
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项目 描述

4 有勾选标志表示该列可见。

5 对于数值字段来说，非科学记数表示请使用 0.00 格式，而科学记数表示
请使用 0.00e0 格式。改变小数点，以表示显示数字的精度。只能用小数
点“.”作为小数分隔符。

注释: 不支持数字分组。

6 所选 LIS Supported 行是由 LIMS 预先设定的，无法更改列选择。

7 单击将列设置用于今后的 Results Table。

8 单击应用更改，然后关闭对话框。

9 单击以放弃更改，然后关闭对话框。

10 选择 Results Table 各列的类别。用户可根据选择，过滤 Results Table
所显示的列。选择一个类别可帮助用户轻松找到 Results Table 内的某
列。

2. 必要时，可选择或取消选择 Visible 列中的复选框。

注释: 除了以下章节中所述的列之外：Results Table 列，Results Table 中还含有自定义计
算列和文本列。计算列标有星号。

3. （可选）在 Number Format 列中，将格式改为整数或科学计数。

4. （可选）在 Number Format 列中，更改要显示的小数位数。

5. 单击 OK。
新设置已应用至 Results Table。创建新的 Results Table 或重新打开之前保存的 Results
Table 时，也会保存并应用新设置。

提示! 使用 Results Table 的标题行调整列宽和列顺序。拖动标题边界，以改变宽度。将列
标题拖动至 Results Table 中的其他位置，以更改列顺序。单击列标题上的筛选器图标

( )，将筛选器应用到该列。当使用 Export 按钮导出 Results Table 时，列宽、顺序和筛
选器设置将保存到导出的文件中。

创建报告

前提条件

• 在 Analytics 工作区中，打开 Results Table。

提示! 如要选择包含在报告中的分析物，可使用 Results Table 中的 Reportable 列。请参阅以
下章节：Results Table 列。

1. 单击 Reporting > Create Report and Save Results Table。
Create Report 对话框随即打开。
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2. 从 Template name 列表中选择一个模板。

3. 选择一种报告格式。

4. 要更改文件名和位置，请单击 Browse，导航至另一个位置，键入 File name，然后单击
Save。

注释: 默认情况下，报告保存在
ProgramData\SCIEX\Analytics\Reporter\Reports 中。

5. 根据需要单击 Create an individual report for each sample 复选框。

6. （可选）为报告选择另一个徽标：

a. 单击 Replace Logo。

b. 使用 Replace Logo 对话框中的选项按需要修改徽标。

c. 单击 Save。

d. 单击 Cancel。

7. 单击 View Pages 可查看报告布局。

8. 单击 Create。

提示! 要使用 Per Sample Quant、Per Sample Qual、Per Sample Visible Rows Using
Visible Analytes 或 Positive Hits Qual 等模板报告所选的结果，使用筛选器或隐藏
Results Table 中不需要的行。

提示! 单击 Create Report 对话框中的 Template View 中的示例可查看报告模板布局。要
查看某个模板，用户必须有一个与模板同名的 jpg 文件，此外还要附加后
[Snapshot_X]，其中，X 是序列中的快照编号。不要在文件名和后 之间使用空格。

例如，All Peaks Qual.docx 模板可命名为 All Peaks Qual[Snapshot_1].jpg、All Peaks
Qual[Snapshot_2].JPG 或 All Peaks Qual[Snapshot_3].jpg

导出并保存 Results Table

前提条件

• 在 Analytics 工作区中，打开 Results Table。

提示! 如要选择要导出的分析物，可使用 Results Table 中的 Reportable 列。请参阅以下章
节：Results Table 列。

1. 单击 Reporting > Export results > Export and save Results Table。

此时 Export 对话框打开。

2. 按需要选择选项。

关于选项描述，请参阅文档：《帮助系统》。
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3. 单击 OK。

导出 Results Table – Metric

前提条件

• 在 Analytics 工作区中，打开 Results Table。

注释: 在数据从 Analytics 工作区导出之后，制造商不承担包括间接或从属损害在内的责任或偶
然责任。

导出结果表是在 Analytics 工作区输出数据的受控方法之一。

本特性用于创建一份制表符分隔的文本文件，其中包含了处于活动状态的 Results Table 中的
信息。导出所有样本的信息，并导出选定度量或字段中的所有成分或仅可见成分。

1. 单击 Reporting > Export results > Results Table - Metric。

此时 Export Metric 对话框打开。

2. 选择 Metric 字段中要导出的列，然后设置选项。请参阅文档：《帮助系统》。

3. 单击 OK。

将结果传输到 Watson LIMS 中

前提条件

• Results Table 已打开并锁定。

• Watson LIMS 软件已打开。

注释: 已传输 Results Table 中列的子集，包括一些隐藏列和未指定为 Reportable 的一些列。

1. 单击 Reporting > Initiate Transfer to Watson LIMS。
传输对话框随即打开。

2. 在 Watson LIMS 中，导入数据。

3. 在 SCIEX OS 的传输对话框中，执行以下操作之一：

• 如传输成功完成，则单击 Confirm。

• 如传输未成功完成，则单击 Decline。
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将结果传输到另一个 LIMS 中

必要程序

• 在 Configuration 工作区中配置 LIMS。请参阅以下章节：选择实验室信息管理系统
(LIMS) 设置。

• 打开一个锁定的 Results Table。

提示! 如要选择要导出的分析物，可使用 Results Table 中的 Reportable 列。请参阅以下章
节：Results Table 列。

1. 单击 Reporting > Transfer Results to LIMS。
LIMS Transfer 对话框随即打开。

2. 从 Template 列表中选择一个模板。

3. 单击 Transfer。

使用 Results Table
Results Table 总结每个未知样本中的分析物基于校正曲线的计算所得浓度和定性分析结果，
如：谱库匹配、Formula Finder 结果等等。Results Table 还包括校正曲线及统计结果。用户
可以自定义 Results Table，以及以不同布局查看 Results Table。

注释: 带星号 (*) 的 Results Table 列为自定义文本或计算列。

Results Table 中的数据可以按 txt 文件形式导出，以用于其他应用程序，如 Microsoft Excel。
用户也可以导出 Results Table 中的所有数据，或只是可见列中的数据。

提示! 如果 Results Table 的多个会话已垂直或水平平铺，则单击 Views > Reset layout 以将
Results Table 恢复至其原始布局。

使用右键菜单编辑 Results Table 行。要显示此菜单，在 Results Table 的任意位置单击鼠标右
键。

图 6-24 右键菜单

表 6-4 右键菜单命令

标签 描述

Copy （复制）使用本选项将当前数据复制到剪切板。
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表 6-4 右键菜单命令 (续)

标签 描述

Paste （粘贴）使用本选项将剪切板中的数据粘贴到当前视图。

Copy Entire Table （复制整个表）使用本选项将整个表复制到剪切板。

Fill Down （往下填入）（成分）使用本选项将选中的第一行的信息复制到
后面的所有的选定行中。

Select All Rows （选中所有行）通过该选项在当前活动的 Results Table 中选中
所有行。如果用户接下来想对选中的行应用某个命令，如
Copy，该命令较为适用。

Apply Current Analyte's
Actual Concentrations
to All

（将当前分析物的实际浓度应用至全部）（分析物）如果分析物
不止一种，而且这些样本中所有分析物的浓度均相同，则通过该
选项可为所有标准物样本的分析物提供一个设置实际浓度字段的
快捷方式。要使用本功能：

1. 使用 Components and Groups List 只显示表中的一个特
定分析物。请参阅以下章节：Components and Groups 列
表。

2. （可选）筛选 Sample Type 列，以只查看标准物样本。

3. 指定分析物的实际浓度，可以在单元格中键入，也可以选择
列，然后粘贴文本。

4. 选择 Apply Current Analyte's Actual Concentrations to
All。

必要时，可返回查看所有成分和样本类型。

Apply Current IS's
Actual Concentrations
to All

（将当前 IS 的实际浓度应用至全部）（内标物）如果内标物不
止一种，而且这些样本中所有内标物的浓度均相同，则通过该选
项可为所有标准物样本的内标物提供一个设置实际浓度字段的快
捷方式。要使用本功能：

1. 使用 Components and Groups List 只显示表中的一个特
定内部标准物。请参阅以下章节：Components and Groups
列表。

2. （可选）筛选 Sample Type 列，以只查看标准物样本。

3. 指定内标物的实际浓度，可以在单元格中键入，也可以选择
列，然后粘贴文本。

4. 选择 Apply Current IS's Actual Concentrations to All。

必要时，可返回查看所有成分和样本类型。

Results Table 过滤器

使用 Results Table 顶部的字段查看和筛选内容。
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图 6-25 筛选控件

表 6-5 Results Table 过滤器

标签 描述

x of y rows （y 行中的 x 行）显示总行数 (y) 中可见的行数 (x)。

Filters （筛选器）显示应用了筛选器的列数。

Qualify for
Rules Filters

（符合规则筛选器条件）在符合该等接受度标准筛选器或置信度红绿灯筛
选器的行与不符合这些筛选器的行之间切换 Results Table 的视图。接受
度标准和置信度红绿灯适用于处理方法。

Reapply Filter （重新应用筛选器）在对 Results Table 进行更改（例如，面积计数更
改）后重新应用筛选器。

注释: 当添加或更改另一项筛选器时，所有筛选器自动重新应用。

Clear （清除）清除所有筛选器。

Results Table 列

注释:

• 带星号 (*) 的列为自定义文本列、计算列或作为组合标记规则结果创建的列。

• 名称以下划线 (_) 开头的列是与预定义 Results Table 列或化学式同名的自定义批次列。

• Format 列指示如何在化学式中验证字段。

• 在包含数字的列中，用户可以更改数字格式和有效位数。在 Number Format 列中选择
Decimal、Significant Digits 或 Scientific Notation，然后在 Results Table Display
Settings 对话框中键入 Number Format Precision 列中的有效位数。

标签 描述 格式 是否支持 LIS

Accuracy （准确度）显示标准物和质量对照 (QC)
样本的准确度。对于其他样本类型，该值
会被设定为 N/A。

对于已知浓度的标准物，标准物和 QC 样
本的准确度会被定义为 100% ×
(Calculated Concentration)/(Actual
Concentration)。

数值 是
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标签 描述 格式 是否支持 LIS

Accuracy
Acceptance

（准确度接受度）显示准确度的可接受状
态。

文本 否

Acq. Method
Name

（采集方法名称）显示采集样本所用采集
方法的名称。

文本 是

Acquisition Date
& Time

（采集日期和时间）显示采集样本的日期
和时间。

文本 是

Actual
Concentration

（实际浓度）对于标准物和 QC 样本，显
示预计的已知浓度。

数值 是

Adduct/ Charge （加成/电荷）显示化合物的加成物或电
荷状态。在针对性工作流中，该值由用户
设置。在非针对性工作流中，如果启用了
按加成物分组，则由软件自动设置该值。

文本 否

Area （面积）显示检测到的峰面积。如果未检
测到峰，则该值会被设定为 N/A（不适
用）。

数值 是

Area / Height （面积/高度）显示用检测到的峰面积除
以高度所得的数值。如果未检测到峰，则
该值会被设定为 N/A（不适用）。

数值 否

Area Ratio （面积比）对于使用内标物的分析物，显
示分析物 Area 与 IS Area 的比。对于内
标物或没有内标物的分析物，该值会被设
定为 N/A（不适用）。

数值 是

Area Ratio of
comparison

（对比的面积比）显示样本/对照样本的
面积比。

• 如果未在对照品中发现峰，则该值为
N/A（不适用）。

• 如果未在样本中发现峰，则该值为 0。

• 如果样本中的每个峰都低于 Area
Ratio Threshold，则该值为 N/A（不
适用）。

• 如果没有使用对比样本，则该值为 No
control sample（无对照样本）。

• 对于对照样本来说，找到的峰的面积
比始终为 1。

仅适用于定性工作流程。

数值 否

Asymmetry
Factor

（不对称因子）显示从峰的中心线到背坡
的距离除以从中心线到前坡的距离，所有
测量结果均在 大峰高的 10% 处测得。

数值 是
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标签 描述 格式 是否支持 LIS

AutoPeak
Asymmetry

（AutoPeak 不对称）显示积分峰相对于
根据模型预计的对称性的不对称率。比率
为 1 表示拟合良好。如果该值不为 1，则
离子源可能已饱和或积分可能不正确。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak
Candidate
Model Quality

（AutoPeak 候选模型质量）显示峰是否
适用于创建峰模型。如果该值明显大于
1，则用于创建定量方法的样本不适合。
使用较大响应峰值创建模型，然后将该峰
值用于所有样本。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Group
Confidence

（AutoPeak 分组置信度）显示一组实际
峰已经过积分计算且积分不包括假阳性噪
声峰的概率。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak
Integration
Quality

（AutoPeak 积分质量）显示数据质量。
质量表示为 0 到 1 之间的一个数值。如果
质量低于 0.6，则进一步调查积分。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Model
Source

（AutoPeak 模型源）显示用于创建峰模
型的样本和成分的名称。如果用于创建模
型的成分与进行积分计算的成分不同，则
请检查该模型以确定其是否合适。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Num
Peaks

（AutoPeak 峰的数量）显示算法所检测
到的邻近重叠峰的数量。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否
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标签 描述 格式 是否支持 LIS

AutoPeak Peak
Width
Confidence

（AutoPeak 峰宽置信度）显示峰宽的置
信度。值为 1 表示实际峰宽与预计峰宽相
等。值大于 1 表示实际峰宽大于预计峰
宽。值小于 1 表示实际峰宽小于预计峰
宽，或者由于色谱图条件更改峰变得更
宽。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak
Saturated acc

（AutoPeak 已饱和）如果使用了
Saturation correction 选项且对应的峰
已饱和，从而使拟合模型高于峰，该字段
中就显示 Yes（是）。否则，该列为空
白。如果浓度更高的样本的准确度和
%CV 超出可接受范围，则应当调整
Saturation correction。

仅适用于使用 AutoPeak 积分算法的处理
方法。

文本 否

Barcode （条形码）显示样本的唯一 ID。该唯一
ID 的初始值使用采集数据所用批次指定
的原始值。

Barcode 多可以包含 20 个字符。
Barcode 不能包含任何这些无效字符：
\ / : * ? " < > |= 或 ASCII 表中的 0 至 31
号字符。

文本 是

Baseline Delta/
Height

（基线差值/高度）显示基线高度（在峰
的起点和终点处）与实际峰高高度差的绝
对值。该值大于 0.1 表示基线积分可能不
正确，并且应当对该峰重新检查。

数值 否

Calculated
Concentration

（计算所得浓度）对于浓度已知的标准
物，显示根据校准曲线反向计算出的浓度
值。回归等式所描述的是各种回归类型和
加权的回归计算是怎样进行的。

数值 是

Combined Score （综合评分）（可选）显示可用于相对比
较的单一评分。

仅适用于定性工作流程。

数值 否

Comparison （对比）显示对比样本的成分。 数值 否

Component
Comment

（成分评注）显示有关分析物或内标物的
任意评注，可应用于所有样本。

文本 否
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标签 描述 格式 是否支持 LIS

Component
Group Name

（成分组名称）显示与分析物或内标物相
关的任何组名称。

文本 否

Component
Index

（成分索引）显示分析物或内标物在原处
理方法中的索引。

数值 是

Component
Name

（成分名称）显示分析物或内标物的名
称。

此列在 Results Table 中始终可见。在
Column Settings 对话框中，该复选框不
可用。

Component Name 多可以包含 50 个
字符。

注释:

• Component Name 只能在处理方法中
更改，在 Result Table 中不可更改。

• 该列在实验室信息管理系统 (LIMS) 传
输中是必需的。

文本 是

Component
Type

（成分类型）显示分析物类型：
Quantifier、Qualifier 或 Internal
Standard。

文本 否

Conc. Units （浓度单位）显示浓度单位。 文本 是

Concentration
Acceptance

（浓度接受度）显示计算所得浓度的可接
受状态。

数值 否

Concentration
Ratio

（浓度比）对于使用内标物的分析物，显
示 Actual Concentration 与 IS Actual
Concentration 的比。对于内标物或没有
内标物的分析物，该值会被设定为 N/A
（不适用）。

数值 否

Difference from
Average Sample
Time

（与平均样本时间之差）显示此样本的分
析时间与所有样本的平均分析时间的差
异。

数值 否

Dilution Factor （稀释系数）显示样本被稀释的系数。该
系数用于计算校准曲线。

数值 是

End Time （结束时间）显示所检测到色谱峰的结束
保留时间，单位为分钟。

数值 是
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标签 描述 格式 是否支持 LIS

End Time at 10% （10% 处的结束时间）显示沿色谱峰背
侧的时间（单位为分钟），强度在峰高的
10% 处。

数值 否

End Time at 5% （5% 处的结束时间）显示沿色谱峰背侧
的时间（单位为分钟），强度在峰高的
5% 处。

数值 否

Expected Ion
Ratio

（预计离子率）显示未知、QC 和标准物
样本的预计离子率。

对于组中的每种成分，Expected Ion
Ratio 是其标准物离子率的平均值。如果
符合下列条件，标准物不会包含在成分
Expected Ion Ratio 的计算中：

1. 峰面积为 N/A。

2. 未选择 Use 列。

数值 是

Expected RT （预计 RT）显示处理方法中原来的预计
保留时间，单位为分钟。

数值 是

Expected MW （预计分子量）显示处理方法中原来的预
计分子量，单位为 Da。

仅适用于质量重建工作流。

数值 是

Formula （化学式）（可选）显示一个有效的化学
式。如果该化学式无效，则软件不会对其
保留。如果该化学式有效，Mass (Da) 列
和 Isotope 列会自动填充。

文本 是

Formula
Confidence

（化学式置信度）以百分比显示 Formula
Finder Score 的置信度。其计算依据
是：

• 当前 MS 谱图与化合物的理论谱图的
拟合程度（基于质量）。

• 采集的 MS/MS 谱图与在 LibraryView
软件数据库中找到的 MS/MS 谱图的拟
合程度。

MS 谱图分数的权重是 MS/MS 谱图分数
的两倍。

仅适用于定性工作流程。

文本 否
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标签 描述 格式 是否支持 LIS

Formula Finder （化学式查找器）显示可用于相对比较的
单一评分。该值可使用源自 Peak Review
菜单中的 Formula Finder Results Table
内的数据进行更新。

仅适用于定性工作流程。

数值 否

Formula Finder
Results

（化学式查找器结果）（可选）显示化学
式查找器结果的 佳匹配。

仅适用于定性工作流程。

文本 否

Formula Finder
Score

（化学式查找器评分）（可选）显示可用
于相对比较的单一评分。

数值 是

Found at
Fragment

（在碎片处发现）（可选）显示在发现匹
配质谱处的 佳请求碎片质量 (Da)。

仅适用于定性工作流程。

数值 是

Found at Mass （在质量处发现）（可选）显示在发现匹
配质谱处的 佳请求提取质量 (Da)。

仅适用于定性工作流程。

数值 是

Fragment Mass （碎片质量）（可选）显示方法中所规定
的碎片质量。碎片的母离子从 Extraction
Mass (Da) 列的 MS/MS 中提取而得。如
果提供，则该值必须为数字。

数值 是

Fragment Mass
Error (ppm)

（碎片质量误差 (ppm)）（可选）显示在
碎片和碎片质量处发现的差别，单位为
ppm。

数值 是

Fragment Mass
Error (mDa)

（碎片质量误差 (mDa)）（可选）显示在
碎片和碎片质量处发现的差别，单位为
mDa。

数值 是

Fragment Mass
Error
Confidence

（碎片质量误差置信度）（可选）显示碎
片质量误差的置信度。

文本 是

Height （峰高）显示检测到的峰高。如果未检测
到峰，则该值会被设定为 N/A（不适
用）。

数值 是

Height Ratio （峰高比）对于使用内标物的分析物，显
示 Height 与 IS Height 的比。对于内标
物或没有内标物的分析物，该值会被设定
为 N/A（不适用）。

数值 是
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标签 描述 格式 是否支持 LIS

Index （索引）显示原始未排序行的索引。如果
根据另一列对表进行排列，则可以通过在
该列上排列返回原有的顺序。

数值 否

Injection Volume （注射体积）显示在方法中储存并通过自
动进样器注射的样本量。

数值 是

Integration
Acceptance

（积分接受度）显示峰积分对接受度标准
的符合程度。它是根据标记规则中配置的
以下因素计算得到：

• 积分质量

• 不对称因子

• 总峰宽，单位为分钟

• 保留时间误差，以百分比或分钟计量

数值 否

Integration Type （积分类型）显示积分的类型。

• Baseline：通常只对一个独立峰进行
积分。

• Valley：表示有两个相邻的峰，且该信
号不会回到两峰之间的基线值。

• N/A（不适用）：表示未检测到峰。

• Manual：表示该峰通过手动方式积
分。

文本 是
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标签 描述 格式 是否支持 LIS

Ion Ratio （离子率）显示离子率。Ion Ratios 是在
一种分析物至少有两个 MRM 离子对被采
集到一组的情况下确定的。

组内的所有分析物构成一个分析物子组。
组内的所有内标物构成一个 IS 子组。子
组中的第一个成分被用作定量离子。子组
中的其他成分被用作定性离子。

离子率 =（定性离子的峰面积或高度）/
（定量离子的峰面积或高度）

无论是峰面积还是峰高都可以计算离子
率。如果处理方法使用了面积计算
Results Table 内第一个成分（即成分索
引为 1 的成分）的回归部分，那么峰面积
会用来计算整个 Results Table 的离子
率。如果在第一个成分的回归计算中使用
了峰高，那么峰高会用于此项计算。

• 如果某成分不在组内，则 Ion Ratio 值
会被设定为 N/A（不适用）。

• 如果未发现峰，则 Ion Ratio 值会被设
定为 N/A（不适用）。

• 如果离子率在分析物和 IS 子组应用于
所有成分，定性离子会作为定量离子
使用。

• 如果定量离子或定性离子的峰积分有
变动，需再次计算离子率。

注释: 用户可以定义处理方法中离子率的
标记规则。

数值 是

Ion Ratio
Acceptance

（离子率接受度）显示离子率的可接受状
态。

数值 否

Ion Ratio
Confidence

（离子率置信度）显示离子率的置信度。

仅适用于定性工作流程。

文本 否
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标签 描述 格式 是否支持 LIS

IS （内标物）显示此行是否代表一种内标
物。复选框被勾选表示该行的成分是内标
物而非分析物。

注释: 对于名称包含 .heavy 或 -cis 的样
本，自动选中 IS 复选框，因为这些样本
定义为蛋白质组学工作流中的内标。对于
其他工作流，它们不是内标，因此应清除
IS 复选框。

数值 否

IS Actual
Concentration

（IS 实际浓度）显示与当前分析物有关的
内标物的实际浓度。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Area （IS 面积）显示与当前分析物有关的内标
物的面积。对于内标物或没有内标物的分
析物，该值会被设定为 N/A（不适用）。

数值 否

IS Area / Height （IS 面积/高度）显示与当前分析物有关
的内标物 IS Area 与 IS Height 之比。对
于内标物或没有内标物的分析物，该值会
被设定为 N/A（不适用）。

数值 否

IS Baseline
Delta / Height

（IS 基线差值/高度）显示内标物基线高
度（在峰的起点和终点处）与实际峰高高
度差的绝对值。该值大于 0.1 表示基线积
分可能不正确，并且应当对该峰重新检
查。

数值 否

IS Comment （IS 评注）显示与当前分析物有关的内标
物的任意评注。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

文本 否

IS End Time （IS 结束时间）显示与当前分析物有关的
内标物采集结束时间。对于内标物或没有
内标物的分析物，该值会被设定为 N/A
（不适用）。

数值 否

IS Expected MW （IS 预计分子量）显示与当前分析物有关
的内标物的预计分子量，单位为 Da。对
于内标物或没有内标物的分析物，该值会
被设定为 N/A（不适用）。

仅适用于质量重建工作流。

数值 是
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标签 描述 格式 是否支持 LIS

IS Expected RT （IS 预计保留时间）显示与当前分析物有
关的内标物的预计保留时间。对于内标物
或没有内标物的分析物，该值会被设定为
N/A（不适用）。

数值 否

IS Height （IS 高度）显示与当前分析物有关的内标
物高度。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

数值 否

IS Integration
Type

（IS 积分类型）显示与当前分析物有关的
内标物的积分类型。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

文本 否

IS Mass Info （IS 质量信息）显示与当前分析物有关的
内标物的质量信息。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

文本 否

IS MW （IS 分子量）显示发现的与当前分析物有
关的内标物分子量，单位为 Da。对于内
标物或没有内标物的分析物，该值会被设
定为 N/A（不适用）。

仅适用于质量重建工作流。

数值 否

IS MW Delta (Da) (IS MW Delta (Da)) 显示内标物预计和发
现分子量之差，单位为 Da。

仅适用于质量重建工作流。

数值 是

IS MW Delta
(ppm)

(IS MW Delta (ppm)) 显示内标物预计和
发现分子量之差，单位为 ppm。

仅适用于质量重建工作流。

数值 是

IS Name （IS 名称）显示与当前分析物有关的内标
物名称。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

文本 否

IS Peak
Comment

（IS 峰评注）显示与当前分析物有关的内
标物的峰评注。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

文本 否

IS Quality （IS 质量）显示与当前分析物有关的内标
物质量。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

数值 否

操作说明 — 处理

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
132/214

软件用户指南
RUO-IDV-05-9804-ZH-F



标签 描述 格式 是否支持 LIS

IS Region
Height

（IS 区域高度）显示内标物区域的高度。
对于内标物或没有内标物的分析物，该值
会被设定为 N/A（不适用）。

数值 否

IS Retention
Time

（IS 保留时间）显示与当前分析物有关的
内标物的保留时间。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Signal / Noise （IS 信噪比）显示与当前分析物有关的内
标物的信噪比。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

数值 否

IS Start Time （IS 开始时间）显示与当前分析物有关的
内标物的开始时间。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Total Width （IS 总计宽度）显示与当前分析物有关的
内标物的总计宽度。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Width at 50% （50% 处的 IS 宽度）显示与当前分析物
有关的内标物的 50% 处宽度。对于内标
物或没有内标物的分析物，该值会被设定
为 N/A（不适用）。

数值 否

Isotope
Confidence

（同位素置信度）显示同位素比的置信
度。

仅适用于定性工作流程。

文本 否

Isotope Ratio
Difference

（同位素比）识别理论同位素模式（基于
化学式）与根据所采集质谱所确定同位素
模式之间的差异。

仅适用于定性工作流程。

数值 否

LC Method （LC 方法）显示采集数据所用液相色谱
方法的名称。

文本 否

Library
Confidence

（谱库置信度）基于匹配的 Library
Score 显示 Library Hit 的置信度。

仅适用于定性工作流程。

文本 否
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标签 描述 格式 是否支持 LIS

Library Hit （谱库匹配）显示 佳谱库匹配的化合物
名称，即化合物的纯度评分 高并且其化
学式与所需化学式匹配。

该值可使用源自峰检查菜单中的谱库搜索
Results Table 格内的数据进行更新。仅
适用于定性工作流程。

文本 否

Library Score （谱库评分）显示谱库匹配与所发现质量
之间的拟合程度。

仅适用于定性工作流程。

数值 否

Mass Error
(ppm)

（质量误差 (ppm)）显示所发现质量与提
取质量之间的差值，以百万分率表示。

仅适用于定性工作流程。

数值 否

Mass Error
(mDa)

（质量误差 (mDa)）显示所发现质量与提
取质量之间的差值，以毫道尔顿表示。

仅适用于定性工作流程。

数值 否

Mass Error
Confidence

（质量误差置信度）显示质量误差的置信
度。

仅适用于定性工作流程。

文本 否

Mass Info （质量信息）显示与成分有关的质量信
息。

• 对于 MRM 实验来说就是 Q1/Q3 比，
对于轮廓（全扫描）实验来说就是开
始－停止。

• 对于 UV、ADC 或 DAD 实验，这是指
波长 (DAD) 或通道信息 (UV/ADC)。

如果存在碎片质量，则会将其用于 XIC 提
取。

如果没有碎片质量，则母离子质量应该用
于 XIC 提取。

文本 是

Modified （已修改）显示找峰参数是否已修改。复
选框已选中表示处理方法中的找峰参数已
使用 Peak Review 窗格进行过修改。

数值 是

MS Method （MS 方法）显示采集数据所用质谱方法
的名称。

文本 否
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标签 描述 格式 是否支持 LIS

MW (MW) 显示重建图形中发现的分析物分子
量，单位为 Da。

仅适用于质量重建工作流。

数值 是

MW Delta (Da) (MW Delta (Da)) 显示预计和发现分子量
之差，单位为 Da。

仅适用于质量重建工作流。

数值 是

MW Delta (ppm) (MW Delta (ppm)) 显示预计和发现分子量
之差，单位为 ppm。

仅适用于质量重建工作流。

数值 是

Non-Targeted
Peak

（无针对性峰）该复选标记表示此峰是否
通过增强型峰查找器找到的。

仅适用于定性工作流程。

数值 否

Operator Name （操作人员姓名）显示负责采集样本的仪
器操作人员的姓名。

文本 是

Original
Filename

（原始文件名）显示文件的名称。 文本 是

Outlier Reasons （离群值原因）在定量方法中启用自动删
除离群值后，显示发现哪个标准超出了成
分的预确定限制。

Outlier Reasons 列与定量方法中的离群
值自动删除规则关联。这是 Results
Table 中的一个预设列。

离群值被标注的原因：

• 准确度

• 浓度

• 离子率

如果定量离子或定性离子中只有一个
有峰，则将为这两个成分标记离子
率。如果这些成分都没有峰，则不为
任何一个成分标记离子率。

• 无法计算预计离子率

• 用户创建的自定义标记规则失败

文本 否

Peak Comment （峰评注）显示对该行的任意评注。 文本 否
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标签 描述 格式 是否支持 LIS

Plate Number （孔板编号）显示用来采集数据的自动进
样器孔板号，如 Batch Editor 所示。

文本 是

Points Across
Baseline

（基线上的点数）显示色谱峰扫描次数。 数值 否

Points Across
Half Height

（一半峰高处的点数）显示约 50% 峰高
处的色谱峰扫描次数。

数值 否

Polarity （极性）显示用来采集样本的实验极性。 文本 否

Precursor Mass （母离子质量）显示从处理方法中获得的
处理输入参数。

此列在 Results Table 中始终可见。在
Column Settings 对话框中，该复选框不
可用。

数值 否

Proc. Method
Name

（处理方法名称）显示创建 Results
Table 的处理方法的名称。

文本 是

Quality （质量）显示积分峰的质量。将比较积分
峰的面积与更大 RT 窗口的面积。值为 0
表示峰的积分欠佳或不存在峰。值为 1.0
表示不需要检查的积分良好的峰。

数值 否

Rack Number （支架编号）显示用来采集数据的自动进
样器支架号，可在 Batch Editor 中指定。

文本 是

Region Height （区域高度）显示检测到的峰附近的 大
峰的高度。它与 Quality 字段结合使用效
果较好。质量较低而 Region Height 较
合理的峰必须经过检查。如果 Region
Height 很小，则不存在明显峰。

数值 否

Relative RT （相对 RT）对于使用内标物的分析物，
显示 Retention Time 与 IS Retention
Time 的比。对于内标物或没有内标物的
分析物，该值会被设定为 N/A（不适
用）。

数值 是

Reportable （可报告）显示结果是否包含在报告、输
出和 LIMS 传输中。

数值 是

Retention Time （保留时间）显示所检测到色谱峰的实际
保留时间，单位为分钟。

数值 是

Retention Time
Delta (min)

（保留时间差值）表示为质量定义的保留
时间与实际保留时间之间的差值。

数值 否

操作说明 — 处理

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
136/214

软件用户指南
RUO-IDV-05-9804-ZH-F



标签 描述 格式 是否支持 LIS

Retention Time
Error (%)

（保留时间误差 (%)）显示“在 RT 发现”
与“预计 RT”之间存在的误差百分比。

仅适用于定性工作流程。

数值 否

RT Confidence （RT 置信度）显示保留时间的置信度。

仅适用于定性工作流程。

文本 否

Sample
Comment

（样本评注）显示样本的用户指定评注。 文本 是

Sample ID （样本 ID）显示样本的用户指定标识。
提交样本供采集之前，Sample ID 在
Batch Editor 中指定。

如果在处理方法中启用了标准物添加工作
流，则 Sample ID 将作为组标识符用于
每个标准物添加组。SCIEX OS 将分析物
浓度未知的每一份样本链接到已添加相同
分析物且所添加分析物浓度已知且不同的
多个样本。

Sample ID 多可以包含 252 个字符。
Sample ID 不能包含任何这些无效字符：
\ / : * ? " < > |= 或 ASCII 表中的 0 至 31
号字符。

文本 是

Sample Index （样本索引）显示当前样本的索引。

注释: 此列锁定，始终在 Results Table 左
侧显示。

数值 是

Sample Name （样本名称）显示样本的用户指定名称。
提交样本供采集之前，Sample Name 在
Batch Editor 中指定。

Sample Name 必须包含 1 到 252 个字
符。Sample Name 不能包含任何这些无
效字符：\ / : * ? " < > |= 或 ASCII 表中的
0 至 31 号字符。

注释: 此列锁定，始终在 Results Table 左
侧显示。

文本 是

Sample Type （样本类型）显示样本的类型。 文本 是

Scanned
Barcode

（扫描的条形码）显示注射之前扫描的条
形码。

文本 是
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Signal / Noise （信噪比）显示检测到的峰的高度与色谱
图中的噪声之比的估计值。

对于 AutoPeak 积分算法，用计算所得的
相对噪声和峰顶位置的基线来估算噪声。
MQ4 积分算法与之相似，但基线是用整
个色谱图来估算的。

数值 是

Slope of
Baseline

（基线的斜率）显示来自基线的积分峰的
斜率：

（（峰停止时的强度）–（峰开始时的强
度））÷ 峰宽

数值 否

Start Time （开始时间）显示所检测到色谱峰的开始
保留时间，单位为分钟。

数值 是

Start Time at
10%

（10% 处的开始时间）显示沿色谱峰前
侧的时间（单位为分钟），强度在峰高的
10% 处。

数值 否

Start Time at 5% （5% 处的开始时间）显示沿色谱峰前侧
的时间（单位为分钟），强度在峰高的
5% 处。

数值 否

Std Addition
Accuracy

（标准物添加准确度）显示通过添加不同
浓度的标准物而进行定量分析的已知浓度
样本的精度。当在处理方法中启用了标准
物添加工作流时，所有样本的 Sample
Type 会自动设置为 Standard。如果
Sample Type 更改为另一种类型，或者
标准物添加工作流未启用，则此值将设定
为 N/A（不适用）。对于已知浓度的样
本，例如一个批次中的质量对照样本，
Std Addition Accuracy 定义为：

100% x（标准物添加计算所得浓度）/
（标准物添加实际浓度）。

数值 否

Std Addition
Actual
Concentration

（标准物添加实际浓度）显示通过标准物
添加定量分析的样本的用户指定预计已知
浓度。例如，一个批次中的质量对照样
本。如果 Sample Type 不是 Standard，
则此值将设定为 N/A（不适用）。

数值 否
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标签 描述 格式 是否支持 LIS

Std Addition
Calculated
Concentration

（标准物添加计算所得浓度）显示通过采
用线性回归和无加权将标准物添加曲线外
推为 X 截距的反向计算出的浓度值。对于
通过标准物添加定量分析的样本，Std
Addition Calculated Concentration 定
义为：

截距/斜率

如果 Sample Type 不是 Standard，如果
未在处理方法中启用标准物添加工作流，
或者如果在标准物添加组的未加标样本中
没有发现峰，则该值将设定为 N/A（不适
用）。

数值 否

Super group ID （超级组）Scout Triggered MRM
(stMRM)算法，组模式：已分配标记离子
对和相关离子对的超级组的名称。

文本 否

Tailing Factor （拖尾因子）显示从峰的前坡到背坡的距
离除以从峰的中心线到前坡距离的两倍。
所有测量结果均在 大峰高的 5% 处测
得。

数值 否

Time Since First
Sample (min)

（从第一个样本起的时间（分））显示从
开始第一个样本的采集后经过的时间，单
位为分钟。

数值 否

Time Since Last
Sample (sec)

（从 后一个样本起的时间（秒））显示
从开始 后一个样本的采集后经过的时
间，单位为秒。

数值 否

Total Width （总峰宽）显示色谱峰在基线处的宽度，
单位为分钟。

数值 是

Used （已使用）显示结果是否已使用。

• 对于所有样本，复选框选中表示该结
果用于计算参考值和执行标记规则。

• 对于标准物样本而言，复选框选中表
示结果用于绘制校准曲线、回归和统
计结果。

• 对于 QC 样本而言，复选框选中表示
该结果用于质控统计计算。

• 对于其它样本类型，复选框选中表示
结果用于计算。

数值 是
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标签 描述 格式 是否支持 LIS

Vial Number （进样瓶编号）显示采集数据所用自动进
样器的进样瓶号，与该批次 初指定的编
号相同。

文本 是

Width at 10% （10% 峰高处的峰宽）显示在 10% 峰高
处测得的峰宽度。

数值 否

Width at 5% （5% 峰高处的峰宽）显示在 5% 峰高处
测得的峰宽度。

数值 否

Width at 50% （50% 时的峰宽）显示在 大强度一半
处测得的色谱峰的宽度，单位为分钟。

数值 是

XIC Width (Da) （XIC 宽度 (Da)）显示提取的离子色谱图
宽度，单位为道尔顿。

数值 是

XIC Width (ppm) （XIC 宽度 (ppm)）显示提取的离子色谱
图宽度，单位为 ppm（百万分率）。

数值 是

接受度筛选器

采用 Results Table 列 Filter 菜单中的 Filter by Flag 选项，选择是否依据接受度标准筛选列。
可按接受度标准筛选 Results Table，如下所示：

• Pass:显示符合处理方法所定义标准的行。

• Fail:显示不符合处理方法所定义标准的行。

图 6-26 Filter By Flag

应用了标记规则的任何列都可以选择使用接受度过滤器以及下列接受度标准：

• Accuracy

• Accuracy Acceptance

• Asymmetry Factor

• Calculated Concentration

• Concentration Acceptance

• Integration Acceptance

• Quality

• Retention Time Delta（min）
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• Retention Time Error（%）

• Total Width

置信度红绿灯

用接受度标准来定义合格的行。合格的行是指其接受度标准符合处理方法中所定义的标准的
行。

图 6-27 合格的行

置信度红绿灯显示 Qualitative Rule 或 Ion Ratio Acceptance 规则应用于各行的置信度状态。
有关标记规则的信息，请参阅文档：《帮助系统》。

提示! Result Table 可用置信度红绿灯过滤器进行过滤。选择 Qualify for Rules Filters 复选
框，在符合置信度筛选器的行与不符合置信度筛选器的行之间切换 Results Table 视图。置信
度筛选器包括：Pass、Marginal、Fail 和 N/A。

表 6-6 置信度红绿灯

红绿灯图标 描述

显示哪些成分达到了处理方法所定义的置信度水平。

显示哪些成分达到了处理方法所定义的边缘百分比差值水平。

显示哪些成分达到了处理方法所定义的不合格百分比差值水平。

显示哪些置信度参数不适用于该成分。
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Components and Groups 列表

当 Results Table 打开时，主窗口的左侧就会出现一个当前成分和分组的列表。用该列表可以
更改结果中显示哪些成分，以及任何关联的 Peak Review 或 Calibration Curve 窗格中显示哪
些成分。全部信息均按处理方法中的定义显示。

图 6-28 Components and Groups

单击列表中的各项以仅显示该项的成分。使用 Shift+click 或 Ctrl+click 来选择多项，如两种
特定的分析物。

提示! 将窗格右侧边缘左右拖动可以更改列表宽度。

Results Table 中各行的顺序不会受到过滤的影响。在预设值中，该表首先按样本排序，然后
再按成分，其顺序如处理方法所示。

操作说明 — 处理

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
142/214

软件用户指南
RUO-IDV-05-9804-ZH-F



表 6-7 选项

标签 描述

Show IS （显示 IS）单击显示 Results Table 中当前选择的分析物以及相应内标物
行。这与单击分析物，然后在按住 Ctrl 的同时单击内标物（这样两者都可以
被选中）效果相同。

Find （查找）单击查找列表中与特定文本匹配的项目。

检查峰

必要程序

• 打开一个 Results Table。

使用 Peak Review 窗格：

• 目测检查原始色谱图，这样就可以确定找峰程序的质量。

• 更正积分不当的色谱图，既可以采用调整找峰参数的办法，也可以通过手动方式选择积分
的起点和终点。色谱图积分更正完成后，Results Table 会用新的峰面积及其他参数自动更
新。

• 目视检查所积分 XIC 中的 MS 和 MS/MS 质谱图。

• 检查 Library Search 结果以及 Formula Finding 结果，必要时在 Results Table 中手动更新
这些结果。

• （质量重建工作流）肉眼检查 Average 谱图和 Reconstruction 谱图。

• （质量重建工作流）调整找峰参数或手动选择 XIC 区域，纠正 XIC 区域未正确选择的色谱
图。选定新的 XIC 区域后，再次生成 Average 谱图和 Reconstruction 谱图。

• （质量重建工作流）调整 Mass Peak Selection 参数或手动选择质量峰，纠正未正确选择的
质量峰。质量峰更改后，Results Table 会用新的峰及其他参数自动更新。

1. 单击 Displays the peak review( )。

2. 在左侧窗格的 Components and Group 列表中选择一个成分。

3. （可选）使用 View 菜单自定义 Peak Review 窗格的布局。关于 View 选项描述，请参阅
文档：《帮助系统》。

4. （可选）单击 Options > Peak review display settings 改变 Peak Review 窗格的外
观。例如，选择要同时查看的色谱图数量。关于选项描述，请参阅文档：《帮助系统》。
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图 6-29 Peak Review Options 对话框

5. （可选）如要放大峰，可使用下列方法：

• 单击 Options > Peak review display settings，然后单击 Zooming 以更改峰的缩放
参数。

• 将光标拖动至 X 轴或 Y 轴上要放大的区域。

6. （可选）如要放大峰使其充满整个 Peak Review 窗格，可选择峰，然后单击 Peak

magnifier( )。

提示! 当 Peak Review 窗格中的图标为黑色时，启用相应的功能。要禁用该功能，再次单
击图标。

7. （可选）要查看和调整图形上的噪声区域，单击 Options > Show Noise Regions，然后
调整噪声区域（如适用）。请参阅以下章节：使用噪声区域。

注释: 仅在使用 Peak to Peak 或 Standard Deviation 信噪比算法时可以调整噪声区域。

8. 如果色谱图或重建图中含有多个峰，并且有一个不正确的峰被积分，则拖拽鼠标将正确的
峰画入框内，设置一个新的预计保留时间或预期分子量。如有必要，可调整找峰参数和积
分参数。

9. （可选）要将新参数应用至样本成分或组的所有样本，请使用右键菜单选项。更多信息，
请参阅以下章节：使用 Peak Review 窗格中的峰值。

提示! 要查看积分的峰，请单击 Displays the peak review ( )。在 Peak Review 窗格
中，选择 Options > Show navigation controls。然后单击导航图标。关于图标的描
述，请参阅文档：《帮助系统》。
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提示! 单击 Set peak to "not found"( ) 可清除积分。用户在对峰进行手动积分前可以
查看原始数据。积分参数无法编辑。

10. 单击 Peak Review 窗格中的 Enable manual integration mode ( )，以使用 Manual
Integration 模式。

11. 将光标从所关注的峰一侧的底部拖至另一侧。
此时该峰已进行手动积分计算，而之前所使用的积分参数不可用。

提示! 如果峰刚刚已修改，则可以通过右键单击和单击 Revert Peak to Original Method
将峰恢复至原始方法。

提示! 要清除手动积分并启用积分参数字段，请清除 Manual Integration 复选框，然后再

次单击 Enable manual integration mode ( )。

12. （可选）如要在 Explorer 工作区中显示当前峰，可单击 Open data exploration( )。

保留当前缩放比例。

注释: 对峰的手动积分会持续存在，直到用户在 Peak Review 窗格更改该峰的积分，或者
编辑嵌入式方法以更改成分。

注释: 在质量重建工作流中，如手动积分重建质量峰，则相应的 XIC 区域和平均谱图依然
存在，直到用户在 Peak Review 窗格更改该峰的积分，或者编辑嵌入式方法以更改成
分。

使用 Peak Review 窗格中的峰值

表 6-8 Peak Review 功能

目的 方法

复制积分参数 将该命令与 Paste Integration Parameters 结合使用，可将一个
色谱图的找峰参数复制到另一个色谱图。如果需要对若干个色谱
图进行相同的参数调整，就可以使用该命令。

1. 在一个有活动色谱图打开的图表中单击右键，然后单击
Copy Integration Parameters。

2. 要将改动应用至成分的所有色谱图，请使用 Update
Processing Method for Component 命令。

3. 要将改动应用至组的所有色谱图，请使用 Update
Processing Method for Group 命令。
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表 6-8 Peak Review 功能 (续)

目的 方法

粘贴积分参数 将该命令与 Copy Integration Parameters 结合使用，可将一个
色谱图的找峰参数复制到另一个色谱图。

1. 在一个有活动色谱图打开的图表中单击右键，然后单击
Copy Integration Parameters。

2. 在另一个色谱图上单击右键，然后单击 Paste Integration
Parameters。

更新成分的处理方法 在对特定色谱图的找峰参数进行调整后，可使用此命令修改用
Results Table 保存的处理方法的副本，以将这些参数用于相关成
分。

• 调整找峰参数，右键单击，然后选择 Update Processing
Method for Component。

所有包含该成分的样本都将自动使用新的参数进行积分计算，
并更新 Peak Review 窗格和 Results Table。如果以手动方式
对某个峰进行积分计算，系统就会询问用户是将重新计算的积
分应用到所有峰，还是仅应用到那些未采用手动积分的峰。

更新组的处理方法 （不适用于质量重建工作流）它与 Update Processing Method
for Component 选项类似，唯一差别是积分适用于与当前活动
色谱图的成分同组的所有成分。如果用户指定了每个分组的各种
成分，并且估计已经分配至指定分组的成分有相同的保留时间，
那么该命令非常有用，因为它允许用户一次性重新设置分组中所
有成分的参数，包括预计保留时间。如果组内的成分保留时间不
同，则该命令不适用。

• 调整找峰参数，右键单击，然后选择 Update Processing
Method for Group。

更新组的处理方法，不含
Expected MW

（仅适用于质量重建工作流）它与 Update Processing Method
for Component 选项类似，唯一差别是积分适用于与当前活动
色谱图和重建图的成分同组的所有成分。如果用户指定了每个分
组的各种成分，并且估计已经分配至指定分组的成分有相同的保
留时间和积分参数，那么该命令非常有用，因为它允许用户一次
性重新设置分组中所有成分的参数，包括预计保留时间。如果组
内的成分保留时间不同，则该命令不适用。此命令不适用于
Expected MW。

• 调整找峰和积分参数，右键单击，然后选择 Update
Processing Method for Group, Excluding Expected
MW。
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表 6-8 Peak Review 功能 (续)

目的 方法

将积分参数应用到组内样
本

（不适用于质量重建工作流）在对特定色谱图的找峰参数进行调
整后，可使用此命令将参数应用至与更改化合物属于同一个组的
样本中的所有化合物。

• 调整色谱图的找峰参数，右键单击，然后选择 Apply
integration parameters to sample within a group。

将积分参数应用到组内样
本，不含 Expected MW

（仅适用于质量重建工作流）在对特定色谱图的找峰参数和重建
图的积分参数进行调整后，可使用此命令将参数应用至与更改化
合物属于同一个组的样本中的所有化合物。此命令不适用于
Expected MW。

• 对色谱图的找峰参数和去卷积质量峰的积分参数进行调整，右
键单击然后选择 Apply integration parameters to sample
within a group, excluding Expected MW。

将峰还原至原来的方法 特定色谱图的找峰参数调整完毕后，可使用此命令将用 Results
Table 保存的处理方法备份中的原始参数应用到色谱图。

• 在一个有活动色谱图打开的图形中单击右键，然后选择
Revert Peak to Original Method。

还原成分的所有峰 某些色谱图的找峰参数调整完毕后，可使用此命令将用 Results
Table 保存的处理方法副本中的原始参数应用到与活动色谱相同
成分的所有色谱图。如果以手动方式对某个峰进行积分计算，系
统就会询问用户是将重新计算的积分应用到所有峰，还是仅应用
到那些未采用手动积分的峰。

• 在一个有活动色谱图打开的图形中单击右键，然后选择
Revert All Peaks for Component。

使用噪声区域

如使用 Peak to Peak 或 Standard Deviation 信噪比算法，可在处理方法的 Integration 页面
和 Peak Review 窗格交互调整噪声区域。

1. 单击图形上的噪声区域，将其移动到所需的位置。

2. 移动光标到噪声区域的左边缘或右边缘，直到显示双头箭头。然后拖动边缘到所需的位
置，以调整噪声区域的大小。

使用谱库搜索或化学式查找器结果分析峰

提示! 单击 Options > Peak review display settings，更改窗格内显示的行数。用户也可向
上拖长窗格，以扩大 Peak Review 窗格。

1. 在 Peak Review 窗格内，单击 View，然后再单击 XIC + MS、XIC + MS/MS 或 XIC +
MS + MS/MS。
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搜索结果显示在下图中。

图 6-30 谱库搜索结果

2. 单击蓝色箭头，扩展 Library Search Results，从而显示更多可能的谱库匹配。

所选谱库匹配的化学结构也显示在表中。

3. 再次单击该箭头，以折叠表格。
折叠后表格中所示的结果也显示在 Results Table 内。

4. （可选）在表中选择一行，然后单击 图标，以更新 Results Table 内的结果，从而使
用该分析中的特定谱库匹配。

5. （可选）单击 ，以使用所选化合物的信息更新处理方法。

6. 要添加谱图到谱库数据库中，请遵照以下步骤：

a. 右键单击谱图，然后单击 Add spectrum to library。
Add spectrum to library 对话框随即打开。

b. 更新 Compound Name、Library 和 Precursor m/z 字段。

c. 单击 OK。

7. 单击蓝色箭头，扩展 Formula Finder Results，从而显示更多可能的结果。
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图 6-31 化学式查找器结果

如果化合物更新自 ChemSpider，那么所选化学式查找器结果的化学结构也显示在表中。

8. 再次单击该箭头，以折叠表格。
折叠后表格中所示的结果也显示在 Results Table 内。

9. 单击 ，以使用所选化合物更新 Results Table 中的 Formula Finder Results 列。

10. 单击 ，以使用所选化合物的信息更新处理方法。

提示! 单击 Options > Get Chemspider hit count，显示下图表格中的 ChemSpider Hit
Count 列。

11. 单击 ，打开 ChemSpider 应用程序。

请参阅以下章节：ChemSpider。

ChemSpider

注释: 该工作站必须包含一个可访问 ChemSpider 数据库的有效许可证文件。

注释: 下图中的信息仅用作示例。
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图 6-32 ChemSpider 会话

项目 描述

1 Results 窗格：显示与所选分子式匹配的建议化合物列表。具体结果以 40
种化合物为一组进行显示。使用向右箭头，可前进至列表中的下一组。使
用向左箭头，可返回至列表中的前一组。

2 Spectra 窗格：显示已采集的质谱（红色）以及匹配的碎片（蓝色）。蓝
色碎片越多，表明匹配效果越好。

3 Structure 窗格：显示结果窗格内所选化合物的化学结构。

4 Fragment 表窗格，Fragments 选项卡：显示所选化合物的匹配碎片总
数。

4 Fragment 表窗格，Peaks 选项卡：显示所选化合物的峰总数、匹配峰数
以及占总强度的 %。Assigned 列中的复选框会为匹配峰自动选定。

表 6-9 ChemSpider 的功能

当您执行这项操作时…… ……这将出现

在 Filter XIC List 图标旁边的字段中键
入该信息。

结果窗格刷新并且仅包含与所输入标准匹配的结
果。

在结果窗格内的条目中单击 其余窗格刷新，显示与该选项相关的信息。

单击碎片表窗格的 Fragments 选项卡中
的条目

其余窗格刷新。在质谱窗格中，红色箭头会显示在
匹配碎片（蓝色）的顶部和底部。在结构窗格中，
与该碎片匹配的化学结构成分会突出显示（粗
体）。
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表 6-9 ChemSpider 的功能 (续)

当您执行这项操作时…… ……这将出现

单击碎片表窗格的 AssignedPeaks 选
项卡中的 条目

其余窗格刷新。在质谱窗格中，红色箭头会显示在
匹配碎片（蓝色）的顶部和底部。在结构窗格中，
与该碎片匹配的化学结构成分会突出显示（粗
体）。

单击 ChemSpider results for 字段右侧
的向下箭头，并选择 ChemSpider web
site 选项

ChemSpider 网站 (www.chemspider.com) 随即在
浏览器窗口中打开。有关访问信息，请参阅
ChemSpider 帮助。

单击 ChemSpider results for 字段右侧
的向下箭头，并选择 Refresh 选项

所有更改都将撤销，会话还原至原始搜索结果。

单击 Select 在 ChemSpider 会话中选中的信息会被复制到软件
会话内的 Formula Finder Results 窗格。
ChemSpider 会话关闭。

Peak Review 窗格提示

• 在特定列上对 Results Table 进行排序，并且只检查排在 上面或 下面的色谱图。

• Peak Review 窗格始终与相应的 Results Table 同步，并按表中的相同顺序显示相同峰的色
谱图。对 Results Table 所作的任何改动（如行排列、筛选样本类型或者选择任何成分）都
会在 Peak Review 窗格中自动反映出来。

• 用窗格右侧的滚动条翻看现有色谱图。当 Peak Review 窗格处于活动状态时，用键盘上的
上下箭头键或鼠标上的滚轮在色谱图间移动光标。

• 单击第一列左侧的淡蓝色区，在 Results Table 内选择一行，在 Peak Review 窗格内显示相
应的峰。如果用户滚动到 Peak Review 窗格内的某个色谱图，Results Table 就会突出显示
相应的行，然后将其带入视图中。

• Analytics 工作区不支持数字分组。用户不得在任何文本框（如积分参数）和表格（如
Results Table）中对数字进行分组。

• 任何时点都有一个色谱图处于活动状态，并以黑体字标题来表示。单击某个色谱图范围内
的任意位置，使之处于活动状态。

小心: 潜在的数据丢失。注意不要在色谱图内拖动光标，否则会改变预计保留时间并导致积
分发生改变。

• 如果用户在色谱图中的某个峰周围拖动光标，则 Expected RT 积分参数就会随峰的实际保
留时间一起更新。新的保留时间就会自动应用，而且软件会对该峰再次进行积分，对
Results Table 相应进行更新。

• （质量重建工作流）如果用户在重建图中的某个峰周围拖动光标，则 Expected MW 参数
就会以峰的实际分子量更新。新的分子量就会自动应用，而且软件会对该峰再次进行积
分，对 Results Table 相应进行更新。

• （质量重建工作流）如果未选择 Recentered on the largest XIC Peak，则用户可以手动
选择所需的 XIC 区域。在 XIC 区域中心的时间为预计 RT，XIC 区域内 大峰的 RT 为发现
的 RT。
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• 如果用户在手动积分模式下检查峰，在峰周围拖动光标就会以手动方式对选中的峰进行积
分。拖动的同时按住 Shift 可帮助保持线条平直。

• 色谱图处于活动状态后，窗格左侧所显示的积分参数便会更新，以反映新的活动色谱图的
情况。如果用户调整了色谱峰的积分参数，然后单击 Apply，就会对当前处于活动状态的
色谱图产生影响。

• 用户必须在峰检查期间检查峰形，以识别潜在的饱和峰，并确保部分或不正确的积分不会
错误地导致报告的浓度不正确。

• 用户必须在峰检查期间检查色谱图中是否存在可能表示系统问题的噪音过大尖峰。

• 在 Y 轴范围内双击，按整个数据集内的 强峰调节轴上的标度。在轴范围内选择一个强度
范围即可放大视图。

• 在 X 轴范围内双击返回图表的主视图，所有数据在主视图中均可见。在轴范围内选择一个
时间范围即可放大视图。

• 在 Results Table 中逐个样本进行导览时，单击 Results > Cache all chromatograms for
faster peak review 可提高性能。

浓度极高（远远超过定量上限或 ULOQ）的样本可能会导致越来越宽、越来越饱和的峰，且其
峰形出现扭曲或分裂。

下图显示可以使用线性回归进行定量的 大浓度。

图 6-33 非饱和峰和饱和峰的示例

项目 描述

1 显示可用于定量分析的可接受峰。

2 显示饱和的峰。生成此峰的样本浓度远远超过 ULOQ。当峰达到饱和时，
由于增益抑制，峰变得越来越宽，且峰的顶端反转。应从定量分析中排除
此类峰，因为部分积分可能会导致报告的浓度不正确。

3 显示导致 LC 峰分成两个峰的极端饱和情况。应从定量分析中排除此类
峰，因为部分积分可能会导致报告的浓度不正确。
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使用统计量分析数据

必要程序

• 打开一个 Results Table。

使用 Statistics 窗格查看有关分析重现性的信息。表中每一行都汇总了源自相同分析物（预计
具有相同响应）的一组相关峰的平均值和标准差之类的信息。

查看峰积分、校准曲线和使用迭代过程的样本统计量。Results Table 中 Actual
Concentration 字段的精确度组也用于统计表。

注释: 有关统计量（包括 %CV 和准确度）验收值的信息，请参阅实验室标准操作程序。

打开 Results Table，然后单击 Views > Statistics pane。

Statistics 窗格列

标签 描述

Row （行）显示行数。

Component
Name

（成分方法）显示分析物的名称。

Sample Name/
Actual
Concentration

（样本名称/实际浓度）当样本按实际浓度分组时，显示浓度。当样本按照
样本名称分组时，显示样本名称。

Num. Values (数值）显示 m 中有 n，其中 n 是相同实际浓度（或相同样本名称）的样
本总数，而 m 是这些样本中用于计算的样本数。如果相应的峰不能进行
积分计算，或者 Used 字段被手动清空，样本就不会被使用。

Mean （平均值）显示所用样本的平均值。

Standard
Deviation

（标准差）显示所用样本的标准差。

Percent CV （百分比 CV）显示变异系数，以百分比表示：100 * Standard Deviation /
Mean。

Accuracy （准确度）显示平均值除以实际浓度，以百分比表示：100 * Mean /
Actual Concentration。只有在按实际浓度分组时才会显示该字段，按样本
名称分组时不显示。

Values （值）显示其他列中的样本的单个值。如果对应样本无法积分，则会显示
N/A。如果 Used 字段已手动清除，则显示该值时会带有一条删除线。
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标签 描述

Group by （分组依据）明确说明有关给定分析物的样本如何分组，以计算统计量。
其中包括以下选项：

• Group by Concentration for Standards（按标准物浓度分组）：标
准物样本按照实际浓度分组。

• Group by Concentration for QCs（按质量对照品的浓度分组）：质
量对照品样本按照实际浓度分组。

• Group by Sample Name for Standards（按标准物的样本名称分
组）：标准物重复样本按照 Sample Name 字段进行分组。

• Group by Sample Name for QCs（按质量对照品的样本名称分
组）：质量对照品重复样本按照 Sample Name 字段进行分组。

• Group by Sample Name for All Samples（按所有样本的样本名称分
组）：所有重复样本按照 Sample Name 字段进行分组。

度量 明确说明用于计算统计量的实际度量。其中包括以下选项：

• Calculated Concentration（计算所得浓度）：使用 Results Table 中
的 Calculated Concentration 字段。

• Area（面积）：使用 Results Table 中的 Area 字段。

• Height（高度）：使用 Results Table 中的 Height 字段。

• Calibration Y-Value（校准 Y 值）：使用为分析物指定的回归参数。
这是一种没有对应内标物的分析物的 Area 或 Height，或者一种使用
了内标物的分析物的 Area Ratio 或 Height Ratio。

Save Results
and Export

（保存结果和导出）单击以保存结果并导出统计表。Export Statistics 对
话框随即打开。

Statistics Pane 提示

• 在 Components and Groups 列表中，选择 All Components 以查看 Statistics 表中所有
分析物的条目。选择单独成分，以仅查看该分析物的条目。如果用户从列表中选择单个内
标物，则 Statistics 表为空。请参阅以下章节：Components and Groups 列表。

• 单击 Statistics 窗格中可见行的其中一个 Value 单元格，以在 Results Table 中选择相应的
行用于分析物和样本。如果 Peak Review 窗格可见，则它会与 Results Table 关联，并且会
在单击相应的单元格时进行更新。

• 单击其中一个列标题对统计数据进行排序。

• 复制整个 Statistics 表，或者仅通过选择行然后按下 Ctrl+C 来复制相关的行。

• 使用 Group by 列表指定（给定分析物的）样本应当如何分组进行统计计算。

• 使用 Metric 列表指定用于计算统计数据、计算所得浓度、面积等的度量。

• 调整列宽以优化显示。这些宽度在下一次显示 Statistics 窗格时会保留。
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• 要更改 Statistics 表的格式和精度，请在 Results Table 中更改它们。请参阅以下章节：自
定义 Result Table。

• 要更改单个值的 Use Peak 选项，右键单击 Statistics 窗格中的单元格，然后选择 Use
Peak。Results Table 中的 Use Peak 列将更新。

查看 Calibration Curve
必要程序

• 打开一个 Results Table。

使用校准曲线通过将未知样本与一组已知浓度的标准物样本进行比较，来确定未知样本中物质
的浓度。请参阅以下章节：校准曲线。

1. 单击 Displays the Calibration Curve( )。

2. 要设置回归选项，单击 Regression。请参阅文档：《帮助系统》。

Export Calibration
使用 Export Calibration 将一份与当前 Results Table 相关联的所有分析物的校准等式副本保存
到一个外部文件 (mqcal)。这样用户就可以将一整套标准物样本的校准等式应用到不属于同一
个 Results Table 的其他样本。

典型的工作流为：

1. 创建一个仅包含标准物的 Results Table。

2. 使用 Peak Review 窗格确保积分成功。

3. 在 Calibration Curve 窗格中，单击 Options > Export calibration (and save results)以
保存校准副本。

4. 新建一个含未知浓度样本的 Results Table。

5. 在 Calibration Curve 窗格中，单击 Options > Assign external calibration 以将导出的
校准等式应用到新的 Results Table。

注释: 用户可以为新的 Results Table 指定应用 (mqcal) 校准文件。

如果原来的 Results Table（含标准物样本）已被改动，则必须重新导出 Results Table，以保
存更新后的校准等式。之前导出的校准等式不会自动更新。

使用度量图表分析数据

必要程序

• 打开一个 Results Table。

用 Metric Plot 对照行号或另一列，按 Results Table 列中的数值绘图。这些图表能够为目测数
据检查提供极大帮助。
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如果选择了一列，生成的图表会作为表内行号的方程，显示列内的数值。如果选择了两列，则
列内的数值便会相互对照绘制。两列中待选择的第一列含 X 值，而第二列则含 Y 值。

1. 在 Results Table 中选择一列或两列。

提示! 要选择第二列，在单击列标题的同时按下 Ctrl。

2. 单击 More > Create Metric Plot with new settings。

3. 在 Metric Plot 中，单击 Link，然后再单击 Link to results table columns 或 Link to
results table rows，以将 Results Table 中的滚动内容链接至 Metric Plot。
有关 Link 菜单的更多信息，请参阅文档：《帮助系统》。

4. 要更新度量图表，请选择 Results Table 中的相关行，然后在 Metric Plot 窗格中，单击
Link > Plot selected rows only。

提示! 要选择多个行，请在选中行的同时按下 Ctrl。

5. （可选）通过从 Options 菜单中选择选项来自定义 Metric Plot 选项。关于选项描述，请
参阅文档：《帮助系统》。

度量图表提示

• 如果用户左键单击某个数据点，Results Tabble 中的相应行便会被自动选中，并滚动显示。
如果 Peak Review 窗格打开，则该窗格也会更新，并显示对应的色谱图。这为对色谱峰执
行离群值检查提供了一种便捷方法。

• 标题区始终显示活动轨迹的名称。如果多种成分的轨迹被叠加在一起，可以切换不同标
题，以显示所有轨迹的信息，或者通过单击标题左侧的加号 (+) 仅显示当前活动轨迹。单击
标题或相应标题左侧的彩色点，或选择 Metric Plot 中的某个数据点便可激活与之对应的轨
迹。

• Metric Plot 可用来绘制内标物或质量对照品样本的峰面积，从而监测可能的偏差或趋势。

编辑报告模板

小心: 潜在的数据丢失。为防止用户改动模板，一定要将 Reporter 模板放在一个安全的只读
文件夹内，只有系统管理员才有写入权限。

用户负责验证自定义模板。

1. 打开 docx 模板。

提示! 模板位于 C:\ProgramData\SCIEX\Analytics\Reporter。

选中某个区域时，Reporter 模板编辑器在右侧打开。模板编辑器会自动加入标签信息。

操作说明 — 处理

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
156/214

软件用户指南
RUO-IDV-05-9804-ZH-F



图 6-34 Reporter 模板编辑器

项目 描述

1 显示当前标签的报告模板。

2 图标:

• 添加新标签。

• 添加图片标签。

• 显示内容区。

• 查看文件变更日志。

3 Created with：显示提供标签信息的软件名称。

4 Field Type：显示适用于该软件的字段类型。

5 根据选定字段类型显示可用属性列表。例如，标签名称和数字格式。

6 Save Tag Parameters：单击以保存改动。如果未保存改动，则会显示
一条消息，提示用户保存所作改动。

2. 使用下表中的程序。

表 6-10 Reporter 软件功能

目的 方法

更改字段类型。 在标签内单击，选择一个新的字段类型，然后选择属性。

更改字段类型的属性。 在选项卡内单击，然后根据要求更改属性。

添加标签。 单击 Add new tag 图标，选择 Field Type，然后选择属性。

添加图片。 单击 Add picture tag 图标，然后选择属性。
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表 6-10 Reporter 软件功能 (续)

目的 方法

显示标签的起始和终止位
置。

单击 Show content area 图标。

显示文档变更日志。 单击 View document change log 图标。

复制并粘贴标签。 复制选定标签并将它们粘贴到新位置，然后更新字段类型属
性。

属性不会被复制，必须进行选择。

标签之间的跳转。 用左右箭头键在标签之间来回移动。

删除标签。 执行以下任一操作：

• 如果光标位于标签的左侧，按 Delete 键。

• 如果光标位于标签的右侧，按 Backspace 键。

3. 作出更改后，单击 Save Tag Parameters。

提示! 强制信息在字段左侧用闪动的红色惊叹号表示。

Reporter 模板

自定义报告模板由用户自行验证。

一些报告模板使用查询。用户可以使用基于 Microsoft Excel 的公式创建查询，从而评估、处
理和列出报告 Results Table 中的数据。报告模板中的 Metafield 标签用于说明报告应当使用的
查询文件的名称。要使用查询，必须在报告模板的 MetaField 标签中指定查询文件名称。查询
还必须具有“.query”的扩展名，以便被识别为查询。查询必须存储在报告模板所存储的
Reporter 文件夹中。

当使用 Reporter 模板时，特别是当在模板中使用查询时，建议用户验证所生成的结果。如果
在验证后对报告模板进行了修改，则应重新验证报告模板。修改报告模板包括修改 Reporter
标签或查询。

表 6-11 默认模板

模板 模板说明（如 Create Report 对话
框所示）

补充说明

所有峰定性 这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、分析物结果表格以及所有分析
物和内标物的叠加色谱图。Analyte
Results Table 按照其在 Results
Table 内的显示内容打印。所有定性
置信度红绿灯均在表格开头处列
出。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

分析物 20% 报告 这份报告针对每个分析物显示一个
区域，其中包含文件信息以及每一
种空白样本、标准样本、质控样本
和 20% 未知样本的 XIC 表。

此样本报告模板随附了查询文件
Analyte20percent.Query。

分析物摘要 这份结果表格显示批次所有样本中
特定分析物及相关内标物的样本名
称、计算浓度和离群值。

不适用

校准曲线 这份报告显示分析物的文件信息、
统计表（标准物）和校准曲线，每
种分析物占一页。

• Reportable 复选框被清除的标准
物将不会在数据表中报告。统计
数据不会受到 Reportable 状态影
响。

• 此报告将根据 Used 列状态显示
回归方程和图形，如 Analytics 工
作区的 Calibration Curve 窗格中
所示和计算。

完整定量所有峰
和图形

这份报告显示每个样本的 Results
Table 条目。所有在 Results Table
中可见的列均会在报告中显示。报
告还包括各样本和分析物的 XIC 色
谱图、平均质谱图和重建质谱图。

此报告专门用于质量重建工作流。

完整定量分析物
摘要和校准曲线

这份报告显示 Results Table 条目、
校准曲线和各分析物统计数据。
Results Table 包括样本名称、样本
类型、分析物名称、实际浓度、面
积、高度、预计 MW、MW、MW
增量、计算所得浓度和准确度。

此报告专门用于质量重建工作流。

完整定量样本摘
要

这份报告显示所有样本的 Results
Table 条目。Results Table 包括样
本名称、样本类型、分析物名称、
实际浓度、面积、高度、预计
MW、MW、MW 增量、计算所得浓
度、准确度和准确度接受度。

此报告专门用于质量重建工作流。

度量图表 这份报告针对每个分析物显示一个
区域，其中包含文件信息和分析物
峰面积的度量图表。

Reportable 复选框的状态不会影响
报告内容。即使清除该复选框，也
会包含所有数据点。

MQ 分析物报告
1

这份报告针对每个分析物显示一个
区域，其中包含文件信息、样本结
果表和每个样本的 XIC 表 - 每个分
析物（< 8 个样本）通常会打印 2
页。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

MQ 分析物报告
2

这份报告针对每个分析物显示一个
区域，其中包含文件信息和每个未
知样本的 XIC 表 - 每个分析物（< 8
个样本）通常会打印 2 页。

仅报告未知项。

MQ 分析物报告
3

这份报告针对每个分析物显示一个
区域，其中包含文件信息和未知样
本摘要表。

仅报告未知项。

MQ 分析物报告
综合表

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。该表显示为 2
列，以便每页能够显示更多样本。

仅报告未知项。

含色谱图的 MQ
分析物报告

这份报告针对每个分析物显示一个
区域，其中包含文件信息、样本结
果表和每个样本的小型色谱图。

仅报告未知项。

MQ 空白模板 不适用 这份报告仅显示标题信息、徽标和
页码。

MQ 肽定量 不适用 与肽定量数据集一起使用。请参阅
MultiQuant 软件的用户指南的第二
个示例，绝对定量示例。

带标记的 MQ
QC 摘要 1

这份报告显示文件信息、每种分析
物的 QC 摘要表（CV 高于 20% 的
数值会突出显示）以及 QC 详细结
果表（准确度在 80-120% 范围之外
的数值会突出显示）。

清除 Reportable 复选框的质控品不
会包含在报告中，也不会用于计
算。

MQ 样本报告 1 这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、IS 信息、分析物结果表和包含
IS 和各分析物的 XIC 表 - 每个样本
（< 8 个样本）通常会打印 2 页。

不适用

MQ 样本报告 2 这份报告针对每个分析物显示一个
区域，其中包含文件信息、TIC、样
本详细信息、分析物 XIC 和表格形
式的结果 - 每个样本（< 8 个样本）
通常会打印 2 页。

仅报告未知项。

MQ 样本报告 3 这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。

仅报告未知项。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

MQ 样本报告综
合表

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。该表显示为 2
列，以便每页能够显示更多分析
物。

仅报告未知项。

含色谱图的 MQ
样本报告

这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、分析物结果表和每个分析物的
小型色谱图。

仅报告未知项。

含浓度阈值的
MQ 样本报告

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要。

• 相关查询文件为包含
Concentration Threshold.query
的样本报告。

• 成分必须命名为 "Cmpd X #”X
#"，其中 X 是从 A 到 F 的任意字
符，# 是任意数值。

示例：在报告中，名为 "Cmpd A
1" 的成分将显示在标题
Compound Group A 下；名为
"Cmpd B 1" 的成分将显示在
Compound Group B 下，以此
类推。

• 如果成分属于同一个组，则该组
中仅按字母顺序的第一个成分将
被纳入报告。

例 1：如果 "Cmpd B 25" 和
"Cmpd C 1" 都属于组 "Grp"，则
"Cmpd C 1" 不会出现在报告中。

例 2：如果 "Cmpd A 1"、 "Cmpd
A 2" 和 "Cmpd A 3" 未分配到
组，则 "Cmpd A 2" 和 "Cmpd A
3" 将不会出现在报告中。

例 3：如果 "Cmpd A 1"、"Cmpd
A 2" 和 "Cmpd A 3" 分别分配到
组 1、2 和 3，则所有 3 个成分
都将出现在报告的 Compound
Group A 标题下。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

含 MRM 比的
MQ 样本报告 2

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息、报告摘要表和所有 XIC 叠加
图。Expected Ion 率可采用任何可
用标准物自动计算。比值被放在
Results Table 的自定义列中。任何
与预计值偏差超过 20% 的值都会被
标记。定量离子分析物名称必须以
一个空格后接数字 1 为结尾。比值
离子分析物名称必须以一个空格后
接 2 和 9 之间的某个数字为结尾。

不适用

含 MRM 比的
MQ 样本报告 EU

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何超过预计值的数值
都会被标记（依据 EU 比值公差指
引）定量离子分析物名称必须以一
个空格后接数字 1 为结尾。比值离
子分析物名称必须以一个空格后接 2
和 9 之间的某个数字为结尾。

相关查询文件为
MRM ratios EU.query。

含 MRM 比的
MQ 样本报告
MQ EFAB 03

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何与预计值偏差超过
20% 的值都会被标记。定量离子分
析物名称必须以一个空格后接数字 1
为结尾。比值离子分析物名称必须
以一个空格后接 2 和 9 之间的某个
数字为结尾。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

含 MRM 比的
MQ 样本报告

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何与预计值偏差超过
20% 的值都会被标记。定量离子分
析物名称必须以一个空格后接数字 1
为结尾。比值离子分析物名称必须
以一个空格后接 2 和 9 之间的某个
数字为结尾。

相关查询文件为
MRM ratios.query。

含标准物、质控
品和空白品的
MQ 样本报告

这份报告针对每个样本显示一个区
域，其中包含文件信息、标准物摘
要信息、质控品摘要表、空白品结
果表；并针对每个未知样本显示一
个区域，包含文件信息、样本信
息、IS 信息、分析物结果表和包含
IS 和各分析物的 XIC 表 - 每个样本
（< 8 个样本）通常会打印 2 页。

清除 Reportable 复选框的标准物和
质控品不会包含在报告各自的综合
表中，也不会用于统计计算。

MQ Tutorial
Dataset Heavy
Light

不适用 此报告用于与 Tutorial Dataset
Heavy Light 数据集一起使用。请参
阅 MultiQuant 软件的用户指南的第
二个示例，相对定量示例。

每个样本定量-定
性

这份报告针对每个选定样本显示一
个区域，其中包含文件信息、样本
信息和选定分析物的分析物结果
表。Analyte Results Table 按照其
在 Results Table 内的显示内容打
印。所有定性置信度红绿灯均在表
格开头处列出。

不适用

每个样本定量-定
性可见行（使用
可见分析物）

这份报告针对每个选定样本显示一
个区域，其中包含文件信息、样本
信息和选定分析物的分析物结果
表。Analyte Results Table 按照其
在 Results Table 内的显示内容打
印。所有定性置信度红绿灯均在表
格开头处列出。

行的隐藏状态优先于 Reportable 复
选框的状态。如选中 Reportable 复
选框，但行已隐藏，则不会报告该
行。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

每个样本定量-定
性（含统计数
据）

这份报告显示每个样本的成分以及
WYSIWYG 表。显示 XIC、MS 和
MS/MS。面积的统计综合表显示在
报告末尾。

• 如果成分表包含 UV 成分，则
UV 迹线将在该报告的 XIC 图形
下报告。

注释: 如果 UV 成分的名称采用格
式 [compound_nameuv] 或
[uv]，则不报告任何 UV 迹线，因
为 uv 后 与 UV MS 定性报告相
关。

• 如果样本被标记为 QC，且有 2
个或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报
告末尾的 QC 摘要表中。

• 如果清除 QC 行的 Reportable
复选框，则该行不会用于 QC 摘
要表的任何计算。

每个分析物定量-
定性

这份报告针对每个分析物显示一个
区域，其中包含文件信息、Results
Table、校准曲线以及内标物和每种
分析物的色谱图。该模板适合已定
义分组的 Results Table。

不适用

确定匹配定性 这份报告针对每个选定样本显示一
个区域，其中包含文件信息；样本
信息；选定分析物的分析物结果
表；所有分析物、内标物和 XIC 的
叠加色谱图；已采集/理论 MS 质
谱；每种选定分析物的已采集/谱库
MS/MS 质谱。Analyte Results
Table 按照其在 Results Table 内的
显示内容打印。所有定性置信度红
绿灯均在表格开头处列出。

不适用

定性 CSV 报告 这份报告以 .csv 格式针对每个样本
显示一个区域，其中包含文件信
息、样本信息和分析物结果表。

建议对报告格式使用 CSV 选项。

样本摘要 这份报告针对每个样本显示一个区
域，其中包含分析物摘要表。该报
告模板适合已分组的 Results
Table。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

UV MS 定性报告 这份报告通过 WYSIWYG 表针对每
个样本显示该样本的成分及其对应
的 UV 成分。报告会显示 XIC、MS
和 MS/MS 以及 UV 数据。面积的统
计综合表显示在报告末尾。

• 处理 UVMS 数据时应遵循命名惯
例，使用 compound 1（任意字
符串）表示质谱仪 (MS) 组件，
compound 1uv（任意字符串加
uv）表示相应的 UV 组件。

• 仅会显示质量误差、碎片质量误
差、RT 置信度、同位素置信度
和谱库置信度红绿灯。

• 可创建图形表来显示 Results
Table 的各个成分，包括化合物 1
的 XIC、MS1 迹线、MS/MS 迹
线和标题信息，以及化合物 1uv
的 UV 迹线。请参阅图 6-35。

• 分析物图形仅可重复用于 MS 实
验，而不能用于 UV 实验。

• 如果样本被标记为 QC，且有 2
个或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报
告末尾的 QC 摘要表中。请参阅
图 6-36。

• 如果清除 QC 行的 Reportable
复选框，则该行不会用于 QC 摘
要表的任何计算。

图 6-35 图形表
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图 6-36 统计表
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事件 7
发生问题时，Central Administrator Console (CAC) 软件会记录屏幕上显示的错误报告和警
告。Event Log 工作区包含系统事件日志，包括错误、警告和消息。

要打开此工作区，请单击 Home 页面上的 Event Log 图标。

表 7-1 Event Log 工作区列

标签 描述

Current （当前）各个子系统的当前事件列表。

Severity （严重性）事件类型：信息、错误或警告。

Time （时间）发生事件的时间。

Subsystem （子系统）发生事件的子系统。

Event （事件）事件的描述。此信息可用于系统检修。

User （用户）用户名称和发生事件的系统。

注释: 对于由决策规则触发的事件，就是提交该批次的用户。

事件日志
其中包括以下日志：

• All（全部）

• Device（设备）

• LC(LC)

• Mass Spectrometer（质谱仪）

• Workspace（工作区）

• Batch（批次）

• Explorer(Explorer)

• Devices（设备）

• General（概况）

• LC Method（LC 方法）

• MS Method（MS 方法）

• MS Tune（MS 调谐）

• Analytics（分析）
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• Queue（队列）

• Users（用户）

• Configuration（配置）

在事件日志包含 20,000 条记录后，SCIEX OS 会自动归档记录并开始创建新的事件日志。更
多信息，请参阅以下章节：事件日志存档。

查看日志
1. 打开 Event Log 工作区。

2. 单击左侧面板中的列表项查看日志。

存档日志
1. 打开 Event Log 工作区。

2. 单击 Archive > Archive Log。

图 7-1 Archive 菜单：Archive Log

图 7-2 Archive Log 对话框

3. 在 Archive event log items older than 的字段中，单击日期图标并选择一个日期。

4. 单击 Archive。

查看存档的日志

1. 打开 Event Log 工作区。
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2. 单击 Archive > Open Log Archive。

图 7-3 Archive 菜单：Open Log Archive

3. 打开所需的文件。

4. 单击 Archive > Close Log Archive。

图 7-4 Archive 菜单：Close Log Archive

打印日志
1. 打开 Event Log 工作区。

2. （可选）打开存档日志。请参阅以下章节：查看存档的日志。

3. 单击 Print。
Print 对话框随即打开。

4. 选择打印机，然后单击 Print。

事件日志存档
事件记录都汇集在事件日志中，可能会形成庞大的文件，从而给查找和管理都带来困难。

当事件日志达到 20,000 条记录时，便会进行存档。一条 终的事件记录会添加到事件日志，
然后，该事件日志将采用显示事件日志的类型、日期和时间的文件名保存。接着，将创建新的
事件日志。新事件日志中的第一条记录将说明事件日志已存档。

事件日志存档储存在 C:\ProgramData\SCIEX\Clearcore2.Acquisition 文件夹中。

文件名的格式为 <logfile>Archive_<YYYYMMDD>_<HHMMSS>.data。例如，
CustomerLogArchive_20220427_172915.data。
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审核 8
本部分主要介绍如何使用审核功能。

查看审核记录结果
1. 打开 Audit Trail 工作区。

2. 要查看工作站的审核记录，单击左侧窗格中的 Workstation。

3. 要查看项目的审核记录，选择左侧窗格中的项目。然后选择以下选项之一：

• General Events：显示应用至整个项目的审核记录，如审核图更改和样本采集。

• Analytics：显示 Results Table 的审核记录。

• All Project Events：显示一般事件和处理事件的审核记录。

使用关键词搜索过滤已审核事件
用户可以使用关键字搜索筛选审核记录中的已审核事件。搜索会突出显示每一次出现的文本。

1. 打开 Audit Trail 工作区。

2. 选择要搜索的审核记录。请参阅以下章节：查看审核记录结果。
随即将显示 Audit Trail。

3. 在 Find in Page 字段中键入要查找的词语。
页面上出现的所有词语将突出显示。

4. 使用 Next ( ) 和 Previous ( ) 按钮在匹配项之间移动。

使用一组指定标准筛选已审核事件
用户可以使用一套指定标准过滤审核记录中的已审核事件。

1. 打开 Audit Trail 工作区。

2. 选择要筛选的审核记录。请参阅以下章节：查看审核记录结果。
随即将显示 Audit Trail。

3. 单击 Filter( )。
Filter Audit Trail 对话框随即打开。

4. 用列表定义所需筛选标准。
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图 8-1 Filter Audit Trail 对话

项目 描述

1 在<No Filter>列表，选择要筛选的字段。以下字段可用于筛选：

• Description

• Sample Name

• Full User Name

• E-Signature

• Reason

2 选择以筛选某个特定的词或短语。

3 选择以筛选部分词或短语。

4 指定要筛选的文本，如下所示：
• 键入全文本字符串。选择 Is（项目 2）。

• 键入部分文本字符串。选择 Contains（项目 3）。

• 选择 Yes 或 No。

5 用于筛选在特定日期和时间发生的事件。

5. 要清除筛选条件，请遵照以下步骤：

a. 单击 Filter( )。

b. 单击 Clear 将所有过滤标准重设为 No Filter。
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c. 单击 OK。

打印审核记录
1. 打开 Audit Trail 工作区。

2. 选择要打印的审核记录。请参阅以下章节：查看审核记录结果。

3. 单击 Print。
Print 对话框随即打开。

4. 选择打印机，然后单击 Print。
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工作原理—软件 A
本部分描述软件中使用的概念。

数据处理
SCIEX OS 软件需要一台运行 Windows 7、64 位或 Windows 10、64 位操作系统的计算机。
计算机及相关系统与系统控制器和相关固件一起控制系统和数据采集。在系统运行期间，所采
集的数据会被发送至 SCIEX OS 软件，此软件可通过完整质谱、单离子或多离子强度随时间
变化曲线或总离子流随时间变化曲线的形式显示这些数据。

扫描技术
MS：在 MS 扫描（也称为单次 MS 扫描）中，离子根据不同的质荷比 (m/z) 进行分离。单 MS
扫描可用于确定化合物的分子量。单 MS 扫描也可称为全谱扫描。除质量信息外，MS 扫描不
提供离子化学组成方面的任何信息。执行 MS/MS 或 MS/MS/MS 扫描可获得更多关于离子的
信息。

MS/MS：MS/MS 扫描用于确定结构信息。

• 在三重四级杆系统的 MS/MS 扫描中，选定的离子将进入 Q2 碰撞池，被碰撞激活，产生碎
片，从而形成特征产物离子。

• 在 QTRAP 系统的 MS/MS 扫描中，Q2 碰撞池或线性离子阱中可能会发生前体离子碎裂。

如果采用了足够大的能量，那么前体离子碎裂产生特征产物离子。

MS/MS/MS：线性离子阱 (LIT) 系统 MS/MS/MS 扫描比 MS/MS 扫描多一步。在碰撞池中产生
的离子碎片在 LIT 中进一步碎裂，从而可以提供更多关于分子离子的结构信息。

四极杆模式扫描类型

三重四极杆仪器具备定量实验所需要的高灵敏度的多反应监测 (MRM) 性能。此外，它们具有
高度特异性的扫描类型，比如前体离子和中性丢失扫描，即可对样本的组分进行更高级的搜
索。

Q1 MS (Q1)：使用第一个四极杆 (Q1) 进行的全扫描类型。对扫描范围内的每种质量均返回离
子强度。

Q1 Multiple Ions (Q1 MI)：使用 Q1 四极杆的选择性扫描类型。仅对指定质量返回离子强
度。

Q3 MS (Q3)：使用第三个四极杆 (Q3) 进行的全扫描类型。对扫描范围内的每种质量均返回离
子强度。

Q3 Multiple Ions (Q3 MI)：使用 Q3 四极杆的选择性扫描类型。仅对指定质量返回离子强
度。
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MRM (MRM)：一种 MS/MS 扫描，在此扫描中用户定义的离子在 Q1 四极杆中分离，然后在
Q2 碰撞池中裂成碎片。然后，使用 Q3 四极杆分离检测器记录的用户定义碎片离子。这种扫
描类型主要用于定量分析。

Product Ion (MS2)：MS/MS 全扫描，其中，Q1 四极杆用于分离和传输特定的前体离子，而
Q3 四极杆则扫描指定的质量范围。此扫描类型用于识别特定前体离子的所有碎片离子。

Precursor Ion (Prec)：一种 MS/MS 扫描，其中，Q3 四极杆固定在特定 m/z 值，以传输特定
的产物离子，而 Q1 四极杆则扫描一个质量范围。此扫描类型用于确认前体离子的存在，或者
更通常用于识别共有一种产物离子的化合物。

Neutral Loss (NL)：MS/MS 扫描，其中，Q1 四极杆和 Q3 四极杆扫描一个质量范围，保持
一个固定的质量差。如果离子是由 Q1 四极杆分段通过丢失指定的中性丢失（固定质量）而选
出的，则可观察到响应。此扫描类型用于确认前体离子的存在，或者更通常用于识别共有一个
中性丢失的化合物。

线性离子阱扫描类型

系统已增强操作模式。在任何 LIT（线性离子阱）模式中，离子脉冲被引入到离子阱 (Q3)
中。主要 RF 场沿径向捕获离子，离子阱两端透镜上施加的直流电压用于轴向捕获离子。捕获
的离子可冷却数毫秒，然后在杆上出现低电压的辅助交流频率时扫描 RF 电压。轴向排向检测
器的离子将被计数。

在采集阶段，离子穿过 Q2 碰撞池，在此处氮气气体将离子集中到 Q3 区域。四极杆 Q3 是在
只应用主射频电压的情况下运作。阻止离子通过 Q3 四极杆，并通过输出透镜反射回来（采用
直流势垒电压）。填充时间（操作员定义或者由软件自动计算的时间）之后，对 Q3 输入透镜
施加直流势垒电压。这样可阻止离子继续进入。输入和输出透镜直流电压势垒和施加到四极杆
上的射频电压可将采集的离子限制在 Q3 区域内。

扫描输出阶段，在输出透镜施加几伏的电势以排斥带电的离子。四极杆 Q3 采用了辅助交流频
率。主射频电压振幅由低数值斜升至高数值，从而依次使各离子与辅助交流频率发生共振。当
离子与交流频率发生共振后，它们获得了足够的轴向速度，从而可以克服输出透镜势垒，径向
排向质谱仪离子检测器。此过程称为共振激发。

注释: 线性离子阱 (LIT) 扫描模式（ER、EMS、EPI、MS3）仅在安装了 QTRAP 许可证的
SCIEX 7500 系统上受支持。

• Enhanced Resolution (ER)：MS 扫描，其中 20 Da 区域中的离子在 LIT 中采集特定填充
时间，并缓慢扫描输出，以获得增强分辨率。

• Enhanced MS (EMS)：MS 全扫描，其中指定 m/z 范围的所有离子在 LIT 中捕获指定填充
时间，再被扫描输出和检测。

• Enhanced Product Ion (EPI)：MS/MS 扫描，其中 Q1 筛选 Q2 中碎片化的前体离子。碎
片离子在 LIT 中捕获指定填充时间，再被扫描输出。

• MS/MS/MS (MS3)：Q2 中生成的产物离子在 LIT 中采集的扫描。指定 m/z 的产物离子在
LIT 中隔离并进一步碎片化。 终的碎片离子被捕获到 LIT 中，然后进行扫描输出和检测。

信息相关采集

注释: IDA 方法仅在 SCIEX 7500 系统上受支持。
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信息相关采集 (IDA) 是一种在采集过程中分析全谱扫描数据的采集方法。IDA 用于根据全谱扫
描分析结果更改实验条件。这些实时更改是由采集方法中设定的标准控制的，包括：

• 候选离子的 大数量

• 强度阈值，指定候选离子的 小强度

• 动态背景减除，基于强度增加优化离子

• 排除之前的候选离子

• 候选离子的电荷状态，以及是否应包含电荷状态未知的离子

• 候选离子的质量范围

• 将包含的离子列表

• 将排除的离子列表

• 排除窗口，指定将排除的同位素离子

• 触发条件性扫描的同位素模式

• 质量偏差窗口，指定候选离子质量窗口，其中的质量将被认为与候选离子相同

在单个时段中创建一个有一次全谱扫描和八次条件性扫描的 IDA 方法。全谱扫描和 IDA 标准
用于 IDA 中以测定条件性扫描的候选离子。以下扫描类型可用作全谱扫描：

• MRM

• 中性丢失扫描

• Precursor ion

• Q3

• 增强型 MS (EMS)

以下扫描类型可用作条件性扫描：

• EPI

• 子离子

• MS3（二级条件性扫描）

在 IDA 实验中，质谱仪的动作会根据之前扫描中所采集的数据因不同扫描而异。软件会在数据
采集时对其进行分析，然后确定进行条件性扫描的质量。用户可以设置激活 IDA 实验的标准以
及拟采用的方法参数。

不同的数据视图

色谱图

色谱图显示在重复性实验中，某些量相对于时间发生的变化。例如，当仪器经过编程设计可将
一组给定的质谱扫描重复数次时。色谱图数据是连续的，即使数据强度为零也不例外。色谱图
不是由仪器直接生成的，而是通过质谱产生的。

在色谱图中，以每秒次数 (cps) 为单位的强度在 Y 轴上显示，而 X 轴代表时间。峰是自动标记
的。
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色谱峰的保留时间和强度会随着给定样本的色谱条件变化而变化。

该软件显示以下类型的色谱图：

• TIC：通过将总离子流作为时间的函数而绘得的图形。

图 A-1 TIC 示例

• XIC：通过从一系列质谱扫描在单个、不连续的质量数或一个质量范围内提取产生的强度数
值而创建的离子色谱图。XIC 表示一个给定的质量数或质量范围随时间变化的行为。
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图 A-2 XIC 示例

质谱图

质谱是指直接从质谱仪获取的数据，通常代表的是以特定质荷比 (m/z) 值检测到的离子数。它
以图形形式显示，X 轴显示 m/z 值，Y 轴显示强度 (cps)。

当数据作为质谱查看时，可获得有关某化合物的质量特异性信息。质谱提供特定色谱峰的对应
离子的 m/z 值。这些离子可用于查找更具体的信息。例如，质谱显示的是组成一个峰的所有质
量，包括每一种质量的强度。

质谱强度可能会改变，但 m/z 值是固定的，因为化合物的质量不会改变。

生成质谱数据有两种方式：

• 如果只采集到一种扫描，则会以质谱方式显示数据。

• 来自色谱图。

sMRM 算法
Scheduled MRM (sMRM) 算法包括下列功能：

• Retention time tolerance 列允许在采集方法中为每个离子对配置采集窗口，从而可以提高
实验保留时间的普适性。用户可以针对 LC 峰范围广、保留时间差异大的不同化合物调整窗
口大小。
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• 驻留时间可以自动计算，或者用户可以为每个离子对指定自定义驻留时间。对于数量非常
充足的化合物，可以指定一个较低的驻留时间，而对于数量偏少的化合物，可以指定一个
较高的驻留时间。用户编辑的驻留时间从目标周期时间中扣除，且剩余周期时间被重新分
布，以计算未编辑离子对的驻留时间。运行期间，根据软件计算或用户编辑的值分配可用
驻留时间，二者均必须位于用户在该方法中指定的 短和 长驻留时间内。

sMRM 算法触发

如果为 sMRM 算法启用了触发，则以下功能也可用：

• 用户可以将分析物的多个离子对标记为主要或次要。主要离子对在整个采集时间窗内受到
全程监测，而次要离子对仅在相关的主要离子对到达触发阈值后才被监测。这样就可以通
过减少被监测的 MRM 离子对数量，来 大限度地缩短扫描周期。采集时间主要用于采集样
本中存在的分析物的数据（其中检测到它们的所有相应离子对都高于定义的阈值），而不
是针对样本中不存在的分析物。

• 该算法支持动态背景减除 (DBS) 触发次要离子对。请参阅以下章节：Dynamic Background
Subtraction 算法。在启用 DBS 时，它将被应用到主要离子对，以触发该实验中的次要离子
对。

对于为全谱扫描使用 sMRM 算法的 IDA 方法，如在 IDA 条件中启用 DBS，将被应用到主
要离子对，以触发次要离子对和 MS/MS 扫描。

stMRM 算法
Scout Triggered MRM (stMRM) 算法是 Scheduled MRM (sMRM) 算法的改进。

在 sMRM 算法中，启用触发后，可以基于用户定义的触发阈值，使用主要离子对采集次级离
子对的数据。但这种触发仅适用于属于同一化合物组且具有相同保留时间和保留时间公差的离
子对。

stMRM 算法通过使用标记离子对触发相关离子对来扩展此功能。相关离子对既可以属于相同
的化合物组 ID，也可以属于不同的化合物组，但前提是它的洗脱时间晚于相应的标记离子对
的保留时间。

标记化合物是触发采集后洗脱相关离子对的化合物。它必须是已知存在于或被引入每个样本中
的化合物，例如质量标记的内标物或样本基质中普遍存在的内源性化合物。

stMRM 算法提供两种模式。相关离子对可能与基于相对保留时间（Scout triggered MRM RT
模式）或组（Scout triggered MRM group 模式）的标记离子对相关。

注释: stMRM 算法可用于正负极性实验之间的交叉实验触发。两个实验必须使用相同的
stMRM 算法模式。

保留时间模式

在保留时间模式下，用户无需为每个离子对定义保留时间窗口，即保留时间加上或减去保留时
间公差。相反，在初始方法开发过程中确定的保留时间用于确定离子对的洗脱顺序。然后，软
件会根据保留时间的接近程度，自动将相关离子对分配给用户定义的标记离子对。为相关离子
对指定的保留时间不需要很精确，但它们必须反映洗脱顺序。
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如果使用多个标记化合物，则它们的保留时间必须分布在整个运行时间中，以便将运行时间分
割成多个采集窗口，每个窗口都包含一个前导标记离子对及其后洗脱相关离子对。

当第一个标记离子对 (Compound A) 的强度达到其触发阈值时，软件开始监视其相关离子对以
及下一个标记离子对 (Compound B)。请参阅图：图 A-3。当第二个标记化合物 (Compound
B) 的强度达到其触发阈值时，软件停止监测第一个标记化合物 (Compound A) 及其相关离子
对，并开始监测第二个标记化合物 (Compound B) 以及第三个标记化合物 (Compound C) 的相
关离子对。

图 A-3 定位离子触发的 MRM，RT 模式

项目 描述

1 标记化合物，保留时间分布在整个标记中（Compound A 到 Compound
C）。

2 根据保留时间分组的相关化合物（Compound 1 到 Compound 12）。
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图 A-4 方法概述：正极性和负极性

项目 描述

1 Compound A 的依赖项。

2 Compound B 也是 Compound A 的依赖项。

3 Compound B 的依赖项。

4 Compound C 也是 Compound B 的依赖项。

5 Compound C 的依赖项。

相关离子对与保留时间更早的前一个标记离子对相关联并由其触发。

示例：相关离子对的触发

第一个标记离子对 (Compound A) 的保留时间为 1.0 分钟，第二个标记离子对 (Compound B)
的保留时间为 2.0 分钟。

保留时间分别为 1.1 分钟、1.5 分钟和 1.6 分钟的相关离子对 Compound 1、Compound 2 和
Compound 3 由第一个标记离子对 (Compound A) 触发。保留时间分别为 2.3 分钟、2.4 分钟
和 2.5 分钟的相关离子对 Compound 6、Compound 7 和 Compound 8 由第二个标记离子对
(Compound B) 触发。

多个标记离子对

具有相同化合物组 ID 和保留时间的多个离子对（如定量离子和定性离子离子对）可以被识别
为标记离子对。所有这些标记离子对都必须超过它们各自的触发阈值，然后才会触发它们的相
关离子对。
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RT 重叠

如果相关离子对在洗脱时距离其标记离子对的采集窗口的起始或结束边缘太近，则保留时间偏
移可能会导致该相关离子对漂离该窗口。如果发生这种情况，则不会采集其数据。使用保留时
间 (RT) 重叠功能可防止出现此问题。

示例：Compound 4

相关离子对 Compound 4 的保留时间显示，它要在标记离子对 Compound A 之后且在标记离
子对 Compound B 之前完成洗脱。由于它要在靠近 Compound A 采集窗口的边缘洗脱，所以
可能会漂入 Compound B 的采集窗口。当 Compound B 达到其触发阈值时，便会停止监测
Compound A（包括 Compound 4）的相关离子对。因此，如果 Compound 4 在 Compound B
达到其触发阈值后才洗脱，则无法对其进行采集。请参阅图：图 A-5。

示例：Compound 5

同样，相关离子对 Compound 5 的保留时间显示，它要在标记离子对 Compound B 之后完成
洗脱，所以它会被 Compound B 触发。如果 Compound 5 漂入此前的标记离子对 Compound
A 的采集窗口，则它既不会被触发，也不会被采集。请参阅图：图 A-5。

示例：RT 重叠

要确保触发这些边缘处的相关离子对，可使用 RT overlap 选项。此选项允许用户在每个标记
离子对周围设置公差窗口。保留时间重叠窗口中的任何相关离子对都会被任意的重叠标记离子
对触发。

在此示例中，RT overlap 被设置为 0.2 分钟。因此，如果 Compound 4 漂离 Compound A 的
采集窗口，则会被 Compound B 触发。同样，Compound B 或 Compound A 也可以触发
Compound 5。

图 A-5 RT 重叠

触发因素

Triggered by 列显示分配给每个相关离子对的标记离子对的化合物 ID。标记离子对是根据用
户输入自动分配的，包括触发选择、相对保留时间、指示洗脱顺序和 RT 重叠。

表 A-1 Triggered by 列

句法 描述

[开始运行] 显示第一个标记离子对或在第一个标记离子对的保留时间之前洗脱的离子
对。
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表 A-1 Triggered by 列 (续)

句法 描述

|| 显示可由其自己的用户定义的标记离子对或 RT overlap 窗口中定义的相
邻标记离子对触发的离子对。

&& 显示保留时间相同且属于同一 Group ID 的多个标记离子对触发某个离子
对的时间。

( ) 显示保留时间相同且属于同一 Group ID 的多个标记离子对的组。

组模式

在组模式下，超级组会将相关离子对分配给标记离子对。每个超级组至少包含一个标记离子对
和多个相关离子对，而后者会被这些标记离子对触发。标记离子对必须是超级组中的第一个洗
脱离子对。如果将多个标记离子对分配给一个超级组，则所有标记离子对都必须先达到其触发
阈值，然后才会触发相关离子对。

将标记离子对和相关离子对分组为超级组是基于预定义的分析关系，该关系按逻辑将这些化合
物连接在一起，例如母离子或代谢物、结构异构体以及蛋白质或肽确认。

对于标记离子对和相关离子对，用户可自行选择是否输入保留时间。不含保留时间的离子对会
从其标记离子对达到其强度阈值时开始被扫描，直至运行结束。具有指定保留时间的离子对会
在其保留时间窗口期被扫描，如 Scheduled MRM (sMRM) 算法所示。

在探索性过滤期间，可能并不知道所有分析物的保留时间，尤其是仅怀疑存在于某些样本中的
分析物。组模式结合了 sMRM 算法的保留时间窗口日程和基于超级组的触发，这不仅能让用
户测量典型的目标分析物列表，还能让用户在同一次进样中适时过滤保留时间未知的其他化合
物。此外，未分配给超级组的任何离子对都可以通过 sMRM 算法采集。
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图 A-6 组模式

项目 描述

1 高于阈值触发的早期洗脱标记。

2 根据分析兴趣与标记化合物 Compound A 进行分组的相关化合物。

3 未超过其触发阈值的标记（Compound B 和 Compound C）MRM 离子
对。这些相关离子对不会被采集。
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图 A-7 方法概述（正极性和负极性）

项目 描述

1 具有指定保留时间的 Compound A 依赖项。

2 保留时间设置为零 (0) 的 Compound A 依赖项。

3 保留时间设置为零 (0) 的 Compound B 依赖项。

4 保留时间设置为零 (0) 的 Compound C 依赖项。

触发因素

Triggered by 列显示分配给每个相关离子对的标记离子对的化合物 ID。标记离子对是根据用
户输入自动分配的，包括触发选择和超级组分配。

表 A-2 Triggered by 列

句法 描述

[开始运行] 显示包含保留时间为零 (0) 的 Super Group ID 所属的标记离子对。

|| 显示可以由 Group ID 不同但 Super Group ID 相同的多个标记离子对触
发的离子对。

&& 显示 Group ID、保留时间和 Super Group ID 均相同的多个标记离子对
触发某个离子对的时间。
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表 A-2 Triggered by 列 (续)

句法 描述

( ) 显示保留时间相同且属于同一 Group ID 的多个标记离子对的组。

Scheduled Ionization
Scheduled Ionization 功能可降低污染风险，从而减少质谱仪停工时间。如启用此功能，则用
户可以根据使用的探针类型指定 Spray voltage 或 Nebulizer current 设置为方法中指定值的
时段。

要使用此功能，首先通过采集未启用此功能时的数据确定所关注峰洗脱的时段。

确定所需的时段后，启用此功能，然后设置适当的 Start time 和 Stop time。

例如，对于时长 5 分钟的方法，如果所关注峰在 1.6 - 3.4 分钟之间洗脱，则可能使用 1.5 分
钟 Start time 和 3.5 分钟 Stop time。

决策规则
当 Queue 工作区内正在处理批次时，软件能针对特定分析结果执行选定的纠正措施。例如，
如果样本不符合处理方法中定义的验收标准（分析结果），则可要求软件重新注射该样本（纠
正措施）。

此功能通过决策规则实现。决策规则包括两个主要部分：

• 标记规则，用于定义分析结果

标记规则在处理方法中定义。

• 纠正措施，当处理结果不符合分析结果标准时采用纠正措施

纠正措施包括以下几种：

• 停止队列

• 中止批次

• 注射不同的样本

• 重新注射标记的样本

创建批次时，用户可以激活该批次的决策规则，然后选择要使用的决策规则。

Dynamic Background Subtraction 算法
Dynamic Background Subtraction 算法可以增强信息相关采集 (IDA) 实验中前体离子的检测效
果。当算法被激活后，IDA 将使用一个已经经过背景减除的质谱来选择所关注的前体离子进行
MS/MS 分析，而非直接从测量质谱中选择前体离子。由于在 LC 分析期间进行处理，该算法
在信号强度增加时启用粒子种类检测。因此，此算法关注 LC 峰上升部分直至或稍微超出 LC
峰顶部的前体离子的检测和分析。
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定量分析
定量分析用于确定样本中特定物质的浓度。通过分析未知样品并与包括浓度已知的相同物质的
样本（即标准物样本）进行比较，软件可以计算出未知样品的浓度。这个过程涉及使用标准品
的信号响应或响应比创建校准曲线，然后计算未知样本的浓度。所有样品的计算所得浓度都添
加到 Results Table 中。

定量分析 常使用多反应监测 (MRM) 扫描执行。在 MRM 扫描中，使用前体离子和特征产物
离子定义对分析物具有高度特异性的 MRM 离子对。在液相色谱检测期间，MRM 离子对与分
析物相关保留时间结合起来，可达到定量分析所需的特异性。

定量工作可通过使用经过验证的 MRM LC-MS/MS 采集方法、采集校准标准曲线以及随后对目
标化合物相关峰进行积分来实现。信号响应与浓度之间的校准曲线关系用于确定未知样本中特
定分析物的含量。

标准物添加

标准物添加可用于确定已知基质效应阻碍了传统校准曲线使用的样本中的化合物浓度。

此功能让用户可以在软件内直接执行标准物添加计算。如果在定量工作流中启用了标准物添加
功能，那么将在积分过程中执行标准物添加计算，结果将显示在 Results Table。

如果启用此功能，那么将禁用以下回归参数：

• Regression Type

• Weighting Type

• Automatic Outlier Removal

启用标准物添加功能

1. 打开 Analytics 工作区。

2. 单击 Process Method > New。

提示! 要编辑已有的处理方法，单击 Process Method > Edit embedded method，然后
遵照下列步骤。

3. 选择 Workflow 页面，然后选择至少一个工作流程以及参考样本。

4. 选择 Components 页面，然后定义成分名称、质量、内标物、分组等。

提示! 如果该组在 Components 表中进行定义，那么用户可选择对组内离子求和，即使相
应离子对的前体离子和实验指数不同时也不例外。求和离子未显示在表中，但却显示在
Integration 页面上，并且也作为 <group name>_Sum 显示在 Results Table 中。该功能有
助于定量分析蛋白质和肽。

提示! 在成分的保留时间未知的情况下，请将质量或化学式的 Retention Time Mode 设置
为 Find n peaks，其中 n 为 1、2、5、10 或全部。软件可识别指定数量的面积 大的特
征峰，指定合适的保留时间，然后执行针对性的峰处理工作流。处理完成后，可以将
Results Table 的内嵌方法保存为一个正常的针对性方法。
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5. 选择 Integration 页面，然后为各个成分选择积分参数。

6. 单击 Options > Quantitate by standard addition。

此功能对以下批次字段有具体要求：

• Sample ID:属于同一标准物添加组的所有样本必须具有相同的样本 ID。

• Sample Type:采用标准物添加进行定量分析的所有样本必须具有样本类型
Standard。

• Actual Concentration:该字段必须包含添加到标准物添加组中每一样本的标准物的已
知浓度。例如，对于没有添加标准物的样本，该字段为 0。来自该列的数据绘制为
Calibration Curve 上的 X 轴。

如果启用该功能，那么 Results Table 将包含一个新的 Standard Addition Accuracy 字
段，该字段将样本的 Standard Addition Calculated Concentration 与 Standard
Addition Actual Concentration 相比较。

特定样本的校准曲线动态视图显示在 Calibration Curve。

质量重建

对于大分子，通常会在 MS 全扫描质谱中观察到电荷状态散布。质量重建功能让用户可以直接
在软件中执行谱图去卷积，然后基于去卷积或零电荷质量峰执行定量。如果质量重建功能已在
定量工作流程中启用，则将在处理期间执行找峰、谱图去卷积、质量峰查找和积分，且结果将
显示在 Results Table 中。

启用质量重建功能

注释: 质量重建仅在定量工作流程中受支持。

注释: 质量重建仅支持 MQ4 和 Summation 积分算法。

注释: 如果启用了质量重建，则 Options > Sum Multiple Ion 被禁用。

1. 打开 Analytics 工作区。

2. 单击 Process Method > New.

提示! 要编辑已有的处理方法，单击 Process Method > Edit embedded method，然后
遵照下列步骤。

3. 选择 Workflow 页面，然后选择 Quantitation 工作流程以及参考样本。

4. 选择 Components 页面。

5. 单击 Options > Mass Reconstruction。

6. 添加成分，以在必填字段中键入信息。

注释: Expected MW 字段可选。
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7. 单击 Integration 查看积分页面，并审核 XIC 色谱图、平均质谱图和重建质谱图，然后选
择目标质量。

8. 保存方法。

如果这项功能启用，则 Results Table 会包含以下新列：Expected MW、MW、MW
Delta (Da)、MW Delta (ppm)、IS Expected MW、IS MW、IS MW Delta (Da) 和 IS
MW Delta (ppm)。

定性分析
定性分析是鉴别一种目标或未知化合物。在质谱分析中，确定存在哪种化合物的工作可使用质
量准确度、保留时间、同位素模式、谱库搜索和化学式查找功能来实现。综合使用所有这些工
具可在鉴别未知样本中靶标和非靶标化合物方面提高置信度。

保留时间

大多数质谱仪使用某种类型的色谱法。化合物的保留时间通过注射化合物的一种已知标准物确
定。保留时间可用于帮助鉴别样本中的目标化合物。如果疑似化合物存在于一种未知物样本
中，则保留时间越靠近标准物的保留时间，未知化合物就越容易鉴别。保留时间可能变动，且
必须使用已知标准物进行常规确认。

同位素模式

根据化合物的分子式，在质谱仪中对其得出的全扫描质谱具有不同的同位素模式。

关于吗啡的同位素形式，请参阅下图。

图 A-8 同位素模式（吗啡）

抑霉唑的同位素模式由元素的不同质量同位素构成。对同位素模式进行理论计算，然后将其与
在未知物样本中针对该化合物实际采集到的同位素模式进行比较。理论与实际同位素模式越匹
配，该化合物就越有可能是已鉴定的化合物。
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谱库搜索

将未知样本的已采集 MS/MS 质谱与包含参考质谱的化合物数据库进行比较是 强有力的定性
分析工具之一。谱库搜索算法将未知物质谱与样本进行比较，然后尝试将质谱匹配至已知化合
物和数据库内的质谱。匹配越接近，所报告的评分越高，从而更有可能使化合物得到鉴定。

纯度、拟合值和逆拟合值计算如下：

• 如果（折算的）谱库质谱和（折算的）未知质谱（其强度比在用户指定的限值范围内）在
给定质量下都有一个峰，则谱库质谱内的峰强度会被设定为与未知物质谱相等。

• 纯度计算如下：

100.0 (ULtotal)2 / (Utotal•Ltotal) 其中：

Utotal = ∑ Um•Um

Ltotal = ∑ Lm•Lm

ULtotal = ∑ Um•Lm

求和值包括所有质量，其中强度 Um 和 Lm 是质量加权值的平方根，它是折算的未知库条
目。纯度一定会落入 0 - 100 的范围内，它是衡量谱库质谱和未知物质谱相似性的一个指
标。

• 拟合值按照与纯度完全相同的方式进行计算，但只有出现在谱库质谱中的质量才会被包括
在总和之中。这对 Ltotal 或 ULtotal 没有影响，因为未从这些总和值中删除任何条件。拟合值
是衡量谱库质谱包含在未知物质谱内的程度的一个指标。高拟合值和低纯度表示未知物质
谱可能不纯，但包含谱库化合物。

• 逆拟合值也按照与纯度完全相同的方式进行计算，但只有出现在未知物质谱中的质量才会
被包括在总和之中。逆拟合值是衡量未知物质谱包含在谱库质谱内的程度的一个指标。

化学式查找

通过使用质量数，化学式查找算法尝试根据质谱仪生成的 MS 和 MS/MS 质谱图，预测化合物
的化学式。化学式查找得分高并不一定意味着样本中的化合物是化学式查找算法所鉴定的化合
物，因为有些化学式通常会有质量匹配误差。必须小心操作，同时必须在使用化学式查找功能
识别化合物之前，先进行其他确认性测试。

注释: 不建议使用标称质量系统进行执行化学式查找。

化学式查找算法对质量准确性使用红绿灯设置。红色的 ppm 误差得 0 分，完美匹配得 100
分。

MS 质谱对 终的化学式查找评分的贡献是 67%，MS/MS 质谱的贡献是 33%。因此，化学式
预测 MS 质量的能力是影响评分的主要因素。然而，MS/MS 碎片的匹配也会影响评分。

同位素模式用于生成所发现化学式的列表，但它不用于生成 终评分。因此，同位素模式错误
的化学式可能不包含在列表中。

可能化学式的列表使用前体离子质量准确度、同位素模式和 MS/MS 碎裂进行确定。建议化学
式根据前体离子质量准确度以及匹配碎片的平均 MS/MS 质量准确度进行评分。
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积分
在定量或定性分析中，积分指的是为关注化合物生成色谱峰面积或高度。处理方法包含处理数
据所需的所有信息。

给定样本集的定量或定性信息汇编构成所谓的 Results Table。请参阅 Results Table。

该软件有三个可以使用的积分算法：

• MQ4：选择的是一个默认为分析运行代表样本的低浓度（但不是 低浓度）标准物或质量
控制样本。

• AutoPeak：选择的是一个默认为分析运行代表样本的高浓度（但不是饱和浓度）标准物或
质量控制样本。

• Summation：不执行正常的峰搜索，但假设峰出现在预计保留时间附近。

对于上述算法漏掉的峰，也可以手动求取其积分。

AutoPeak 积分算法参数

以下参数用于识别和报告所关注的峰。

关于可用参数的完整列表，请参阅帮助系统。

• 局部峰基线：与根据整个色谱图计算基线不同，该软件可评估峰周围基线的局部改变。

• 线性峰基线：与峰下面的基线可能表现为非线性形式的情况不同，该软件可在一组特定峰
的起点和终点之间进行线性拟合。

饱和校准：当算法检测到某个峰已饱和时，如果此时检测器未饱和，则会运用该模型来预测峰
的形状。这样就会使峰的轮廓超过峰的 顶端，直到所能达到的响应高度附近。它可以扩大校
准曲线的线性动态范围。只有在设置总体算法默认值而且不在创建处理方法或检查各个峰的时
段内，该选项才可用，因为仅对某些峰使用该设置是没有用的。

Minimum Signal/Noise
如果 小信噪比被设为 7，如下图中的左图所示，则不会报告峰。如果 小信噪比被设为 2，
如右图所示，则会报告峰。参数并不影响积分。
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图 A-9 S/N 阈值

置信度阈值

该参数用于过滤潜在的假阳性峰。默认值为 50%，通常情况下是适宜的。不过，对于噪声较
大的数据或者不同样本间峰宽度差异较大的数据，用户可能希望使用更大的值。

下面的两个图显示了 Confidence Threshold 对峰的识别数量有怎样的影响。如果
Confidence Threshold 设为 50%，带有一点肩部的峰被识别为一个峰。如果 Confidence
Threshold 降低到 16%，则 SignalFinder 算法将找到两个峰。在两个峰的区域画框，查看两
个峰。

要确定一个峰当中是否可能存在其他峰，以及 Confidence Threshold 是否正确，可按住
Ctrl，然后将所关注的峰区域画入框中。这样可以自动降低 Confidence Threshold，以反映
第二个所关注的峰，这个峰在 Confidence Threshold 被设为 50% 时是不存在的。

图 A-10 50% 置信度

在 16% 的置信度下发现了两个峰。在峰区域画框，找到两个峰.
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图 A-11 16% 置信度

图 A-12 置信度阈值参数

局部与全局峰基线

峰基线可以是局部的，也可以是全局的。如果选中局部选项，定量软件就会以局部方式评估基
线的变动。全局选项将整个色谱图用作基线。

有关显示应在何时使用局部基线的示例，请参阅下图。左图是一个用局部基线经过恰当积分的
色谱图。右图是同一个用全局基线经过不恰当积分获得的色谱图。

图 A-13 使用全局基线
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线性与非线性峰基线

峰基线可以设为线性或非线性。非线性选项用来预测每一个峰之下的基线。线性选项可以在特
定峰组的起点和终点之间作出一根拟合线。有关共同洗脱峰线性和非线性基线的示例，请参阅
图 A-14 和图 A-15。第 1 项至第 4 项是卷积峰。第 5 项显示由不同选项得出的基线。

对多个峰建议使用非线性基线。对单个峰而言线性和非线性基线之间的差别并不显著。

图 A-14 线性基线示例
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图 A-15 非线性基线示例

MQ4 积分算法参数

以下参数用于识别和报告所关注的峰。关于可用参数的完整列表，请参阅帮助系统。

噪声百分比

该参数用于估计色谱图中的噪声水平。强度 小的数据点的指定百分比被假定为噪声。

典型值的范围为 20% - 60%。如果在有较大峰存在的情况下不能发现小的峰，就应当降低噪声
百分比。下图显示了一个有极大峰存在情况下的小峰的例子。当噪声百分比被设为 90% 时，
该峰未被找到，但当噪声百分比被设为 40% 就能找到。
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图 A-16 关注峰

在下面的图中，左图显示噪声百分比被设为 40%。右图被设为 90%。

图 A-17 噪声水平

Baseline Subtract Window
在经过平滑计算但尚未进行其他处理时，色谱图的基线会作减法计算，以消除数据中的隆起部
分。对于每一个数据点来说，基线是用当前强度 小的点（在减除窗口内）的左右两侧的数据
点计算出来的。

该参数值确切是多少并不重要，只要该值在设置时至少是预计峰宽度的数倍即可。

下图中，左侧的图显示了设为 0.1 分钟的基线减除窗口，右侧的图显示了设为 1 分钟的基线减
除窗口。
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图 A-18 基线减除窗口

峰分离

该参数用于控制潜在的噪声峰是作为一个峰还是两个或多个单独的峰对待。如果两个潜在峰之
间的空隙小于指定值，则作为一个峰对待。否则就作为两个峰对待。

将该参数设为一个较大的值可以防止噪声峰被分离，并被作为两个单独的峰对待。不过，如果
有两个洗脱峰靠得很近（重叠），则需要使用较小的值。

在下图中，左侧的图显示的峰分离被设为两个点。右侧的图显示的峰分离被设为三个点。

图 A-19 峰分离

回归
在 Calibration Curve 和 Metric Plot 中，分析物峰的面积或高度与已知浓度的关系被绘制成图
表。之后用线条连接各点。回归线用于计算未知样本的浓度。
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回归方程

本部分主要介绍用于计算回归曲线的方程。在下列等式中，x 代表标准物样本的分析物浓度，
而 y 则代表相应的峰面积或高度。用于回归计算的变量取决于是否使用了内标物以及所使用的
峰面积或高度是否如下表所示。

表 A-3 回归变量

是否使用了内标
物？

是否使用了面
积？

x y

是 是 Ca / Cis / DF Aa / Ais

是 否 Ca / Cis / DF Ha / His

否 是 Ca/ DF Aa

否 否 Ca/ DF Ha

其中：

• Ca = 实际分析物浓度

• Cis = 内标物浓度

• DF = 稀释系数

• Aa = 分析物峰面积

• Ais = 内标物峰面积

• Ha = 分析物峰高

• His = 内标物峰高度

加权类型

下表显示的是七种加权类型中的加权系数 (w) 是如何计算的。

表 A-4 加权类型

加权类型 权重 (w)

无 始终是 1.0。

1 / x 如果 |x| < 10-5，则 w = 105。否则，w = 1 / |x|。

1 / x2 如果 |x| < 10-5，则 w = 1010。否则，w = 1 / x2。

1 / y 如果 |y| < 10-8，则 w = 108。否则，w = 1 / |y|。

1 / y2 如果 |y| < 10-8，则 w = 1016。否则，w = 1 / y2。

ln (x) 如果 x < 0，则会报错。如果 x < 10–5, 则 w = ln 105，否则 w = |ln (x)|。

ln (y) 如果 y < 0，则会报错。如果 y < 10-8，则 w = ln 108，否则 w = |ln (y)|。
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相关系数

在回归等式中，x、y 和 w 的定义和前面一样。所有求和计算都是针对全部标准物样本，被标
注为未使用的标准物样本除外。

相关性系数的计算如下：

其中：

•

• yc = 使用回归类型的适当等式计算的 Y 值

•

回归类型

Analytics 工作区中提供有以下回归类型：

• 平均值（仅限 Metric Plot 窗格）

• 中位值（仅限 Metric Plot 窗格）

• 线性 (y = mx + b)

• 过零点线性 (y = mx)

• 平均响应因子

• 二次 (y = a2 + bx + c)

• 幂

• Wagner

• Hill

注释: Calibration Curve 窗格内的 Regression Options 对话框中的 Remove outliers
automatically from the calibration curve 选项会将自动离群值删除规则自动应用到选定的相
关成分。请参阅帮助。

Linear (线性回归)
线性校正等式为：

y = mx + b

斜率和截距的计算方式为：

工作原理—软件

SCIEX OS 软件 适用于 SCIEX Triple Quad 和 QTRAP
系统
198/214

软件用户指南
RUO-IDV-05-9804-ZH-F



其中：

过零点线性

过零点线性的校准等式是：

y = mx

斜率的计算方式是：

平均响应因子

平均响应因子校准等式为：

y = mx

这与线性过零点校准用的是相同的等式。不过斜率的计算方式不同：

响应因子的标准差则是：

其中：

注释: X 值为零的点不予求和。

如果在点连线上有一些直线，有一些曲线，则应使用幂回归而非线性或二次回归方式在这些拟
合点之间的某处产生连线。

二次

二次校准等式如下所示：

y = a2x2 + a1x + a0

多项式系数的计算如下：

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 = b5/b3 - a2b4/b3
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其中：

幂

幂函数校准等式为：

y = axp

线性校准等式的用法如上所述，它被用于计算斜率 (m) 和截距 (b)，只不过这些等式中的 x 用
lnx 代替，而 y 则用 lny 代替。这一步完成后，a 和 p 的计算方法为：

a = eb

p = m

如果有任何 x 或 y 值为负或零，软件就会报告错误。

Wagner
Wagner 校准等式为：

ln y = a2 (ln x)2 + a1 (ln x) + a0

按照上文所述使用二次校准等式来计算 a0、a1 和 a2，但这些等式中的 x 将被 ln x 替换，y 将
被 ln y 替换。

如果有任何 x 或 y 值为负或零，软件就会报告错误。

Hill
Hill 校准等式为：

y = (a + bxn) / (c + xn)

不可能有分析方程能够解出 a、b、c 和 n。这些系数是用 Levenberg-Marquardt 迭代法确定
的。
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自动离群值删除
这是一项选配功能，让软件可自动从校准曲线删除离群值。这项节省时间的功能，对于线性范
围和灵敏度不同的多种化合物的应用而言比较有用。

当这项功能启用时，软件会迭代地检验所有数据点，以便确定由四个连续点组成的起始范围，
该范围能提供 佳线性回归并满足用户指定的离群值删除规则。算法针对起始点的所有排列计
算多重回归。它会考虑满足用户指定的规则的所有有效回归，并让这些所有有效的回归通过扩
展序列。对于所有有效的起始范围而言，每次扩展是否成功取决于所使用点的总数、所使用水
平的范围以及扩展之前和之后回归内具有 糟糕绝对准确度的那一点。扩展至 大范围且满足
规则的回归是“胜出”回归。

注释: 如果无法提供四个数据点，那么软件将采用三个。如果可提供的数据点少于三个，那么
将不会应用算法。

自动离群值删除的规则在处理方法中定义，包括以下内容：

• 小相关系数 (r)

注释: 此选项采用相关系数，而非确定系数 (r2)。

• 定量下限 (LLOQ) 时标准物重复的 大允许准确度误差

• 高于 LLOQ 时标准物的 大允许准确度误差

• LLOQ 时多个标准物重复的 大变异系数 (CV) 百分比

注释: 如果 %CV 大于特定值，那么算法将按准确度误差降序删除重复，直到剩余重复的
%CV 小于该值。

• 高于 LLOQ 的所有水平时多个标准物重复的 大 CV 百分比。

注释: 如果 %CV 大于特定值，那么算法将按准确度误差降序删除重复，直到剩余重复的
%CV 小于该值。

• 指定的离群值总数是否不包括低于 LLOQ 和高于定量上限 (ULOQ) 的离群值

• 可为某一浓度水平删除的离群值 大数

• 可从校准曲线中删除的离群值总数

注释: 此算法适用于所有标准，包括那些手动排除的标准。

注释: 如果用于生成回归的重复次数对于每个标准物水平有所不同，自动离群值删除无法完美
运行，只能作为起始点使用。手动检查每个校准曲线。

提示! 请确保处理方法 Acceptance Criteria 中的标准物准确度公差阈值与 Rules for
Automatically Removing Outliers for Calibration Standards 对话框中的公差阈值相匹配。
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Results Table
Results Table 收集了与一组样本相关的定量和定性信息。表中包括内插标准物校准曲线后确
定的浓度和准确度计算值。谱库搜索结果、化学式查找结果以及其他定性分析结果也在
Results Table 中提供。可显示面积、高度和其他数量特征。为便于查看，可对 Results Table
中列的数量和类型进行编辑。

校准曲线
校准曲线（也被称为标准浓度曲线）是一种通过将未知样本与一组已知浓度的标准物样本进行
比较，来确定未知样本中物质浓度的方法。校准曲线是一种仪器（的分析信号）如何响应分析
物（待测量的物质）浓度变化的图表。用户可以准备一系列标准物，其浓度范围接近未知样本
中分析物的预计浓度。

校准标准品用于建立校准曲线。有些校准样本的错误读数或缺失的读数可能会指出分析运行中
存在的问题。遵循文献和监管机构指南中找到的可接受方法来创建校准曲线。制作校准曲线时
的良好做法示例包括：

• 在要测量分析物的空白基质中制备校准标准物。

• 为每个要测量的分析物生成校准曲线。

• 确保涵盖预期分析物浓度范围，包括典型和非典型标本。

• 使用六到八个标准物来生成曲线。

这不是详细一览表，在确定制定实验室校准曲线的 佳做法时还应使用其他指南。

注释: 一些分析运行中使用单点校准标准物。通过基质空白样本和单个标准物浓度可进行单点
校准。仪器反应和分析物浓度之间的关系可通过由这两个点确定的直线确定。将采集方法和处
理方法用于其预期用途前，这两个方法都应进行验证。

信噪比
当执行定量质谱数据处理时，一定要确定某个峰是否显著，而显著通常是指超过了背景噪声。

相对噪声和信噪比计算

通常峰高度要与无峰区域测量的背景噪声进行比较，这些地方的噪声通常以该范围数据点标准
差的 1 倍或 3 倍进行估算。这种方法不甚理想的原因有：

• 它是主观的，因为噪声区域是手动选择的。

• 没有峰的背景区域可能不存在，或者该区域可能过窄，无法准确估计噪声。

• 峰位置处的噪声可能与选定噪声区域的噪声有很大不同。

• “1 倍或 3 倍”的系数也是主观的，而且不同权威人士给出的推荐也不同。

• 如果数据已经预先经过处理，明显的噪声可能会受到改变。比如，被平滑或被限制范围。

通过运用相对噪声 (Rn) 的概念，可以很容易找到一种简单的方法来计算任何数据点处的预计
噪声，以便与测量得到的信号进行比较。这是一种实实在在且客观的量度，可以用来计算信噪
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比 (S/N) 以及评估和比较仪器及测定方法的性能。相对噪声的概念有很多用途，其中之一就是
计算 S/N。

基本算法如下：

1. 设计一种噪声模型，使用户能够在数据点的基础信号水平给定的情况下，计算数据记录中
任何点位置的预计噪声。

噪声模型可以从理论角度来确定，也可以通过对某个系统的实际测量来进行建模。对于脉
冲计数检测器来说，信号的标准差，也就是预计噪声，是与信号的平方根成正比的，因而
会随着信号变化。在其他系统中，有一个始终存在的“白色噪声”成分，它可能与某个和强
度有关的成分结合在一起。

2. 要根据测量信号来估计基础信号。

此任务可以通过多种方式来实现，但 简单的方法是生成一个经过平滑的数据。请参阅
图：图 A-20。

图 A-20 原始和平滑数据的叠加

3. 用所有点（峰和背景）测量数据范围内的实际噪声。

通过从每个数据点测得的信号中减去基础信号估计值，并从该点的原始信号中减去平滑信
号，便可以得到结果。此结果就是所谓的 delta 噪声。delta 噪声的范围基本上是恒定的，
除了 大峰所在的位置，因为噪声要取决于信号，因而信号强的地方噪声也大。请参阅
图：图 A-21。

图 A-21 每个数据点的 delta 噪声值图表

4. 在每一个数据点计算测量噪声与预计噪声的比率。
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也就是说，在每一个数据点，我们都要用步骤 3 中测得的噪声值除以噪声模型的预测值，
在本例中为强度的平方根。如果噪声模型较好，软件会生成一系列的值，其绝大部分都在
极限范围内。请参阅下图。此图还显示了图表

注释: 此步骤减小了 delta 噪声中的较大差异，从而产生了差异范围较小的数值集合。

图 A-22 噪声模型

5. 计算比值的标准差。即 Rn，是实际 delta 噪声和模型预测噪声之间 接近关系的预测值。
在前面的图中，这样得到的值为 9.5。

下面的图显示了如何用相对噪声计算 S/N 的一个例子。

图 A-23 原始数据、基础信号估计值和基线估计值的叠加

如前文所述：

在本示例中：
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如果用峰的 高点作为信号，则 S/N 为 34 (4900/145)，如果用平滑信号的高度，则 S/N 为
22 (3150/145)。

报告 S/N 时，MQ4 积分方法采用的是本文所述的程序，而且以峰的 高点为信号。由于
AutoPeak 积分算法是用模型来拟合峰的，它所使用的是拟合轮廓的高度。这样得到的 S/N 较
小。不过，这个值要更为准确，因为它受可能的噪声尖峰的影响较小。AutoPeak 积分算法还
有一种更为复杂的基线估算方法，基于这两个原因，两种算法所报告的 S/N 值并不相同，尽管
它们通常较为类似。

总而言之，相比以背景区域的标准差来估算噪声的常用方法，用相对噪声计算 S/N 的方法有以
下优点：

• 主观性小，因为无需手动选择背景区域。

• 预测的 S/N 较为准确，即使色谱图上不存在无峰区域。

• 对于 AutoPeak 和求和积分算法，估算的基线及噪声靠近所关注的峰。对于 MQ4 积分算
法，基线是用户指定噪声百分比处的数据点的强度。例如，如果用户指定噪声百分比为
40%，有 100 个数据点，则 MQ4 积分算法按照从 小到 大强度对数据点进行排序，使用
强度为第四十的数据点的强度。

这样会使得所报告的 S/N 值有很大差异，因为常用方法所选择的背景区可能比靠近峰的背
景区噪声小。如前文所述，用相对噪声法计算得出的 S/N 比常用方法所得出的值更小。不
过，它们要更加准确，而且更有用。请参阅图 A-23。

若要使 Signal / Noise 列在 Results Table 中可见，请参阅自定义 Result Table。

使用 AutoPeak 积分算法时的信噪比注释

由于 AutoPeak 积分算法对信噪比的计算更精确（因此对 CV 预测也更精确），如果采用了 1-
sigma 信噪比方法，就要根据实验室的经验数据适当降低标准操作规程 (SOP) 可接受的 小
信噪比值。

峰-峰信噪比

如采用这种信噪比算法，则软件通过考虑指定背景开始时间和背景结束时间之间的所有色谱数
据点的标准差计算信噪比。该软件计算活动色谱图的信噪比，从选定峰减去平均背景信号，然
后用所得差值除以峰-峰噪声水平。再根据各区域的 大强度区分噪声和峰区域。完成后，活
动色谱图被标记上信噪比。

使用标准差的信噪比

使用这种信噪比算法时，软件计算色谱峰信噪比并进行标记。此算法需要在色谱图上选择两个
区域：

• 噪声区域

• 所关注的峰

然后，软件可根据各选择中的 大强度确定包含峰的区域以及包含噪声的区域。从峰信号强度
减去平均背景信号强度，然后用所得差值除以用户指定的系数再乘以该噪声区域的标准差。
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定义噪声区域

如果使用标准差或峰-峰算法，则使用此程序定义噪声区域。

注释: 在 Results Table 中只能使用一种信噪比算法。要对数据应用不同的信噪比算法，更改项
目默认设置，然后创建新 Results Table。

1. 在项目默认设置中，选择 Standard Deviation 或 Peak-to-Peak 信噪比算法。

提示! 要打开项目默认设置，请单击 Projects > Project default settings。

2. 创建处理方法。

3. 在 Integration 页面上，单击 Options > Show Noise Regions。

4. （如有必要）使用鼠标调整噪声区域。

注释: 必须为每个离子对设置噪声区域。

5. 处理数据。

6. 在 Peak Review 窗格中，单击 Options > Show Noise Regions。

7. （如有必要）使用鼠标调整噪声区域。

计算列
计算列是用于产生将添加到 Results Table 的新自定义列的公式。创建公式并处理（或再处
理）数据后，公式的结果显示在新的自定义列中。

导航计算列界面

计算列在处理方法中创建。它们可以作为 frml 文件导入和导出，以供随后使用或共享。

下图显示了公式编辑器的界面。
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图 A-24 计算列 UI

项目 描述

1 处理方法的工作流中的 Calculated Columns 步骤。单击此处打开
Calculated Columns 页面。然后单击 Add Formula（未显示）。

2 Formula name 字段。键入公式的名称。

注释: 公式名称不能包含计算器上的函数名称、方括号或圆括号。

3 Formula 字段。

4 包含常用函数和运算符的计算器。下列附加运算符可在公式字段中键入：
• >（大于）

• >=（大于等于）

• <（小于）

• <=（小于等于）

• !=（不等于）

有关这些运算符和函数的更多信息，请参阅帮助系统。

5 可用的回归参数和 Results Table 列。

注释: 此列表在 qsession 表格中不可用。

6 Treat resulting text values as 菜单可供用户配置如何处理文本条目。此
选项在可能同时包含数字和文本输出的 Results Table 列中非常重要。

例如，计算所得浓度列可能包含数值以及非数值，例如 N/A、简并和无
穷。

注释: 当用户开始键入使用一组样本的公式时，样本选择项变为可用状态。
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非默认信息的简单提取

计算列功能可供用户显示默认情况下在 Results Table 中不可用的信息。

例如，要将 R2 显示为 Results Table 中的列，用户可以创建一个等于 R2 的公式。

图 A-25 使用计算列创建自定义列

简单算术

可以创建简单公式以执行基本数学运算。

示例：R2

[r]*[r]

在本示例中，利用乘法算子 (*) 将 R 乘以 R 来重现 R2 值。

示例：每秒采集的点数

[Points Across Baseline]/(([End Time]-[Start Time])*60)

在本示例中，基线涵盖的点除以从积分色谱峰起点到终点的秒数。此公式使用除法 (/)、乘法
(*) 和减法 (–) 运算符。
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更复杂的函数

存在许多其他函数和控制结构。其中一些常见的包括 MEAN()、MAX() 和 MIN()，显示在计算
器中的公式栏下。

关于句法详细信息、运算符和函数的完整列表，请参阅帮助系统。

示例：用于标准物的 MEAN([Area])

使用对所有值运行的函数时，用户可以选择要纳入计算中的样本。

图 A-26 仅获取标准物样本的峰面积平均值

示例：组合函数

简单算术和更复杂的函数可以组合使用。例如，为了计算每秒采集的平均点数，可以使用以下
公式：

MEAN([Points Across Baseline]/(([End Time]-[Start Time])*60))

IF 语句

IF 函数执行逻辑测试并为 true 结果返回一个值，为 false 结果返回另一个值。嵌套 IF 函数可
用于测试多个条件。IF 函数可与其他逻辑函数（例如，and 和 or）组合，以扩展逻辑测试。

注释: “&&”和“||”分别可用于 and 和 or。and 和 or 运算符必须被空格包围，但 && 和 || 运算符
不需要。

基本 IF 语句的句法如下：

if(<condition>;<value if true>;<value if false>)

工作原理—软件
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• <condition> 是可评估为 true 或 false 的值或逻辑表达式。

• <value if true> 是待返回的值，当 <condition> 评估为 true 时显示在相应的 Results Table
列中。

• <value if false> 是待返回的值，当 <condition> 评估为 false 时显示在相应的 Results Table
列中。

注释: IF 函数符号可以从计算器选择、键入或从其他源复制。它可用于 if 或 IF 句法。

IF 函数允许将其他数值函数，例如 MEAN、STDEV 等，用于公式中以及 <condition>、
<value if true>或 <value if false> 表达式中。

示例： <condition>

一些 <condition> 示例包括：

[Peak Area]>5000

[Component Name]='Analyte 1'

[Retention Time]> 1 and [Retention Time]<2

示例： <value if true> 和 <value if false>

<value if true> 和 <value if false> 可以是数值或文本。

if([Retention Time]> 1 and [Retention Time]<2; '1-2 min RT 
window'; 
'not applicable')

示例：内标面积的平均值

在本示例中，在所需的样本中计算内标 (IS) 面积的平均值，并与值 1e6 进行比较。如果
MEAN ([IS Area]) 大于 1e6，平均 IS 面积值显示在相应的 Results Table 列中，该条件表示
如果 <condition> 为 true。如果 MEAN ([IS Area]) 小于 1e6，即如果 <condition> 为 false，
则 Results Table 列包含 Review IS performance， <value if false>。

IF(MEAN([IS Area])>=1e6;'MEAN([IS Area])';'Review IS performance')

注释: 只有 IF 函数能够包含多个计算。

Treat Resulting Text Values As
Treat resulting text values as 选项决定在包含文本或数字和文本组合的自定义 Results
Table 列中如何解读文本。例如，Sample Type 列仅包含文本，Precursor Mass 列仅包含数
值，Calculated Concentration 列可同时包含数值和文本。

根据公式中使用的函数，Treat resulting text values as 选项可对计算所依据的列中的文本值
进行特定解读。可用选项包括：
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• Zero

• Ignore (blank)

• Error (N/A)

• Original text

注释: 有关这些选项的更多信息，请参阅帮助系统。

如果计算基于 COUNT、MAX、STDEV、SUM、MIN、MEDIAN、GET、GETGROUP、
SLOPE、INTERCEPT、MAD 或 GETSTAT 函数，则推荐的选项为 Zero、Ignore (blank) 或
Error (N/A)。当公式中包含预计会有数值的列时，也推荐在 IF 语句中使用这些选项。

Original text 是此类 IF 语句的推荐选项： <condition>、 <value if true>和 <value if false> 表
达式可能同时包含数值和文本，尤其是在使用其他函数时。

注释: 如果 IF 语句包含多个 <condition>，未能评估任何一个 <condition> 都会在自定义
Results Table 列中产生 <value if false> 输出。

示例

在本示例中，公式中使用的列可能同时包含文本和数值。因此，建议使用 Original text 选
项。

IF([Sample Type]='Unknown'&&(GET([Calculated Concentration];
'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))<=15;
'Low Range';IF([Sample Type]='Unknown'&&(GET([Calculated 
Concentration]
;'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))
<=65;'Normal Range';'Over normal range'))

此 IF 公式同时包含 Sample Type 和 Calculated Concentration 列。Sample Type 列中的值
应处理为 Original text。对于 Calculated Concentration 列，可能需要将 <0 和 Degenerate
之类的非数值处理为 Zero。

由于非数值必须以不同的方式处理，因此建议用户将该公式拆分成多个更小的公式，以更精细
地控制非数值。
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精确质量和化学式 B
PPG

表 B-1 包含用 PPG（聚丙烯乙二醇）校准液观察到的准确的单同位素质量和带电粒种（正电
和负电）。质量和离子使用公式 M = H[OC3H6]nOH 计算，正离子的 MSMS 碎片使用公式
[OC3H6]n(H+) 计算。在所有计算中，H = 1.007825，O = 15.99491，C = 12.00000，N =
14.00307。

注释: 用 PPG 溶液进行校准时，使用正确的同位素峰。

表 B-1 PPG 精确质量

n 精确质量 (M) (M + NH4)+ MSMS 碎片 (M + NH4)2+ (M + COOH)–

1 76.05242 94.08624 59.04914 56.06003 121.05061

2 134.09428 152.12810 117.09100 85.08096 179.09247

3 192.13614 210.16996 175.13286 114.10189 237.13433

4 250.17800 268.21182 233.17472 143.12282 295.17619

5 308.21986 326.25368 291.21658 172.14375 353.21805

6 366.26172 384.29554 349.25844 201.16468 411.25991

7 424.30358 442.33740 407.30030 230.18561 469.30177

8 482.34544 500.37926 465.34216 259.20654 527.34363

9 540.38730 558.42112 523.38402 288.22747 585.38549

10 598.42916 616.46298 581.42588 317.24840 643.42735

11 656.47102 674.50484 639.46774 346.26933 701.46921

12 714.51288 732.54670 697.50960 375.29026 759.51107

13 772.55474 790.58856 755.55146 404.31119 817.55293

14 830.59660 848.63042 813.59332 433.33212 875.59479

15 888.63846 906.67228 871.63518 462.35305 933.63665

16 946.68032 964.71414 929.67704 491.37398 991.67851

17 1004.72218 1022.75600 987.71890 520.39491 1049.72037

18 1062.76404 1080.79786 1045.76076 549.41584 1107.76223

19 1120.80590 1138.83972 1103.80262 578.43677 1165.80409

20 1178.84776 1196.88158 1161.84448 607.45770 1223.84595

21 1236.88962 1254.92344 1219.88634 636.47863 1281.88781
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表 B-1 PPG 精确质量 (续)

n 精确质量 (M) (M + NH4)+ MSMS 碎片 (M + NH4)2+ (M + COOH)–

22 1294.93148 1312.96530 1277.92820 665.49956 1339.92967

利血平

表 B-2 利血平精确质量 (C33H40N2O9)

描述 质量

分子离子 C33H41N2O9 609.28066

碎片 C23H30NO8 448.19659

碎片 C23H29N2O4 397.21218

碎片 C22H25N2O3 365.18597

碎片 C13H18NO3 236.12812

碎片 C10H11O4 195.06519

碎片 C11H12NO 174.09134

精确质量和化学式
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的 新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载 新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发布说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件的文档 DVD。

新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。

注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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